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Preface

 How to read this manual

Thank you for purchasing the TOSHIBA multifunctional digital systems. This manual describes how to use, 
perform maintenance, and fix problems for this equipment. Be sure to read this manual before using this 
equipment. Keep this manual handy and retain it for future reference.

 Symbols in this manual

To ensure correct and safe use of this equipment, this manual describes safety precautions according to the 
three levels shown below.
You should fully understand the meaning and importance of these items before reading this manual.

Other than the above, this manual also describes information that may be useful for the operation of this 
equipment with the following signage:

Description of original/paper direction

Paper or originals of A4 or B5/LT size can be placed either in a portrait direction or in a landscape direction. In 
this manual, “-R” is added to this paper size when this size of paper or original is placed in a landscape 
direction.

e.g.) A4/LT size original on the original glass

Paper or originals of A3 or B4/LD or LG size can only be placed in a landscape direction, therefore “-R” is not 
added to these sizes.

 Screens

 In this manual, the screens and the operation procedures in Windows are described for Windows 7.
The details on the screens may differ depending on how the equipment is used, such as the status of the 
installed options, the OS version and the applications.
 The illustration screens used in this manual are for paper in the A/B format. If you use paper in the LT 

format, the display or the order of buttons in the illustrations may differ from that of your equipment.

Indicates a potentially hazardous situation which, if not avoided, could result in death, 
serious injury, or serious damage, or fire in the equipment or surrounding assets.

Indicates a potentially hazardous situation which, if not avoided, may result in minor or 
moderate injury, partial damage of the equipment or surrounding assets, or loss of data.

Indicates information to which you should pay attention when operating the equipment.

Describes handy information that is useful to know when operating the equipment.

Pages describing items related to what you are currently doing. See these pages as 
required.

Placed in a portrait direction: A4/LT Placed in a landscape direction: A4-R/LT-R
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 Trademarks

 The official name of Windows Vista is Microsoft Windows Vista Operating System.
 The official name of Windows 7 is Microsoft Windows 7 Operating System.
 The official name of Windows 8 is Microsoft Windows 8 Operating System.
 The official name of Windows Server 2008 is Microsoft Windows Server 2008 Operating System.
 The official name of Windows Server 2012 is Microsoft Windows Server 2012 Operating System.
 Microsoft, Windows, Windows NT, and the brand names and product names of other Microsoft products 

are trademarks of Microsoft Corporation in the US and other countries.
 Adobe, Acrobat, Reader, and PostScript are either registered trademarks or trademarks of Adobe Systems 

Incorporated in the United States and/or other countries.
 Mozilla, Firefox and the Firefox logo are trademarks or registered trademarks of Mozilla Foundation in the 

U.S. and other countries.
 TopAccess is a trademark of Toshiba Tec Corporation.
 Other company and product names given in this manual or displayed in this software may be the 

trademarks of their respective companies.

 Lineup of our manuals

These manuals are provided for the operation of the e-STUDIO2309A/2809A. Select and read the manual 
best suited to your needs. This manual is the User’s Guide.

Safety Information (Printouts)

This manual describes the necessary precautions for use. For your added security, be sure to read this 
manual first.

Quick Guide (Printouts)

This manual describes the components, preparations, basic operations, and troubleshooting for the 
equipment.

User’s Guide (PDF file, this manual)

This manual describes preparations for using the e-STUDIO2309A/2809A, and how to use functions such as 
copying, printing, and scanning. It also describes maintenance and troubleshooting for the problems that 
could occur while you are using the equipment.

Software Installation Guide (PDF file)

This manual describes how to install and uninstall printer and scanner drivers.

TopAccess Guide (PDF file)

This manual describes how to use the co-packed utility “TopAccess”. The settings and management of the 
equipment can be done using a Web browser.

Fax Guide (PDF file)

This manual describes how to use the Fax functions. Various functions both basic and advanced regarding 
Fax transmission/reception are available.

Help menu for client software

To run the following client software, refer to the Help menu of each:
 Printer driver
 Scan driver
 N/W-Fax driver
 e-STUDIO Scan Editor

 To read manuals in the PDF file format

This manual in the PDF (Portable Document Format) can be displayed/printed using Adobe Reader or Adobe 
Acrobat Reader. If neither is installed in your computer, download one of them. This can be done via the 
website of Adobe Systems Incorporated.
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 Recommended toner cartridges

To assure optimal printing performance, we recommend that you use only genuine TOSHIBA toner cartridges. 
If you use a TOSHIBA-recommended toner cartridge, you can utilize the following three functions of this 
equipment:

Cartridge detecting function: This function checks if the toner cartridge is correctly installed and notifies 
you if it is not.
Toner remaining check function: This function notifies you when there is little toner remaining in the 
cartridge, as well as notifying your authorized service representative automatically by remote service.
Image quality optimization function: This function controls image quality according to the characteristics 
of the toner to be used and enables you to print images of an optimal quality.

If you are using a toner cartridge other than the one we recommend, the equipment may not be able to detect 
whether it is installed or not. Therefore, even if the toner cartridge is correctly installed, the error message 
“ERROR: TONER” appears on the LCD screen and printing may not be performed. You may also not be able 
to utilize the image quality optimization function, the toner remaining check function, and the remote service 
function which notifies your service representative automatically.
If you are using a toner cartridge other than the one we recommend, toner is not recognized. If this is a 
problem for you, please contact your service representative. Remember you will not be able to utilize the 
Toner remaining check function and Image quality optimization function as we mentioned.
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Components

 Front/Left side/Inner side

1. Reversing Automatic Document Feeder (RADF) (optional)

The stack of originals is scanned one sheet at a time. Both sides of the originals can be scanned. A 

maximum of 50 sheets (80 g/m2 or 20 lb. Bond) can be placed in one go. (The maximum number of sheets 
that can be set may vary depending on the media type of the originals.)
 P.202 “Paper Misfeed”

2. Platen sheet

 P.218 “Regular Cleaning”

3. Original glass

Place the book-type originals and special paper such as overhead transparencies or tracing paper, as well 
as plain paper.

4. Control panel

Make settings to use the various functions on this equipment.
 P.14 “Control panel”

5. Toner cartridge

For the recommended toner cartridges, refer to the Safety Information.
 P.211 “Replacing Toner Cartridge”

6. Front cover

Open this when you replace the toner cartridge.
 P.211 “Replacing Toner Cartridge”

7. Drawer

Place up to 250 sheets of plain paper (80 g/m2 or 20 lb. Bond).
 P.24 “Loading paper in the drawer/Paper Feed Unit”

8. Paper Feed Unit (optional)

Use the Paper Feed Unit to add the second drawer. A maximum of 250 sheets (80 g/m2 or 20 lb. Bond) of 
plain paper can be placed in one go.

1

4

5

6

7

8

9

10

17

16

14

12
13

11

2

3

20

19

18

15
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9. Paper Feed Pedestal (optional)

Use the Paper Feed Pedestal to add one drawer. The Drawer Module can be installed in this device. A 
maximum of 550 sheets (80 g/m2 or 20 lb. Bond) can be placed in one go.

10.Drawer Module (optional)

Use this to add one more drawer to the Paper Feed Pedestal (optional). A maximum of 550 sheets (80 g/
m2 or 20 lb. Bond) can be placed in one go.

11.Receiving tray

12.Paper exit stopper

Stops large paper from sliding out of the receiving tray.

13.Power switch

Turns the power ON or OFF.
 P.18 “Preparation 1 - Turning Power ON”

14.AC-IN terminal (rear)

Connect the power cable supplied with the equipment.

15.TEL (optional)

Connect to an external telephone.
For details on how to use the Fax functions, see the following manual.
 Fax Guide

16.Network interface connector

Use this connector when connecting this equipment to a network.

17.USB terminal (4-pin)

Connect to your PC using a commercially available USB cable.

 Use a USB2.0 Hi-Speed certified cable: USB cable supporting the USB2.0 Hi-Speed mode (480 
Mbps of transfer speed) certified by the USB Implementers Forum.
 Connect the equipment with a PC directly by the USB cable. When it is connected with a PC via a 

USB hub, the equipment may not be recognized.

18.LINE (optional)

Connect to the public switched telephone network.
For details on how to use the Fax functions, see the following manual.
 Fax Guide

19.Scanning area

The data of originals transported from Reversing Automatic Document Feeder are scanned here.
 P.218 “Regular Cleaning”

20.Original scale

Confirm the size of an original placed on the original glass.
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 Right side

1. Platen Cover (optional)

Close this before start copying or scanning.

2. Side cover

3. Bypass tray

Place special paper such as thick paper, overhead transparencies, or tracing paper.
 P.30 “Loading paper on the bypass tray”
 P.32 “Loading an envelope on the bypass tray”

4. USB port

Connect a USB device to store scanned data or print files stored in the USB device.

2

3

1

4
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 Configuration of options

The available options are listed below. Contact your service technician or service representative for details.

Main body

Reversing Automatic

Document Feeder

(MR-3029)

Platen Cover

(KA-2507PC)

Wireless LAN Module

(GN-1080)

Fax Kit

(GD-1360)

Paper Feed Unit

(MY-1043)

Drawer Module

(MY-1044)

Paper Feed Pedestal

(KD-1039)

Desk

(MH-2507)

PostScript Kit

(GA-1340)
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 Control panel

The functions and indications of the  button vary depending on the region. The illustrations show the control 
panel for Europe and the Americas unless they are specified.

For Europe and the Americas

For regions other than Europe and the Americas

1. [MONITOR] button

Use this button to dial the number without picking up the handset of the external telephone.

2. [PAUSE] button

Use this button to inset a pause (of approximately 2 seconds) while dialing a fax number. Available only 
when the Fax Unit (optional) is installed.

54321

1415

18202223

192124252627

1311109

17 16

7 86 12

54321

1415

18202223

192124252627

1311109

17 16

7 86 12
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3. [ADDRESS BOOK] button

Use this to display the Address book. Available only when the Fax Unit (optional) is installed.

4. [RESOLUTION] button

Use this to select the resolution for sending a fax. Available only when the Fax Unit (optional) is installed.

5. One Touch button

Speed button for sending a fax. Available only when the Fax Unit (optional) is installed.

6. [COPY] button

Press this button to use the copy functions.

7. [SCAN] button

Press this button to use the scan functions.

8. [FAX] button

Press this button to use the Fax functions. Available only when the Fax Unit (optional) is installed.
For details on how to use the Fax functions, see the following manual.
 Fax Guide

9. [USER FUNCTIONS] button

Changes the equipment’s default settings.
 P.179 “User Functions Menu List”

10.[JOB STATUS] button

Displays the processing status of print, scan, or fax, as well as allowing you to view the performance 
history and delete the job.
 P.194 “Job Status”
For details on how to use the Fax functions, see the following manual.
 Fax Guide

11.[SETTINGS] button

Displays the current settings.

12.[TEMPLATE] button

Creates and recalls template settings.
 P.70 “Using Templates (Copy)”
 P.169 “Using Templates (Scan)”

13.[ENERGY SAVER] button

Enters into the energy saving mode.

14.[FUNCTION CLEAR] button

Restores all the selected functions to the defaults.

15.[CLEAR/STOP] button

Clears the number entered with the digital keys such as the number of copies, as well as cancels scanning 
or copying the original.

16.[START] button

Starts the copying, scanning or faxing operation.

17.Digital keys

Enters numbers such as the number of copies, password or fax number.

18.[OK] button

Determines the items or operations selected in each menu.
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19.  button

- Press this button on menu screens to move to an item on the right or increase the setting.
- Press this button once on the main screen (Copy) to show the “EXPOSURE” screen for Europe and the 

Americas, or the “ID CARD” screen for regions other than Europe and the Americas.
 P.42 “Using the “EXPOSURE” or “ID CARD” function quickly”

- Press this button once on the main screen (Fax) to send a fax to multiple destinations. Available only 
when the Fax Unit (optional) is installed.

20.  button

Press this button on menu screens to move to the item above. If you press this button when the top menu 
item is highlighted, the bottom menu item is displayed.

21.  button

Press this button on menu screens to move to the item below. If you press this button when the bottom 
menu item is highlighted, the top menu item is displayed.

22.  button

Press this button once on the main screen (Copy) to show the “ORIGINAL MODE” screen. Press it on 
menu screens to move to an item on the left or decrease the setting.
 P.43 “Selecting “ORIGINAL MODE” quickly”

23.[CANCEL] button

Cancels the current settings and returns to the previous item.

24.Alert lamp

Blinks or lights in case of an error.

25.[DATA] lamp

This lamp blinks while print data is being received or fax data is being sent and received.

26.LCD screen

Confirms each menu and error messages.
 P.17 “Main screen (Copy)”

27.[DRAWER] button/lamps

Use this button to select a drawer or the bypass tray to be used as a paper source. The lamp of the paper 
source currently selected is lit. The lamp blinks when the selected drawer or tray is running out of paper.
When paper in the drawer or on the bypass tray has run out, see the following page to add paper.
 P.20 “Preparation 2 - Loading Paper”
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 Main screen (Copy)

Appears after the power of the equipment is turned ON and the warm-up is finished. This screen is called 
“main screen (Copy)”. This screen also appears when the AUTO CLEAR function has worked.

1. Message

Displays the current status or error messages.

2. Paper size

Displays the paper size specified for the drawer or the bypass tray.

3. Copy quantity

Displays the number of copies.

4. Scroll icon

Displays  or  that you can press on the current screen or menu.

5. Original mode

Displays the mode to copy the original.

6. Exposure

Displays the copy density.

7. Reproduction ratio

Displays the reproduction or zoom ratio to copy.

This function returns all settings to default without the need to press [FUNCTION CLEAR] on the control 
panel. It works when a specified period of time has passed since the last paper exit or the last entry of any 
button.
 P.182 “GENERAL”

A41

READY

100%

AUTO EXPOSURE

TEXT/PHOTO

2

5

6

1 3

7

4
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Preparation 1 - Turning Power ON

 Turning on

1 Press the power switch to “ ” (on).

Starts warming up, which takes approx. 20 seconds. When the warm-up has finished, the equipment is 
ready.

If you press [START] during the warm-up, copying automatically starts after it has finished. When 
the job is reserved, “COPYING” appears on the LCD screen to show you the current status.
This function cannot be accessed while “PLEASE WAIT” is being displayed.

2 The LCD screen below is shown if the equipment is managed under the department 

code function.

Key in a 5-digit department code, and then press [OK].

If the department code function is enabled, press [FUNCTION CLEAR] after any operation to 
prevent unauthorized use of the equipment.
For the details of the department code, see the following page:
 P.192 “Department Management”

 Turning off

Press the power switch to “ ” (off).

A41

READY

100%

AUTO EXPOSURE

TEXT/PHOTO

DEPARTMENT CODE

_

  :12
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 Saving energy when not in use - Energy saving mode -

To reduce power consumption, the equipment automatically enters into the energy saving mode when a 
specified period of time has passed since its last use.

 Types of energy saving mode

Low power mode:“SAVING ENERGY” appears on the LCD screen.
The equipment automatically enters into low power mode when a specified period of time 
elapses.

Sleep mode: The LCD screen is turned off and only [ENERGY SAVER] is lit.
The equipment enters into sleep mode when a specified period of time elapses or the 
[ENERGY SAVER] button is pressed.

 When “Status Monitor” is running, the equipment does not enter into the sleep mode. If you want to 
enable the sleep mode, exit it out.
 P.82 “Status Monitor”
 This equipment does not enter sleep mode when the Wireless LAN Module is installed.

The timers for “AUTO POWER SAVE” and “SLEEP MODE” have been set respectively as the factory 
default settings. You can change them in the “USER FUNCTIONS” menu.
 P.179 “User Functions Menu List”

 To turn the equipment into the energy saving mode (Sleep mode) manually

Press [ENERGY SAVER].

Canceling conditions for energy saving mode

The energy saving mode is canceled under the following conditions.

 When [ENERGY SAVER], [START], [COPY], [SCAN], or [FAX] on the control panel is pressed.
- For the low power mode: Press [ENERGY SAVER], [START], [COPY], [SCAN], or [FAX]
- For the sleep mode: Press [ENERGY SAVER]

 When printing or scanning is performed from a PC connected with this equipment.
 When fax data is received.



1 PREPARATION

20    Preparation 2 - Loading Paper

Preparation 2 - Loading Paper

Load an appropriate type of paper.

 Acceptable paper types

Acceptable paper types differ depending on its paper source. See the table below for more details.

*1 “Maximum sheet capacity” refers to the maximum number of sheets when recommended paper is used. See the following page for 

the recommended paper: 

 P.22 “Recommended paper”

*2 2-sided copying is not available.

*3 Sticker labels should not be cut off each other.

Paper 

source
Paper type Paper size

Maximum sheet 

capacity*1

Drawer Plain paper

(64 - 80 g/m2, 17 - 20 
lb. Bond)

A/B format:
A3, A4, A4-R, A5-R, B4, B5, B5-R, FOLIO
LT format:
LD, LG, LT, LT-R, ST-R, COMP, 13"LG, 
8.5"SQ
K format:
8K, 16K, 16K-R

250 sheets

(80 g/m2, 20 lb. Bond)

Paper Feed 
Unit

Plain paper

(64 - 80 g/m2, 17 - 20 
lb. Bond)

A/B format:
A3, A4, A4-R, A5-R, B4, B5, B5-R, FOLIO
LT format:
LD, LG, LT, LT-R, ST-R, COMP, 13"LG, 
8.5"SQ
K format:
8K, 16K, 16K-R

250 sheets

(80 g/m2, 20 lb. Bond)

Paper Feed 
Pedestal

Plain paper

(64 - 80 g/m2, 17 - 20 
lb. Bond)

A/B format:
A3, A4, A4-R, A5-R, B4, B5, B5-R, FOLIO
LT format:
LD, LG, LT, LT-R, ST-R, COMP
K format:
8K, 16K, 16K-R

550 sheets

(80 g/m2, 20 lb. Bond)

Drawer 
Module

Bypass tray Plain paper

(64 - 80 g/m2, 17 - 20 
lb. Bond)

A/B format:
A3, A4, A4-R, A5-R, B4, B5, B5-R, FOLIO
LT format:
LD, LG, LT, LT-R, ST-R, COMP, 13"LG, 
8.5"SQ
K format:
8K, 16K, 16K-R

100 sheets

(80 g/m2, 20 lb. Bond)

Thin paper*2

(52 - 63 g/m2, 14 - 16 
lb. Bond)

1 sheet

(52 - 63 g/m2, 14 - 16 
lb. Bond)

Thick paper*2

(81 - 105 g/m2, 21 - 28 
lb. Bond)

10 sheets

(81 - 105 g/m2, 21 - 28 
lb. Bond)

Thick paper 1*2

(106 - 163 g/m2, 29 lb. 
Bond - 90 lb. Index)

10 sheets

(106 - 163 g/m2, 29 lb. 
Bond - 90 lb. Index)

Thick paper 2*2

(164 - 216 g/m2, - 80 lb. 
Cover, - 110 lb. Index)

10 sheets

(164 - 216 g/m2, - 80 lb. 
Cover, - 110 lb. Index)

Tracing paper*2 *7

(75 g/m2, 20 lb. Bond)

1 sheet

Sticker labels*2 *3 1 sheet

Transparencies*2 *4 A4/LT only 1 sheet

Envelope*2 *5 *6 DL (110 mm x 220 mm), COM10 (4 1/8" x 
9 1/2"), Monarch (3 7/8" x 7 1/2"), CHO-3 
(120 mm x 235 mm), YOU-4 (105 mm x 
235 mm)

1 sheet
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*4 Be sure to use the recommended overhead transparencies. Using other transparencies could cause an equipment malfunction.

*5 Printing on the back side of an envelope is not possible.

*6 Envelope can be used when printing from your PC.

*7 For printing the tracing paper, select "THICK1" as the media type.

 Do not mix various paper sizes in one drawer.
 “LT format” is the standard size for only use in North America.
 “K format” is a Chinese standard size.
 2-sided copying is only available for plain paper.

Abbreviations for LT format sizes:
LT: Letter, LD: Ledger, LG: Legal, ST: Statement, COMP: Computer
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 Recommended paper

To ensure the best copy performance, the paper types listed below are recommended. If you want to use 
paper other than that we recommend, contact your service technician.

*1 Be sure to use the recommended overhead transparencies. Using other transparencies could cause an equipment malfunction.

Paper type Product name

Plain paper A/B format: TGIS Paper/Mondi
LT format: TIDAL/Hammermill

80 g/m2, 20 lb. Bond

K format: Classic Jetset COPY 
PAPER/UPM

70 g/m2

Thick paper A/B format: Color Copy/Mondi
LT format: Laser/Hammermill

90 g/m2, 24 lb. Bond

A/B format: Color Copy/Mondi 100 g/m2

Thick paper 1 A/B format: Color Copy/Mondi
LT format: Laser/Hammermill

120 g/m2, 32 lb. Bond

A/B format: Color Copy/Mondi
LT format: Exact Index/WAUSAU

160 g/m2, 90 lb. Index

Thick paper 2 A/B format: Color Copy/Mondi
LT format: Laser/Hammermill

200 g/m2, 80 lb. Cover

A/B format: Color Copy/Mondi
LT format: Exact Index/WAUSAU

200 g/m2, 110 lb. Index

Tracing paper Tracing paper/Ostrich International 75 g/m2, 20 lb. Bond

Sticker labels A/B format: 3478/ZWECH-AVERY
LT format: 5165/AVERY

Transparencies *1 A/B format: PP2500/3M
LT format: X10.0/FOLEX

Envelope ColumbianCO138/Westvaco,
No.553/Monarch/mailwell
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 Paper types not acceptable

Do not use the types of paper listed below since they may cause paper misfeeds or an equipment 
malfunction.
 Damp paper
 Creased paper
 Wrinkled paper or paper prone to be curled
 Extremely smooth or rough surface paper
 Paper whose surface has had special treatment
 Paper once printed or used on one side
 Sticker labels shown below

- The released paper is visible since its label has been punched out.
- The released paper is visible since a part of its label has peeled off.
- A sticker label which has been cut

 Storing paper

Note the following points when storing paper.
 Wrap the paper in its packaging to prevent it from gathering dust.
 Do not expose the paper to direct sunlight.
 Do not store the paper in a humid location.
 Store the paper on a flat surface to prevent it from becoming curled or creased.
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 Loading paper in the drawer/Paper Feed Unit

You can load paper in the drawer and Paper Feed Unit in the same procedure.

For the acceptable paper, see the following page:
 P.20 “Acceptable paper types”

1 Turn the power of the equipment ON.

2 Pull out the drawer carefully.

3 Press down the paper plate.

Press it down until you hear a click sound and it is no longer lifted up.
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4 Load paper face up in the drawer.

 Up to 250 sheets (80 g/m2 or 20 lb. Bond) can be loaded. Be sure that the height of the stacked 
paper does not exceed the line indicated inside of the side guides.
 P.20 “Acceptable paper types”
 Fan the paper well before loading it in the drawer, otherwise multiple feeding could occur. Be 

careful not to cut your fingers.
 The printable side may be noted on its packaging.
 Never put anything in a vacant space in the drawer after the paper has been loaded. Otherwise, 

it may cause paper misfeeds or an equipment malfunction.

5 Move the end guide to the trailing edge of the paper while pushing its lower part in the 

direction of the arrows.

Do not allow any gap between the paper and the end guide in the drawer.

When placing LD size paper

To place LD size paper in the drawer, the end guide needs to be removed. Move it to the left 
end while pushing its lower part from both sides, and then pull it upward. Keep it in the pocket 
on the front side of the drawer.

1

2
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6 While holding the green lever of the front side guide, adjust the side guides to the 

paper size.

7 Push the drawer straight into the equipment slowly until it stops.

Do not catch your fingers in the drawer when closing it.

This could cause injury.

Register the paper size into the equipment.

When you load paper in the drawer for the first time, register the paper size. Be sure to register it 
correctly, otherwise it could cause a paper misfeed.
For the registration, see the following page:
 P.35 “Preparation 3 - Registering Paper Size and Type”

Be sure to register the paper size each time you have changed it.
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 Loading paper in the drawers of Paper Feed Pedestal

For the acceptable paper, see the following page:
 P.20 “Acceptable paper types”

1 Turn the power of the equipment ON.

2 Pull out the drawer carefully.

3 Pull out the trailing guide while pushing its lower part to the direction of the arrow. 

Then reinstall the guide at the position of the desired paper size.

The paper size is indicated on the bottom inner surface of the drawer.

4 Push the right side of the side guide lock to unlock it.
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5 While pushing the green knob of the side guides, adjust the side guides at the position 

of the desired paper size.

Adjust the side guides with both hands.

6 Load paper face up in the drawer.

 Up to 550 sheets (80 g/m2 or 20 lb. Bond) can be loaded. Be sure that the height of the stacked 
paper does not exceed the line indicated inside of the guide.
 P.20 “Acceptable paper types”
 Fan the paper well before loading it in the drawer, otherwise multiple feeding could occur. Be 

careful not to cut your fingers.
 Place the paper face up. The printable side may be noted on its packaging.
 Never put anything in a vacant space in the drawer after the paper has been loaded. Otherwise, 

it may cause paper misfeeds or an equipment malfunction.

7 Adjust the side guides.

Be sure that a gap of approx. 0.5 mm (0.02") (1.0 mm (0.04") or less in total) is left between the paper 
and each side guide (shown as “A” in the picture). If the gap is inappropriate, this could cause a paper 
misfeed.

A
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8 Push the left side of the side guide lock to lock it.
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 Loading paper on the bypass tray

The contents of the original(s) are rotated when copied on paper of the following sizes fed from the bypass 
tray.
A/B format: A3, A4-R, A5-R, B4, B5-R, FOLIO
LT format: LD, LG, LT-R, ST-R, COMP, 13"LG, 8.5"SQ
K format: 8K, 16K-R

For example, to copy an A5-size original, place the original on the original glass in A5 portrait orientation 
and paper on the bypass tray in A5 landscape orientation (A5-R).

To enlarge an A4-size original to A3, place the original on the original glass in A4 portrait orientation and 
A3 paper on the bypass tray.

The illustrations below are example of loading A4/LT size paper.
For the acceptable paper, see the following page:
 P.20 “Acceptable paper types”

1 Open the bypass tray.

2 Pull the paper holding lever out, and then load paper face down and straight on the 

bypass tray.

The printable side may be noted on its packaging.

2

1
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3 Align the side guides with the edges of the paper, and then push back the lever.

 Up to 100 sheets of plain paper (80 g/m2 or 20 lb. Bond) can be loaded. Be sure that the height of 
the stacked paper does not exceed the indicators of the side guides. If paper other than plain is 
used, set it one sheet at a time.
 Fan the paper well before loading it on the bypass tray, otherwise multiple feeding could occur. 

Be careful not to cut your fingers.
 Do not push the paper forcibly into the entrance of the bypass feeder, otherwise it could cause a 

paper misfeed.
 Flatten curled paper before loading it on the bypass tray.

 When you use paper longer than the bypass tray size, pull out the paper holder from the tray.

 When using thick paper for bypass copying, some thick paper may not be fed properly. In this 
case, turn over the paper and place it again as shown in the figure.

2
1
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 Loading an envelope on the bypass tray

For the acceptable envelope sizes, see the following page:
 P.20 “Acceptable paper types”

Notes for using envelopes

Do not use the following envelopes, otherwise they may cause a paper misfeed or damage to the equipment.
1. Badly curled, wrinkled or folded envelopes
2. Extremely thick or thin envelopes
3. Wet or damp envelopes
4. Torn envelopes
5. Envelopes which include the contents
6. Non-standard size envelopes (ones with a special shape)
7. Envelopes with eyelets or windows
8. Envelopes sealed with adhesive paste or tape
9. Partly-opened or perforated envelopes
10.Envelopes with special coating on the surface
11.Envelopes with glue or double-sided adhesive tape

 Store envelopes at room temperature and away from heat and moisture.
 Paper wrinkling may occur after printing depending on environment or the envelope type or condition. 

We recommend printing paper as a sample before doing so in large amounts.

2

5  6

8

7

3

4

9 1110

1
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1 Place an envelope on a flat clean surface and press it with your hands in the arrow 

directions as shown below to expel air from the inside.

Press it well to prevent the flap from rolling upward.

Correct bent corners of the envelope.

2 Open the bypass tray.
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3 Pull the paper holding lever out, and then load the envelope face down on the bypass 

tray.

Place the envelope with its flap side at the front as shown below.

 Do not copy or print on the back of envelopes, otherwise it may cause a paper misfeed or soil 
them or the inside of the equipment.
 Printing may be uneven depending on the envelope types.

4 Align the side guides to the edges of the envelope, and then push back the lever.

2

1

2
1
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Preparation 3 - Registering Paper Size and Type

When you load or change paper, a pop-up window appears. Follow the instructions to register the items below 
in the equipment.

 For the drawer: the paper size
 For the bypass tray: the paper size and type

 You can also register the paper size for the drawer in the “USER FUNCTIONS” menu.
 P.179 “User Functions Menu List”
 When loading the paper the size other than standard ones on the bypass tray, select “CUSTOM” as 

paper size.
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Basic Copy Procedure

Learn the basic copy procedure in this section. For the other various functions, see the following page:
 P.44 “Copy Settings”

Make sure that the equipment is ready to copy.
 P.18 “Preparation 1 - Turning Power ON”
 P.20 “Preparation 2 - Loading Paper”
 P.35 “Preparation 3 - Registering Paper Size and Type”

 Acceptable originals

Acceptable originals differ depending on the setting position. See the table below for more details.
If you are using the Reversing Automatic Document Feeder, you can automatically scan a stack of plain paper 
originals at one time. 

*1 The maximum number of sheets acceptable varies depending on the type of original.

Maximum number of originals scanned at one time

When you use “CONTINUE SCAN” with the Reversing Automatic Document Feeder (RADF), you can scan up 
to 150 original sheets at one time. When the number of sheets to be scanned exceeds 150 or the built-in 
memory in the equipment is full, scanning stops and an error message is displayed on the LCD screen. Press 
any button on the control panel to delete the scanned data.

 Precautions for Reversing Automatic Document Feeder

Do not use the following types of original as they may cause a paper misfeed or damage to the equipment:
 Originals that are folded or curled
 Originals with carbon copies
 Originals that have been taped, pasted, or cut-out
 Originals that have been clipped or stapled
 Originals with holes or tears
 Originals that are damp
 Originals whose correction fluid or ink has not been dried completely
 Overhead transparencies or tracing paper
 Coated paper (e.g. coated with wax)
 Originals with multiple holes punched (e.g. loose leaf paper)

Setting position Type
Maximum 

size

Acceptable sizes for 

automatic size detection

Maximum number of 

sheets

Original glass Plain paper
Special paper
Booklets

A3 or LD Other than North America 
and China:
A3, A4, A4-R, A5, A5-R, B4, 
B5, B5-R
North America:
LD, LG, LT, LT-R, ST, ST-R
China:
A3, A4, A4-R, A5, A5-R, B4, 
B5, B5-R, 8K, 16K, 16K-R

-

Reversing 
Automatic 
Document 
Feeder

Plain paper
Thin paper
Thick paper

(50 - 104 g/m2, 
13 - 27 lb. Bond)

Other than North America 
and China:
A3, A4, A4-R, A5-R, B4, B5, 
B5-R
North America:
LD, LG, LT, LT-R, ST-R, 
COMP
China:
A3, A4, A4-R, A5-R, 8K, 
16K, 16K-R

50 sheets (80 g/m2, 20 
lb. Bond)
(or stack height 9.5 

mm)*1
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The following types of originals can be used but need extra care:
 Originals that you cannot slide with your fingers or whose surface is specially treated: They should be 

fanned well before loading since they may not be able to be separated from each other at feeding.
 Originals that are folded or curled: They should be smoothed out before being loaded.

When black streaks appear

If the scanning area or the guide area is dirty, image problems such as black streaks may occur. Weekly 
cleaning of these areas is recommended.
 P.218 “Regular Cleaning”

 Copying originals

Follow the common basic instructions below to make a copy.

1 Place the original(s).

 Placing originals on the original glass

1) Raise the Platen Cover or the Reversing Automatic Document Feeder.
2) Place the original face down on the original glass.
3) Align the original with the top-left corner of the original glass.
4) Lower the Platen Cover or the Reversing Automatic Document Feeder carefully.

Do not place heavy objects (4 kg/8.8 lb. or over) on the original glass and do not force it 

down.

It may breaks the glass and could cause injury.

 When you copy originals with folds or wrinkles, smooth out the folds and wrinkles first. Then, 
place the original on the original glass and close the Platen Cover or the Reversing Automatic 
Document Feeder to start copying.
 If a shadow of the folds or wrinkles appears on copies although you smooth out them, adjust the 

exposure or use the “BACKGROUND ERASE” function.
 When you place a booklet-type original, strong light may leak out while copying. Do not look 

directly at the original glass.
 When you place a thick booklet, do not close the Platen Cover or the Reversing Automatic 

Document Feeder forcefully; you can still make copies without closing the cover or feeder.
 If lights from lighting devices are applied to the original glass, the original size may not be 

detected correctly. In this case, specify the original size.
 P.48 “Enlarging or reducing the copy size”

When you use the transparent original such as overhead transparencies and tracing paper, place a 
blank plain sheet of paper - the same size or a larger sheet - over the original, otherwise the copied 
image could be stained.
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 Placing originals on the Reversing Automatic Document Feeder

1) Align all the originals.
2) Place them face up and align the side guides to the original length.

 The top sheet of the originals will be scanned first.

 Do not load more than 50 originals (80 g/m2, 20 lb. Bond) at once, and make sure the thickness 
of the stack of originals does not exceed 9.5 mm regardless of their size.
 Flatten curled paper before loading it on the Reversing Automatic Document Feeder.
 To prevent long originals (A3, B4, A4-R, LD, LG, COMP, or 8K) from sliding out, raise the paper 

exit stopper. When you have finished using the stopper, lift it slightly and slide it back in.

 To prevent misfeeding, do not leave originals or turn OFF/ON the equipment with originals on the 
Reversing Automatic Document Feeder.

2 Press [COPY].
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3 Enter the number of copies with the digital keys.

4 Make the copy settings as required.

 P.44 “Copy Settings”

You may not be able to use some combinations of functions.
 P.227 “Copying Function Combination Matrix”

5 Press [START] to start copying.

To stop or resume copying, press [CLEAR/STOP] during copying.

Press [OK] or [CANCEL] according to the message displayed on the LCD screen.

When you copy loading originals from the Reversing Automatic Document Feeder (RADF):

If there are more originals, place the next ones, select “SCAN NEXT” using  or  and press [OK]. If 

there are no more originals, select “FINISHED” using  or  and press [OK].

When the copying has finished, press [FUNCTION CLEAR] to clear the set copy functions and return to 
the main screen (Copy).
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 If the paper source runs out of paper, an error message is displayed on the LCD screen and copying 
stops. Load paper. The equipment automatically resumes copying after approx. 3 seconds have 
passed.
 The receiving tray can hold up to 100 sheets. If the excessive paper error occurs, the lamp blinks and 

an error message is displayed on the LCD screen. Remove the paper from the tray and press [START] 
to resume copying.
 When you use overhead transparencies, remove them one by one every time they are ejected. 

Otherwise, they could be curled and not be good for projection.

 Shortcut keys

You can access some functions by simply pressing the  and  button.
 P.42 “Using the “EXPOSURE” or “ID CARD” function quickly”
 P.43 “Selecting “ORIGINAL MODE” quickly”

Using the “EXPOSURE” or “ID CARD” function quickly

On the first screen of Copy mode, the  button function varies depending on the region. It can work as the 
[EXPOSURE] button for Europe and the Americas, or the [ID CARD] button for regions other than Europe and 
the Americas. Just press the button to access the “EXPOSURE” or “ID CARD” function so that you can 
change the copy density, or you can copy the front and back of a card on a sheet of paper.
 P.44 “Adjusting the exposure”
 P.57 “Copying both sides of a card on a sheet”

For Europe and the Americas

For regions other than Europe and the Americas

AUTO EXPOSURE

TEXT/PHOTO

A41

READY

100%

EXPOSURE

AUTO

AUTO EXPOSURE

TEXT/PHOTO

A41

READY

100%

SET FRONT OF ID CARD

[START]
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Selecting “ORIGINAL MODE” quickly

On the first screen of Copy mode, the  button can work as the [ORIGINAL MODE] button. Just press the 
button to access the “ORIGINAL MODE” function so that you can change the original mode.
 P.45 “Selecting the original mode”

For Europe and the Americas

For regions other than Europe and the Americas

AUTO EXPOSURE

TEXT/PHOTO

A41

READY

100%

ORIGINAL MODE

TEXT/PHOTO

TEXT

PHOTO

AUTO EXPOSURE

TEXT/PHOTO

A41

READY

100%

ORIGINAL MODE

TEXT/PHOTO

TEXT

PHOTO
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Copy Settings

You can make the copy settings on the copy functions menu.

Press [CANCEL] to exit from the setting without making any changes.

 Adjusting the exposure

You can adjust the density to make copies lighter or darker in nine levels from -4 to +4. The auto density 
setting can represent the copy image in the middle density status.

You can directly access this function by pressing . The button operation varies depending on the region.
For Europe and the Americas:
 P.42 “Using the “EXPOSURE” or “ID CARD” function quickly”

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item.

4 Adjust the density as follows.

For “AUTO”:

Press [OK].
For manual:

1) Press  or  to increase or decrease the density level.
2) Press [OK].

Menu Functions Settings Description

EXPOSURE AUTO Adjusts the density automatically.

Manual Adjusts the density manually.

A41

READY

100%

AUTO EXPOSURE

TEXT/PHOTO
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 Selecting the original mode

You can select suitable original image to copy.

You can directly access this function by pressing .
 P.43 “Selecting “ORIGINAL MODE” quickly”

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK].

Menu Functions Settings Description

ORIGINAL MODE TEXT/PHOTO Text and photographs mixed.

TEXT Text only or text and fine illustration only.

PHOTO Photographs only.

BACKGROUND 

ERASE

Dark background is placed.

A41

READY

100%

AUTO EXPOSURE

TEXT/PHOTO
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 Selecting the paper

You can select the paper source in which the paper of the desired size and type is loaded.
 P.20 “Acceptable paper types”

 Selecting the paper source

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item.

To select the paper size:

1) Press .

2) Press  or  to select the paper size, and then press [OK].
To accept the setting:

Press [OK].

Menu Functions Settings Description

DRAWER Drawer 1 XX, Drawer 2 

XX, Drawer 3 XX, 
Drawer 4 XX

Uses the drawer as the paper source. The variable 
“XX” indicates the paper size.

Bypass XX Uses the bypass tray as the paper source. Available 
only when the paper is loaded on the bypass tray. 
The variable “XX” indicates the paper size.

APS Automatic Paper Selection. Detects the size of the 
original and selects paper of the same size 
automatically.

This function may not work properly for totally dark originals or originals with 
dark borders.

For the detectable original sizes, see the following page:
 P.38 “Acceptable originals”

A41

READY

100%

TEXT/PHOTO

A41
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 Selecting the bypass tray automatically

When you load paper into the bypass tray, the paper source automatically changes from the drawer to the 
bypass tray. The LCD screen automatically changes so that you can easily set the paper size and type for the 
bypass tray.

1 Press  or  to select the paper size, and then press [OK].

2 Press  or  to select the paper type, and then press [OK].

Remove the paper from the bypass tray after copying is finished. The paper source automatically changes 
back to the drawer.

BYPASS

A3

A4

A4-R

BYPASS PAPER TYPE

PLAIN

THICK

THICK1
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 Enlarging or reducing the copy size

You can enlarge or reduce the size of copies in the following three ways.
 Specify the ratio manually ( P.48)
 Select a fixed zoom ratio ( P.49)
 Automatic Magnification Selection (AMS) ( P.51)

 Specifying the ratio manually

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item for manual zoom.

When manual zoom is already selected, this step is not necessary.

Menu 

Functions
Settings Description

ZOOM Manual zoom (25 - 100 - 400%) Adjusts the ratio manually.

FIXED ZOOM A/B format:

50% (A3 -> A5), 71% (A3 -> A4), 
71% (A4 -> A5), 141% (A4 -> A3), 
141% (A5 -> A4), 200% (A5 -> A3), 
300%, 400%
LT format:

50% (A3 -> A5), 60% (LG -> ST), 
65% (LD -> LT), 65% (LT -> ST), 
78% (LD -> LG), 78% (LG -> LT), 
100% (LT -> LG), 121% (LG -> LD), 
129% (LT -> LD), 129% (ST-> LT), 
154% (ST -> LG), 200% (ST -> LD), 
300%, 400%
K format:

50% (A3 -> A5), 54% (8K -> A5), 
64% (A3 -> 16K), 69% (8K -> 16K), 
71% (A3 -> A4), 71% (A4 -> A5), 
76% (16K -> A5), 76% (8K -> A4), 
91% (A3 -> 8K), 91% (A4 -> 16K), 
108% (16K -> A4), 108% (8K -> A3), 
129% (A4 -> 8K), 129% (A5 -> 16K), 
138% (16K -> 8K), 141% (A4 -> A3), 
141% (A5 -> A4), 152% (16K -> A3), 
182% (A5 -> 8K), 200% (A5 -> A3), 
300%, 400%

 P.49 “Selecting a fixed 
zoom ratio”

AMS  P.51 “Automatic 
magnification selection (AMS)”

A41

READY

100%

100%

A41
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4 Press  or  to increase or decrease the zoom ratio, and then press [OK].

You can keep pressing the button to adjust the ratio quickly.

To make an enlarged or reduced copy of an original placed in portrait direction onto a paper in landscape 
direction, select “AMS” for zoom ratio.
 P.51 “Automatic magnification selection (AMS)”

 Selecting a fixed zoom ratio

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

Menu 

Functions
Settings Description

ZOOM Manual zoom (25 - 100 - 400%)  P.48 “Specifying the ratio 
manually”

FIXED ZOOM A/B format:

50% (A3 -> A5), 71% (A3 -> A4), 
71% (A4 -> A5), 141% (A4 -> A3), 
141% (A5 -> A4), 200% (A5 -> A3), 
300%, 400%
LT format:

50% (A3 -> A5), 60% (LG -> ST), 
65% (LD -> LT), 65% (LT -> ST), 
78% (LD -> LG), 78% (LG -> LT), 
100% (LT -> LG), 121% (LG -> LD), 
129% (LT -> LD), 129% (ST-> LT), 
154% (ST -> LG), 200% (ST -> LD), 
300%, 400%
K format:

50% (A3 -> A5), 54% (8K -> A5), 
64% (A3 -> 16K), 69% (8K -> 16K), 
71% (A3 -> A4), 71% (A4 -> A5), 
76% (16K -> A5), 76% (8K -> A4), 
91% (A3 -> 8K), 91% (A4 -> 16K), 
108% (16K -> A4), 108% (8K -> A3), 
129% (A4 -> 8K), 129% (A5 -> 16K), 
138% (16K -> 8K), 141% (A4 -> A3), 
141% (A5 -> A4), 152% (16K -> A3), 
182% (A5 -> 8K), 200% (A5 -> A3), 
300%, 400%

Selects a fixed zoom ratio.

AMS  P.51 “Automatic 
magnification selection (AMS)”

ZOOM

- 100% +
FIXED ZOOM

AMSAMS

A41

READY

100%

100%

A41
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3 Press  or  to select “FIXED ZOOM”, and then press .

4 Press  or  to select a zoom ratio, and then press [OK].

To make an enlarged or reduced copy of an original placed in portrait direction onto a paper in landscape 
direction, select “AMS” for zoom ratio.
 P.51 “Automatic magnification selection (AMS)”

ZOOM

- 100% +
FIXED ZOOM

AMSAMS
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Automatic magnification selection (AMS)

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

Menu 

Functions
Settings Description

ZOOM Manual zoom (25 - 100 - 400%)  P.48 “Specifying the ratio 
manually”

FIXED ZOOM A/B format:

50% (A3 -> A5), 71% (A3 -> A4), 
71% (A4 -> A5), 141% (A4 -> A3), 
141% (A5 -> A4), 200% (A5 -> A3), 
300%, 400%
LT format:

50% (A3 -> A5), 60% (LG -> ST), 
65% (LD -> LT), 65% (LT -> ST), 
78% (LD -> LG), 78% (LG -> LT), 
100% (LT -> LG), 121% (LG -> LD), 
129% (LT -> LD), 129% (ST-> LT), 
154% (ST -> LG), 200% (ST -> LD), 
300%, 400%
K format:

50% (A3 -> A5), 54% (8K -> A5), 
64% (A3 -> 16K), 69% (8K -> 16K), 
71% (A3 -> A4), 71% (A4 -> A5), 
76% (16K -> A5), 76% (8K -> A4), 
91% (A3 -> 8K), 91% (A4 -> 16K), 
108% (16K -> A4), 108% (8K -> A3), 
129% (A4 -> 8K), 129% (A5 -> 16K), 
138% (16K -> 8K), 141% (A4 -> A3), 
141% (A5 -> A4), 152% (16K -> A3), 
182% (A5 -> 8K), 200% (A5 -> A3), 
300%, 400%

 P.49 “Selecting a fixed 
zoom ratio”

AMS Detects the size of the original 
and automatically sets the 
optimum zoom ratio for the 
paper size.

This function may not work properly for totally dark originals or originals with dark 
borders.

For the detectable original sizes, see the following page:
 P.38 “Acceptable originals”

A41

READY

100%

100%

A41
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3 Press  or  to select “AMS”, and then press [OK].

To make an enlarged or reduced copy of an original placed in portrait direction onto a paper in landscape 
direction, select “AMS” for zoom ratio.
 P.51 “Automatic magnification selection (AMS)”

ZOOM

- 100% +
FIXED ZOOM

AMSAMS
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 Sorting pages

You can sort a number of copied pages in the same order as the original.

NON SORT: Not to sort the copied pages. All copies of the first page are ejected first and then all copies of 
subsequent pages are ejected in sequence.

SORT: Sorts the copied pages in the same order as the original and eject all sets of copies in the 
same orientation.

ROTATE SORT:When you make several sets of copies, the copies can be sorted and made to exit alternately 
one set by one. This is called alternation. You need to place copy paper in one paper source 
in a landscape direction and place that of the same size in another paper source in a portrait 
direction in advance.

Paper of letter, A4, B5, LT, or 16K size can be loaded in drawers or on the bypass tray for “ROTATE 
SORT”.
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When an original is placed on the Reversing Automatic Document Feeder, “SORT” is automatically set.

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK].

4 Specify the number of copies to “2” or more.

 P.39 “Copying originals”

When placing the original on the original glass

After the first original is scanned, the LCD screen shows “NEXT ORIGINAL?”.
Make sure that “SCAN NEXT PAGE” is selected, place the next original on the original glass, and then press 
[OK] or [START]. When all the originals have been scanned, select “FINISHED”, and then press [OK] or 
[START].

“CANCEL JOB?” is displayed if there is no operation for a certain period.

Menu Functions Settings

FINISHING NON SORT

SORT

ROTATE SORT

A41

READY

100%

100%

NON SORT
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 Copying two or four pages on each sheet

You can copy two or four original pages on each sheet of paper.

OFF: Disables this function.
2IN1: Copies two pages on a sheet of paper.

4IN1: Copies four pages on a sheet of paper.

 Be sure the [Paper size], [EXPOSURE] and the like are set before selecting [2IN1/4IN1].
 You need to make settings to use the “2IN1/4IN1” function from “USER FUNCTIONS” - “COPY” - “2IN1/

4IN1”.
 P.180 “User functions menu items”
 This function is not available for some paper sizes. If you have set the unavailable sizes, the LCD 

screen shows the error message and you cannot use this function.
 P.20 “Preparation 2 - Loading Paper”
 P.35 “Preparation 3 - Registering Paper Size and Type”
 Copying without specifying paper size and direction of the original pages may result in unexpected 

page allocation order or image position.
 When a 2-sided original is placed with its top on the left of the Reversing Automatic Document Feeder 

in 2in1/4in1 copying, set [IMAGE DIRECTION] to “OFF”.

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press .

Menu Functions Settings

2IN1/4IN1 OFF

2IN1

4IN1

A41

READY

100%

NON SORT

2IN1/4IN1:OFF
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4 Follow the instructions on the LCD screen to use the “2IN1/4IN1” function. You are 

instructed to make the following settings.

 ORIGINAL SIZE

Press  or  to select the size of the original.
 ORIGINAL ORIENTATION

Press  or  to select the portrait or landscape orientation of the original.
 SET ORIGINAL

Place the originals as shown on the LCD screen. Make sure that you place the original in the same 
orientation as the one selected in “ORIG. ORIENTATION”.
 NEXT ORIGINAL?

When you place the original on the original glass, this message appears. Press  or  to select 
“SCAN NEXT PAGE”. Select “FINISHED” when you have finished scanning your originals.

 The size of the original selected in [ORIGINAL SIZE] is disabled if it is detected automatically.
For the detectable original sizes, see the following page:
 P.38 “Acceptable originals”
 If the size of the original is not detected automatically, specify [ORIGINAL SIZE] and place the 

original on the original glass.
 “CANCEL JOB?” is displayed if there is no operation for a certain period.
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 Copying both sides of a card on a sheet

You can copy the front and back of a card on a sheet of paper.

You can directly enable this function by pressing . The button operation varies depending on the region.
For regions other than Europe and the Americas:
 P.42 “Using the “EXPOSURE” or “ID CARD” function quickly”

 Be sure to set the paper size and density, etc. before selecting [ID CARD].
 The settings for the area to scan originals and the print position vary from region to region, so that the 

area wider than the card frame of the original glass might be scanned depending on the region.
 The upper and left areas (about 4 mm in width) cannot be copied. To copy up to the edges of a card, 

place the card apart from the edges of the original glass.

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK].

Menu Functions Settings

ID CARD OFF

ON

Front side Back side

A41

READY

100%

2IN1/4IN1:OFF

ID CARD:OFF
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4 Follow the instructions on the LCD screen to use the “ON” function. You are instructed 

to make the following settings.

 SET FRONT OF ID CARD

Place the front of a card face down at the upper left on the original glass, and then press [START].

 SET BACK OF ID CARD

Turn over the card and place the back surface face down on the original glass, and then press 
[START].

“CANCEL JOB?” is displayed if there is no operation for a certain period.
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 Erasing the shadow on edges

You can erase the shadow on the edges of copies. When you copy thick books, you can erase the 
surrounding shadow with this function. The area to erase can be changed from 4 to 15 mm (0.2 to 0.6") in 
increments of 1 mm (0.04").

 This function is available only for paper of standard sizes.
 If the original is different from paper in size (the ratios of width and height are different), the shadow 

might not be erased on some edges.

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item.

4 Set the setting as follows.

For “OFF”

Press [OK].
For “ON”

1) Press .

2) Press  or  to increase or decrease the value for the area to erase.
3) Press [OK].

If you just press [OK] for “ON”, the default value (7 mm (0.3")) of this function is used.

Menu Functions Settings

EDGE ERASE OFF

ON

A41

READY

100%

ID CARD:OFF

EDGE ERASE:OFF
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 Copying right and left pages separately

When you place a booklet-type original on the original glass while it is being opened, the right and left pages 
of the opened section can be copied separately on different paper. Also, they can be copied on both sides of 
paper. You do not need to move the original on the original glass. The book margin width can be set between 
8 to 30 mm (0.3 to 1.2") in increments of 1 mm (0.04").

A4, B5, LT, and 16K sizes are available for this function.

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item.

4 Set the setting as follows.

For “OFF”

Press [OK].
For “ON”

1) Press .

2) Press  or  to increase or decrease the value for the book margin width.
3) Press [OK].

If you just press [OK] for “ON”, the default value (15 mm (0.6")) of this function is used.

Menu Functions Settings

DUAL PAGE OFF

ON

22 3 3

A41

READY

100%

EDGE ERASE:OFF

DUAL PAGE:OFF
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 Shifting the pages to the right or left

You can shift pages to the right or left. The shifted area can be used as a margin for punching holes or 
stapling. The margin can be changed from 4 to 15 mm (0.2 to 0.6") in increments of 1 mm (0.04").

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item.

4 Set the setting as follows.

For “OFF”

Press [OK].
For “LEFT MARGIN” or “RIGHT MARGIN”:

1) Press .

2) Press  or  to increase or decrease the value for the margin.
3) Press [OK].

If you just press [OK] for “ON”, the default value (7 mm (0.3")) of this function is used.

Menu Functions Settings

IMAGE SHIFT OFF

LEFT MARGIN

RIGHT MARGIN

A41

READY

100%

DUAL PAGE:OFF

IMAGE SHIFT:OFF
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 Copying on one or both sides

You can select whether originals and paper are 1-sided or 2-sided individually. You can make copies of 1-
sided originals into the both sides of paper so that you can save paper.

1 > 1 SIMPLEX ( P.63 “Copying on one side”)

1 > 2 DUPLEX ( P.64 “Copying on both sides”)

2 > 2 DUPLEX ( P.64 “Copying on both sides”)

2 > 1 SPLIT ( P.63 “Copying on one side”)

To scan 2-sided originals automatically, the Reversing Automatic Document Feeder is required.
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Copying on one side

You can copy 1-sided or 2-sided originals on the one side of paper.

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the item for copying on one side, and then press [OK].

When placing the original on the original glass

After the first original is scanned, the LCD screen shows “NEXT ORIGINAL?”.
Make sure that “SCAN NEXT PAGE” is selected, place the next original on the original glass, and then press 
[OK] or [START]. When all the originals have been scanned, select “FINISHED”, and then press [OK] or 
[START].

“CANCEL JOB?” is displayed if there is no operation for a certain period.

Menu Functions Settings Description

2-SIDED 1 > 1 SIMPLEX 1-sided original -> 1-sided copy.

1 > 2 DUPLEX 1-sided original -> 2-sided copy. ( P.64)

2 > 2 DUPLEX 2-sided original -> 2-sided copy. ( P.64)

2 > 1 SPLIT 2-sided original -> 1-sided copy.

A41

READY

100%

IMAGE SHIFT:OFF

1 > 1 SIMPLEX
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Copying on both sides

You can copy 1-sided or 2-sided originals on the both side of paper.

For double-sided printing, use plain paper (64 to 80g/m2).

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the item for copying on both sides, and then press .

4 Press  or  to select the finishing mode, and then press [OK]. Select “BOOK” for 

“open to left”, or “TABLET” for “open to top”.

When placing the original on the original glass

After the first original is scanned, the LCD screen shows “NEXT ORIGINAL?”.
Make sure that “SCAN NEXT PAGE” is selected, place the next original on the original glass, and then press 
[OK] or [START]. When all the originals have been scanned, select “FINISHED”, and then press [OK] or 
[START].

“CANCEL JOB?” is displayed if there is no operation for a certain period.

Menu Functions Settings Description

2-SIDED 1 > 1 SIMPLEX 1-sided original -> 1-sided copy. ( P.63)

1 > 2 DUPLEX 1-sided original -> 2-sided copy.

2 > 2 DUPLEX 2-sided original -> 2-sided copy.

2 > 1 SPLIT 2-sided original -> 1-sided copy. ( P.63)

A41

READY

100%

IMAGE SHIFT:OFF

1 > 1 SIMPLEX
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 Adding a page number and date/time on the copied paper

You can add a page number and date/time on the copied paper.

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK].

 Removing blank pages

You can skip blank pages in the original when copying.

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK].

Menu Functions Settings

ANNOTATION OFF

PAGE NO.

PAGE No.+DATE/TIME

A41

READY

100%

1 > 1 SIMPLEX

ANNOTATION:OFF

Menu Functions Settings

OMIT BLANK 

PAGE

OFF

ON

1 3

5 6

1 3

5 6

A41

READY

100%

ANNOTATION:OFF

OMIT BLANK:OFF
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 Copying different sizes in one go

When different sizes of originals are mixed and placed on the Reversing Automatic Document Feeder, some 
combinations of sizes can be copied in one go. The combination of A3 and A4, B4 and B5, or A4-R and 
FOLIO is available.

 Bypass copying is disabled. Place paper in the drawer.
 When this function sets to “ON”, the equipment is switched to the automatic paper selection mode. In 

the automatic paper selection mode, a copy is made on copy paper of the same size as the original. 
Place paper whose sizes are the same as those of the originals in the corresponding drawers in 
advance.

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK].

Menu Functions Settings

MIX-ORIGINAL OFF

ON

A41

READY

100%

OMIT BLANK:OFF

MIX-ORIGINAL:OFF
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 Image direction

When you make 1-sided portrait originals to 2-sided copy by placing them in a landscape direction, normally 
the copied pages are “open to top”. With this function you can make them “open to left”. This function is called 
“image direction”.
When you make 2-sided “open to left” portrait originals to 1-sided copy, normally the copied pages exit in a 
different direction alternately. With this function, you can make them all exit in the same direction.

1-sided portrait original (placed in a landscape direction) -> 2-sided copy

2-sided “open to left” portrait original -> 1-sided copy

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK] or .

Menu Functions Settings

IMAGE DIRECTION OFF

ON

No setting“IMAGE DIRECTION” set

No setting“IMAGE DIRECTION” set

A41

READY

100%

MIX-ORIGINAL:OFF

IMAGE DIRECTION:ON
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 Continuing the scanning for a copy

When you copy with the Reversing Automatic Document Feeder (RADF), you can select whether you 
continue scanning the next originals after the last loaded original is scanned.

1 Press [COPY].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK].

Menu Functions Settings

CONTINUE SCAN OFF

ON

A41

READY

100%

IMAGE DIRECTION:OFF

CONTINUE SCAN:ON
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 Confirming the current function settings

1 Press [SETTINGS].

2 Press  or  to scroll through the menu.

For details on the displayed functions and settings, see the pages below.
 P.172 “Copy menu items”

3 When you are finished with confirmation, press [SETTINGS] again.
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Using Templates (Copy)

Once you have set the several functions and settings, you can register up to three of them as “templates” and 
recall one of
them for frequent use.

 Registering the templates

1 Make settings for the functions to register as a template.

2 Press [TEMPLATE].

3 Press  or  to select “REGISTRATION”, and then press .

4 Press  or  to select a template, and then press [OK].

 You can register three templates for copying.
 The settings are overwritten if you select an existing template.
 You can also register and edit templates with TopAccess. For details, refer to the TopAccess Guide.

You can specify the following items in copy templates.

No. Item Name Settings

1 Copy Quantity 1-999

2 Exposure AUTO, MANUAL(±4)

3 Original Mode TEXT/PHOTO, TEXT, PHOTO, BACKGROUND ERASE

4 Paper Source Drawer 1~4, Bypass, APS

5 Zoom 25~400%, AMS

6 Finishing NON SORT, SORT, ROTATE SORT

7 Nin1 OFF, 2IN1, 4IN1

8 Nin1-Original size

9 Nin1-Original orientation PORT., LAND.

10 ID Card OFF, ON

11 Edge Erase OFF, ON

12 Edge Erase  Adjustment 4~15

13 Dual Page OFF, ON

14 Dual Page  Adjustment 8~30

15 Image Shift OFF, LEFT, RIGHT

TEMPLATE

RECALL

REGISTRATION



2.COPY FUNCTIONS

Using Templates (Copy)    71

2 COPY FUNCTIONS

* This item is available only when the Reversing Automatic Document Feeder (RADF) is installed.

 Recalling a template

1 Press [TEMPLATE].

2 Press  or  to select “RECALL”, and then press .

3 Press  or  to select a template, and then press [OK].

16 Image Shift  Adjustment 4~15

17 2-Sided 1>1 SIMPLEX, 1>2 DUPLEX, 2>2 DUPLEX, 2>1 SPLIT

18 2-Sided BOOK, TABLET

19 Annotation OFF, PAGE NO., PAGENO.+DATE/TIME

20 Omit Blank Page OFF, ON

21 Mixed Size Original OFF, ON

22 Image Direction OFF, ON

23 Continue Scan* OFF, ON

No. Item Name Settings

TEMPLATE

RECALL

REGISTRATION
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Before Using the Printer Driver

Before printing, you have to configure the following options:
 Configuration Settings

To use devices installed in this equipment, you must first configure their options on the [Configuration] tab 
of the printer driver.
 P.74 “Configuring the options”
 Department Code

This system can manage jobs by department codes. This feature allows you to manage job counters for 
each department code. For example, a network administrator can check the number of copies printed by a 
specific department.
If the department code function is enabled, enter your department code provided by your administrator.

 Configuring the options

To use this equipment properly, you need to save the configuration of the options installed on the 
[Configuration] tab menu after you installed the printer drivers. In the default setting, you can obtain the 
configuration data of options installed automatically by opening the [Configuration] tab menu. If SNMP 
communication between this equipment and your computer is not available, or you want to configure options 
manually, see the following page:
 P.74 “Configuring options manually”

When SNMP communication between this equipment and your computer is enabled, you can retrieve the 
option configuration information by clicking [Update Now].

Configuring options manually

If SNMP communication between this equipment and your computer is not available:

Setting the [Configuration] tab manually

You need to log in to Windows with the “Administrator” privilege.

1 Click [Start] and select [Devices and Printers].

The Printers folder appears.

 For Windows Vista or Windows Server 2008
Click [Start], [Control Panel], [Hardware and Sound] and select [Printers].
 For Windows 8 or Windows Server 2012, see the procedures in the following section.
 P.77 “Accessing the printers folder on Windows 8 / Windows Server 2012”
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2 Select your printer, and then click [Printer properties] in the [File] menu.

The printer driver properties dialog box appears.

 For Windows Vista / Windows Server 2008, click [Properties] in the [File] menu and select your 
printer.
 If the [File] menu is not displayed, press [Alt].
 If the dialog box displayed does not allow the printer driver properties to be changed, follow the 

procedure below.
- For Windows Vista, click [Run as administrator] and [Properties] in the [File] menu.

If the password entry screen appears, enter the administrator password.
The [User Account Control] dialog box appears. Click [Continue].

- For Windows 7, some tab menus have a  button in the printer driver properties. To change the 
properties, click on it. If the properties cannot be changed, ask your system administrator.

3 Select the [Configuration] tab menu, and set the following options.

Model Selection — Select the model name.
Option - Automatic Duplexing Unit — Be sure to select this check box to use the equipment.
Option - Drawers — Select the drawer configuration.

For more information about each item, see the descriptions about the Configuration tab.
 P.102 “[Configuration] tab”
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4 Click [Drawer Settings].

The [Drawer Settings] dialog box appears.

5 Set the following options and click [OK].

Drawer 1 — Select the size of paper that is loaded in the Drawer 1. The paper type for the drawer is 
fixed to [Plain].
Drawer 2 — Select the size of paper that is loaded in the Drawer 2. The paper type for the drawer is 
fixed to [Plain].
Drawer 3 — Select the size of paper that is loaded in the Drawer 3. The paper type for the drawer is 
fixed to [Plain].
Drawer 4 — Select the size of paper that is loaded in the Drawer 4. The paper type for the drawer is 
fixed to [Plain].
Bypass Tray — Select the size and type of paper that is loaded in the Bypass Tray.

 Setup items differ depending on the model and the option configuration.
 For more information about each item, see the descriptions about the Drawer Settings.
 P.103 “Drawer Settings”

6 Click [Apply] or [OK] to save settings.
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Accessing the printers folder on Windows 8 / Windows Server 2012

Follow the steps below to access the printers folder on Windows 8 / Windows Server 2012.

1 Move the cursor to the upper right corner or lower right corner of the computer screen, 

and then select [Start] in the menu that appears.

The [Start] screen appears.

2 Right-click in the blank area in the [Start] screen, and then click [All apps] that appears.

The [Apps] screen appears.
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3 Click [Control Panel].

The [All Control Panel Items] screen appears.

4 Click [Devices and Printers].

The [Devices and Printers] folder appears.

 Setting the department code

When the department code function is enabled on this equipment, you have to enter your department code to 
the printer driver.
This allows a network administrator to check the number of copies printed by specific department.
Ask your administrator whether you should enter the department code. If you should, obtain the department 
code you need to enter.
If the department code is required, you can enter the department code into the [Department Code] box of the 
printer as described below to save you having to enter the department code each time you print.

If printing is performed with an incorrect department code, a dialog box indicating that it is incorrect 
appears. In this case, enter the correct one or stop transmitting. If this dialog box does not appear, the job 
becomes invalid and is deleted. An error report is then printed out from this equipment.

A department code needs to be entered every time you begin printing. If you have to use a different 
department code for each print job, enter it when you begin printing.
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Entering department code

1 Click [Start] and select [Devices and Printers].

The Printers folder appears.

 For Windows Vista or Windows Server 2008
Click [Start] menu, [Control Panel], [Hardware and Sound] and select [Printers].
 For Windows 8 or Windows Server 2012, see the procedures in the following section.
 P.77 “Accessing the printers folder on Windows 8 / Windows Server 2012”

2 Select your printer, and then click [File] menu and select [Printing Preferences].

 If the [File] menu is not displayed, press [Alt].
 The printing preferences dialog box appears.

3 Display the [Others] tab menu and enter your department code in the [Department 

Code] box.

The department code is a 5-digit number.

4 Click [Apply] or [OK] to save the settings.
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Printing From Application

This section describes how to print a document from application.
 P.80 “Considerations and limitations”
 P.80 “How to print”

 Considerations and limitations

 Some print options can be set from both the application and the printer driver, such as collation. If the 
collation is set from the application, documents may not be properly printed. If that happens, use the 
printer driver to set the collation. Depending on the application, some print options such as the orientation 
need to be set from the application. For print options that can be set from both the application and the 
driver, refer to the manual of the application.
 Some print options are not displayed on the screen of printer driver depending on the model or type of 

printer driver.

 How to print

Once you have installed the printer driver and configured it properly, you can print directly from most Windows 
applications. Simply choose the Print command from your application.
You can print using the various functions by setting print options on the printer driver.

Printing from Windows applications

The following describes an example for printing from Notepad on Windows 7.

1 Open a file and select [Print] from the application’s [File] menu.

The [Print] dialog box appears.

2 Select your printer, and then click [Preferences].

The printing preferences dialog box appears.

The procedures for displaying the properties dialog for the printer driver may be different depending on the 
application that you are using. See your application’s manual about displaying the printer properties dialog 
box.
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3 Setting the print options on each tab according to how you want to print.

 Setting the print options varies depending on how you want to print a document.
 P.87 “Print options”

4 Click [OK] to save the settings.

5 Click [Print] to print a document.
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Status Monitor

The status monitor is utility software that is installed with the printer driver. It can monitor the current print job 
and the current status of the equipment.
 P.82 “Monitoring the print status and reporting print errors”

 Monitoring the print status and reporting print errors

You can start the status monitor from the [Status Monitor] button on the printer driver screen. When started, 
the status monitor icon appears in the notification area of the Windows taskbar.

The icon changes according to the status of the equipment.

  is a “Ready” icon that indicates the equipment is ready to print.

  is a “Warning” icon that prompts you to take action as soon as possible.

  is an “Error” icon that prompts you to take a troubleshooting action soon.
If any error occurs, the LCD screen also shows the error message.

You can double-click the icon, or right-click it and select “Start” to open the status monitor dialog and see the 
detailed information.

If you right-click the “Status Notify” icon and select “Exit”, the status monitor terminates the operation.
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Setting up Print Options

Print Options are the attributes you set to define the way a print job is processed.
 P.83 “How to set up”
 P.87 “Print options”

To find the printing instructions for your specific needs, see the procedures in the following section.
 P.105 “Printing With Best Functions for Your Needs”

 How to set up

There are several ways to set print options. How the settings affect printing varies depending on the way you 
set the options. The tabs displayed also vary depending on how you display the printer properties.
 P.83 “Setting initial values of print options”
 P.83 “Setting print options for each print job”
 P.84 “Setting print options using profiles”

 Setting initial values of print options

Setting the print options by displaying the printer properties from the Printers folder within the Windows Start 
menu will establish the initial values of the options. For example, the paper size setting you most commonly 
use, etc., are settings you will not want to change every time you print. It is convenient to set these options as 
initial values.

How to display:

1  Click [Start] and select [Devices and Printers].

 For Windows Vista or Windows Server 2008
Click [Start], [Control Panel], [Hardware and Sound] and select [Printers].
 For Windows 8 or Windows Server 2012, see the procedures in the following section.
 P.77 “Accessing the printers folder on Windows 8 / Windows Server 2012”

2 Select your printer, and then click [Printing preferences] in the [File] menu.

 Setting print options for each print job

The print options that are set in properties dialog box, which can be accessed from the [Print] dialog box of the 
application, are only applied to the current print job, so once you close the application, the options will be 
invalid.

How to display:

1 Click the [File] menu and select [Print] on application.

2 Select your printer, and then click [Preferences].
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 Setting print options using profiles

Using profiles, you can save the print settings or apply the saved settings to a print job.

In order to print a document using profiles, you must first create the saved profile.
 P.84 “Saving profile”
Once you save a profile, you can apply its settings to a print job.
 P.85 “Loading profile”
You can also delete unnecessary profiles.
 P.85 “Deleting profile”

Saving profile

You can register up to 20 profiles for each printer driver.

1 Configure the print options on each tab.

Setting the print options varies depending on how you want to print a document.
 P.87 “Print options”

2 Click [Save Profile] in the Profile group.

The [Profile Name] dialog box appears.

3 Enter the profile name and click [OK].

The file name must be up to 63 characters long.

 If you enter an existing profile name, you are prompted to confirm whether you want to overwrite 
it. If you want, click [OK].
 If you try to save more than 20 profiles, a dialog box notifying you that no more can be saved 

appears, then the 21st profile is saved as a temporary profile. If you want to register this 
temporary profile, delete unnecessary profiles first, and then select [Temporary Profile] to recall 
this profile and click [Save Profile] to save it.
 You cannot specify [None] for the profile name.

4 The profile is saved.
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Loading profile

1 Select a profile in the [Profile] box.

The setting options in the profile are reflected on each tab.

To restore the default settings after you select the profile, click [Restore Defaults] on each tab. 
Selecting [None] on the [Profile] box will not restore them.

Deleting profile

1 Select the profile that you want to delete in the [Profile] box, and click [Delete].

The [Confirm Delete] dialog box appears.
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2 Click [Yes] to delete the selected profile.
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 Print options

This section describes print options in each tab of the printer driver. This section will help you to find the 
description of specific print options, or understand their individual functions.
 P.89 “[Basic] tab”
 P.91 “[Finishing] tab”
 P.95 “[Image Quality] tab”
 P.96 “[Effect] tab”
 P.99 “[Others] tab”
 P.102 “[Configuration] tab”

The following tabs are the setting items which depend on the OS. For their setting procedures and details, 
refer to the Operator's Manual or the Help of the OS to be used.
- [General] tab
- [Sharing] tab
- [Ports] tab
- [Advanced] tab
- [Color Management] tab
- [Security] tab

How to display:

1 Click [Start] and select [Devices and Printers].

The Printers folder appears.

 For Windows Vista or Windows Server 2008
Click [Start], [Control Panel], [Hardware and Sound] and select [Printers].
 For Windows 8 or Windows Server 2012, see the procedures in the following section.
 P.77 “Accessing the printers folder on Windows 8 / Windows Server 2012”

2 Select your printer, and then click [Printing preferences] in the [File] menu.

 If the [File] menu is not displayed, press [Alt].
 The printing preferences dialog box appears.
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1) Printer Name

Displays the name given to the printer driver when it was installed, or the name it displays on the icon in 
the Printer folder.

2) Menu Tabs

The menu items of the printer driver are displayed as tabs. Clicking on a tab will display the contents of the 
selected tab. The tabs displayed vary depending on the way the print properties are displayed.
- [Basic] tab

Contains basic print operation settings, such as original paper size, print paper size, paper source, 
paper type, orientation, and so on.
 P.89 “[Basic] tab”

- [Finishing] tab

Allows you to enable sort printing and N-up printing, and so on.
 P.91 “[Finishing] tab”

- [Image Quality] tab

Allows you to select how images are printed.
 P.95 “[Image Quality] tab”

- [Effect] tab

Contains print options that add the effects to your print jobs such as Watermarks, and so on.
 P.96 “[Effect] tab”

- [Others] tab

Contains special features such as toner save, and so on.
 P.99 “[Others] tab”

- [Configuration] tab

Allows you to configure the device options of the equipment. This tab is only displayed when the printer 
properties are accessed from the Printers folder.
 P.102 “[Configuration] tab”

3) Preview window

In the Preview window, you can preview how a document will be printed under the current settings of the 
printer driver. The image of a page to which the set print options are applied is displayed.

4) Profile

Print option settings can be saved on your memory. You can save print option settings by clicking [Save 
Profile] and easily load a setting file by selecting a profile name in the box.
 P.84 “Setting print options using profiles”

5) [OK]

Enters the input settings and complete the print option settings.

6) [Cancel]

Cancels the input settings and exit the print option settings.

7) [Apply]

Enters the input settings without closing the print option settings. This button is only displayed when the 
printer properties are accessed from the Printers folder. This button remains grayed out until a setting is 
changed.

8) [Help]

Opens the Help for the printer driver.
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 [Basic] tab

The [Basic] tab contains basic print operation settings, such as the original paper size, print paper size, paper 
source, paper type, orientation, and so on.

1) Original Paper Size

Selects the size of a document to be printed.

 The default paper size will be [A4] or [Letter] according to the regional setting in the Windows.
 Setup items differ depending on the model.

2) Print Paper Size

Enlarges or reduces a page image to fit exactly in the selected paper size. If you do not wish to enable 
enlarge or reduce printing, select [Same as Original Size].

3) Manual Scale

Enter the scale manually to enlarge or reduce an image. The ratio can be set at between 25 and 400%.

If originals which include thin lines are printed when the zoom ratio is set, the line width may vary.

For detailed instructions on how to print with the [Manual Scale] setting, see the following page:
 P.105 “Fitting images within paper size”

Available original paper sizes are listed below:

 A4 (210 x 297 mm)
 A5 (148 x 210 mm)
 A3 (297 x 420 mm)
 B4 (257 x 364 mm)
 B5 (182 x 257 mm)
 Folio (210 x 330 mm)
 Letter (8 1/2 x 11") 
 Legal (8 1/2 x 14") 
 Ledger (11 x 17") 
 Statement (5 1/2 x 8 1/2") 
 Computer (10 1/8 x 14") 
 13"LG (8 1/2 x 13") 

 8.5"SQ (8 1/2 x 8 1/2") 
 16K (195 x 270 mm)
 8K (270 x 390 mm)
 Env-Com10 (4 1/8 x 9 1/2")
 Env-Monarch (3 7/8 x 7 1/2")
 Envelope DL (110 x 220 mm)
 Envelope Cho-3 (120 x 235 mm)
 Envelope You-4 (105 x 235 mm)
 Env-C4 (9.02 x 12.76")
 Env-C5 (6.38 x 9.02")
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4) Paper Source

Selects a paper source to print a job in the most suitable paper size. The figure on the right indicates the 
paper size set for each paper source. When you select a paper source, the chosen one is indicated with a 
green square in the figure.
- Auto — Automatically selects the paper set in this equipment according to the printed document size.
- Drawer 1 — Paper is fed from the Drawer 1.
- Drawer 2 — Paper is fed from the Drawer 2.
- Drawer 3 — Paper is fed from the Drawer 3.
- Drawer 4 — Paper is fed from the Drawer 4.
- Bypass Tray — Paper is fed from the Bypass Tray.

The selectable values vary depending on the devices installed in this equipment and their configuration 
on the [Configuration] tab.

5) Paper Type

Sets the paper type.
- Plain — Printing on plain paper.
- Thick — Printing on thick paper.
- Thick1 — Printing on thick 1 paper.
- Thick2 — Printing on thick 2 paper.
- Transparency — Printing on transparent sheets.
- Thin — Printing on the back side of thin paper.

 When [Drawer 1] to [Drawer 4] is selected in the [Paper Source] box, only [Plain] can be chosen in 
the [Paper Type] box.
 When [Envelope] is selected in the [Print Paper Size] box, [Envelope] will be displayed and you 

cannot change the paper type.

6) Number of Copies

Sets the number of printed copies. This can be set at between 1 and 999.

7) Orientation

Sets the paper printing direction.
- Portrait — The document is printed in the portrait direction.
- Landscape — The document is printed in the landscape direction.
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 [Finishing] tab

The [Finishing] tab allows you to enable sort printing and N-up printing.

1) Copy Handling

Sets how to sort the printed sheets when numerous copies are made for printing.
- Sort Copies — Select this for sort-printing (1, 2, 3... 1, 2, 3...).

- Group Copies — Select this for group-printing (1, 1, 1... 2, 2, 2... 3, 3, 3...).

- Rotated Sort Copies— Select this for rotate sort-printing.

 [Group Copies] and [Rotated Sort Copies] can be selected only when more than 1 copy is entered at 
the [Number of Copies] option.
 For rotated sort copies, you need to load paper of the same size in two paper sources (a drawer and 

the bypass tray) in advance, placing one in a landscape direction and another in a portrait direction. 
The paper size should be Letter, A4, B5, or 16K.

For the detailed instructions on how to print with the [Copy Handling] setting, see the following page:
 P.106 “Sort printing”

2) 2-Sided Printing

This sets printing on both sides of paper. Select this check box and then the position of the margin for 2-
sided printing.
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- Long Edge — Select this to print on both sides of the paper with a margin on the long edge.

- Short Edge — Select this to print on both sides of the paper with a margin on the short edge.

- Booklet — Select this to print a properly paginated booklet or magazine-style publication. When this is 
selected, click [Details] to specify the details of the Booklet printing.
 P.94 “Booklet Details”

 The default setting is [Long Edge], which varies from destination to destination.
 Be sure to select the following settings on the [Basic] tab to use this print option:

- Any paper size other than envelopes from the [Print Paper Size] list. You cannot use envelopes.
- [Plain] from the [Paper Type] list. You cannot use other paper types.

For detailed instructions on how to print with the [2-Sided Printing] setting, see the following page:
 P.107 “Printing on both sides of a paper”

3) Number of pages per Sheet

Sets the printing of multiple pages on one sheet. The pages are reduced to fit the selected paper size 
automatically and printed.
- 2 pages — Prints images from 2 pages arranged on one sheet.
- 4 pages — Prints images from 4 pages arranged on one sheet.
- 6 pages — Prints images from 6 pages arranged on one sheet.
- 8 pages — Prints images from 8 pages arranged on one sheet.
- 9 pages — Prints images from 9 pages arranged on one sheet.
- 16 pages — Prints images from 16 pages arranged on one sheet.

Direction of Print

Sets how the pages are arranged on one sheet.
- Left to Right — Arranges pages horizontally from the left and printed top to bottom on one sheet.
- Right to Left — Arranges pages horizontally from the right and printed top to bottom on one sheet.
- Left to Right by column — Arranges pages vertically from the top and printed left to right on one 

sheet.
- Right to Left by column — Arranges pages vertically from the top and printed right to left on one 

sheet.

Draw Borders Around Pages

Prints borders around each page.

For the detailed instructions on how to print with the [Number of pages per Sheet] setting, see the 
following page:
 P.109 “Printing several pages on one sheet”

Portrait Landscape
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4) Use Custom Margin

Enables you to set the custom margins. You usually set margins in your application. If you cannot set them 
in the application, use this option. Select the check box and click [Details] to open the dialog box. Select 
[Units], set the left, right, top, and bottom margins, and then click [OK] to enable them.
- Margin — Enter the value from 4.2 to 100 mm/ 0.17 to 3.94 inches.
- Units — Select the unit, [inch] or [mm], for values.
- Restore Defaults — Restores the margins to the default settings.

If the application has the function to set margins, be sure to set them in the application.
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Booklet Details

In the [Booklet Details] dialog box, you can specify how Booklet printing is performed.

1) Output Document Layout

Select the booklet size to be made.
- A5 on A4 — Select this to print an A5 size booklet. Every 2 pages are printed on A4 paper to fit on half 

a sheet (A5).
- A4 on A3 — Select this to print an A4 size booklet. Every 2 pages are printed on A3 paper to fit on half 

a sheet (A4).
- B5 on B4 — Select this to print a B5 size booklet. Every 2 pages are printed on B4 paper to fit on half a 

sheet (B5).
- B6 on B5 — Select this to print a B6 size booklet. Every 2 pages are printed on B5 paper to fit on half a 

sheet (B6).
- 1/2 Folio on Folio — Select this to print a 1/2 Folio size booklet. Every 2 pages are printed on Folio 

paper to fit on half a sheet.
- A6 on A5 — Select this to print an A6 size booklet. Every 2 pages are printed on A5 paper to fit on half 

a sheet (A6).
- Letter-Half on Letter — Select this to print a 1/2 Letter size booklet. Every 2 pages are printed on 

Letter paper to fit on half a sheet.
- LT on LD — Select this to print a Letter size booklet. Every 2 pages are printed on Ledger paper to fit 

on half a sheet (Letter).
- 1/2 LG on LG — Select this to print a 1/2 Legal size booklet. Every 2 pages are printed on Legal paper 

to fit on half a sheet.
- 1/2 Statement on Statement — Select this to print a 1/2 Statement size booklet. Every 2 pages are 

printed on Statement paper to fit on half a sheet.
- 1/2 Comp on Comp — Select this to print a 1/2 Computer size booklet. Every 2 pages are printed on 

Computer paper to fit on half a sheet.
- 1/2 13LG on 13LG — Select this to print a 1/2 13 inch LG size booklet. Every 2 pages are printed on 13 

inch LG paper to fit on half a sheet.
- 1/2 8.5SQ on 8.5SQ — Select this to print a 1/2 8.5 inch SQ size booklet. Every 2 pages are printed on 

8.5 inch SQ paper to fit on half a sheet.
- 32K on 16K — Select this to print a 32K size booklet. Every 2 pages are printed on 16K paper to fit on 

half a sheet.
- 16K on 8K — Select this to print a 16K size booklet. Every 2 pages are printed on 8K paper to fit on half 

a sheet.

2) Margin - Center

This sets the gutter in the center of a two-sided page. You can enter the value between 0.00 and 12.70 mm 
(0.00 and 0.50 inches). The printed images will be reduced according to the margin setting.

3) Margin - Outer

This sets the gutter on the right side and left side on the paper. You can enter the value between 0.00 and 
25.40 mm (0.00 and 1.00 inches). The printed images will be reduced according to the margin setting.

4) Margin - Units

Select the unit for the Center Margin and Outer Margin option. The default unit varies depending on the 
regional setting in the Windows.
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For detailed instructions on how to print with the [Booklet] setting, see the following page:
 P.108 “Making a booklet”

 [Image Quality] tab

The [Image Quality] tab allows you to select how images are printed.

1) Halftone

This sets how halftones are printed.
- Detail — Select this to print halftone in detail.
- Smooth — Select this to print halftone smoothly.

This function is not available for the XPS printer driver.

2) Smoothing

Prints texts and graphics smoothly.

This function is not available for the XPS printer driver.

3) Distinguish Thin Lines

Select this check box to print thin lines clearly.

This function is not available for the XPS printer driver.

4) Use Black for All Text

Prints all texts in 100% black except white texts.
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 [Effect] tab

The [Effect] tab contains print options that add effects to your print jobs such as Watermarks and Rotate 
printing.

1) Watermark

Selects the watermark to be used or edited. The following values except [None] are the default watermarks 
that have been registered in the printer driver. Up to 15 new watermarks can be added in this box.
- None — Select this if no watermark is desired.

The following default watermarks are also displayed in the box:
- TOP SECRET
- CONFIDENTIAL
- DRAFT
- ORIGINAL
- COPY

This function is not available for the XPS printer driver.

For the detailed instructions on how to print with the [Watermark] setting, see the following page:
 P.110 “Printing with watermarks”

[Add]

Creates a new watermark. The [Watermark] dialog box appears when you click on this.
 P.97 “Add/Edit Watermark”

[Edit]

Select a watermark from the [Watermark] box and click it to edit the watermark. The [Watermark] dialog 
box appears when you click on this.
 P.97 “Add/Edit Watermark”

[Delete]

Select a watermark from the [Watermark] box and click it to delete a watermark.
 P.112 “Deleting a watermark”

 The default watermarks can be deleted. However, once deleted, they cannot be restored.
 [None] cannot be deleted.

1

2



3.PRINT FUNCTIONS (Windows)

Setting up Print Options    97

3 PRINT FUNCTIONS (Windows)

Print on First Page Only

Prints a watermark on the first page only. This setting will become available when any watermark is 
selected from the [Watermark] box.

2) Rotate 180 Degrees

Performs rotation printing of an image.

Add/Edit Watermark

When you click [Add] or [Edit], the [Watermark] dialog box appears and you can create new watermark or edit 
selected watermarks.

1) X Position

The horizontal position of the watermark is displayed. You can change the position using the horizontal 
scroll bar.

2) Y Position

The vertical position of the watermark is displayed. You can change the position using the vertical scroll 
bar.

3) Units

Select the unit for the “X Position” and “Y Position” field.

4) [Center Watermark]

Automatically moves the watermark position to the center.

5) Caption

Enter the text of a watermark. You can enter up to 63 characters. 
When you are editing a watermark, the selected watermark text is displayed in the box.
The entered text is displayed as the sample image on the left.

6) Font Name

Select the font to be used for the watermark text.

7) Style

Select the font style for the watermark text.
- Regular — Sets the regular style to the text.
- Bold — Sets the bold style to the text.
- Italic — Sets the italic style to the text.
- Bold Italic — Sets the bold and italic style to the text.

8) Font Size

Enter the font size for the watermark text. The font size can be set from 6 to 300 pt in units of 1 pt.

9) Angle

Enter the degree of angle for rotating the watermark text. The angle can be set from -90 to 90 degrees in 
units of 1 degree. You can also set the degree of the angle by moving the scroll bar.

10)Solid

Prints a solid type of watermark.
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11)Draw as Outline

Prints a outline type of watermark.

12)Transparency

Prints a transparent watermark. When you select this, set the brightness from 0 (darker) to 100% (lighter) 
in units of 1%. You can also set the brightness using the scroll bar.

13)[Restore Defaults]

Restores the settings displayed in the [Watermark] dialog box to the original factory defaults.
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 [Others] tab

The [Others] tab contains print options such as toner saving, and so on.

1) Default Menu Setting

Select the default tab that is displayed when you open the printing preferences of the printer driver. Set 
frequently used functions as a default menu setting for your convenience.

If you made settings on the [Others] tab menu from the print setting page of the application, they are 
restored to the defaults when you close the printer driver.
If you want to resume the settings, set the printer driver from the [Devices and Printers] folder.
 P.83 “Setting initial values of print options”

2) Toner Save

Prints in the toner save mode.

 When the toner save mode is enabled, printing may become lighter.
 This function is not available for the XPS printer driver.

3) Do not Print Blank Pages

Select this check box to ignore blank pages for printing.

 If the watermark option is enabled, all pages are printed even when the content is blank.
 If the blank pages have a header or footer, they are printed.
 This function is not available for the XPS printer driver.
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4) Custom Paper Size

Click this to specify the custom paper size. The [Custom Paper Size] dialog box appears when you click 
this.
 P.100 “Custom Paper Size”

 In order to set [Custom Paper Size], you must access the printer driver properties from the [Devices 
and Printers] folder (Windows Vista / Windows Server 2008: [Printer]), but not from the [Print] dialog 
box in the application.
 The [Custom Paper Size] can be set only by an operation with the administrator privilege.
 Paper size cannot be smaller than 100 x 148 mm or larger than 297 x 432 mm.
 This function is not available for the XPS printer driver.

5) Department Code

Enter the user’s department code if the system is managed with department codes. Please ask your 
administrator for your department code.
The department code is a 5-digit number.

6) Version Information

Shows the version of the printer driver.

7) Restore All Defaults

Restores all print options to the default settings.
Click [OK] on the confirmation dialog box to start restoring or [Cancel] to stop it.

Custom Paper Size

In the [Custom Paper Size] dialog box, up to 40 custom paper sizes can be defined. The custom page size 
that you specify can be selected in the [Original Paper Size] and [Print Paper Size] box on the [Basic] tab.

The defined custom paper size setting can be used in common for the PCL6/PS3 printer drivers.

The [Custom Paper Size - Paper Size List] dialog box

1
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The [Custom Paper Size - Name] dialog box

1) Paper Size List

Select the custom paper size that you want to modify.

2) [Add]

Click this to display the [Custom Paper Size - Name] dialog box.

3) [Delete]

Click this to clear and restore the default settings of the selected custom paper size that you selected in the 
[Paper Size List]. When you click this, the confirmation dialog box appears. Click [Yes] to delete the setting.

4) Name

Enter the custom paper size name. You can enter up to 63 characters. This name will be displayed in the 
[Original Paper Size] and [Print Paper Size] box on the [Basic] tab.

5) Paper Size

Enter A (Length) and B (Width) to specify the paper size.

The selectable range of A (length) and B (width) differs depending on the model. Select values within 
the range shown on the right of each.

6) Units

Select the unit for the paper size. The default unit varies depending on the regional setting in the Windows.

 To register a custom paper size, either A (Length) or B (Width) should differ by more than 0.3 inches (7 
mm) from the standard paper size. If not, the created custom paper size is considered as the standard 
paper size.
 You cannot create a custom paper size with A (Length) longer than B (Width). If you want to print such 

a document, do so by selecting [landscape] for the [Orientation].

4

6

5
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 [Configuration] tab

The [Configuration] tab allows you to configure options. When any optional unit is installed in this equipment, 
set the configuration of the machine on this tab. The [Configuration] tab can be displayed only from the 
Printers folder (and not when displaying the properties from the application’s print dialog box).

In order to set the [Configuration] tab, you must access the printer driver properties from the [Devices and 
Printers] folder (Windows Vista / Windows Server 2008: [Printer]). For detailed instructions on how to set 
the [Configuration] tab, see the following page:
 P.74 “Configuring options manually”

1) Model Selection

This sets the model type.

2) Option

This option sets whether the following optional devices are installed.

Automatic Duplexing Unit

Be sure to select this check box to use the equipment.

Drawers

This sets the installation of drawers according to the configuration.
- Drawer 1 — Select this when only Drawer 1 is installed.
- Drawer 1 & Drawer 2 — Select this when Drawers 1 and 2 are installed.
- Drawer 1, 2 & Drawer 3 — Select this when Drawers 1, 2 and 3 are installed.
- Drawer 1, 2 & Drawer 3, 4 — Select this when Drawers 1, 2, 3 and 4 are installed.
 P.103 “Drawer Settings”

3) [Drawer Setting]

Sets the paper size and paper type of each drawer. The [Drawer Settings] dialog box appears by clicking 
this.
 P.103 “Drawer Settings”

4) [Version Information]

Displays the [Version Information] dialog box.

5) [SNMP Settings]

Click this button when you need to verify or change the SNMP settings.
 P.103 “SNMP Settings”

1
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In order to set [SNMP Settings], you must access the printer driver properties from the [Devices and 
Printers] folder (Windows Vista / Windows Server 2008: [Printer]), but not from the [Print] dialog box in 
the  application.

6) [Enable SNMP Communication]

This enables SNMP communication between this equipment and your computer to retrieve the option 
configuration
information.

Update Automatically/Manual

Select whether to update option configuration information automatically each time the [Configuration] tab 
of the printer driver is accessed or to update manually.

[Update Now]

This is available only when [Manual] is selected. Click this to obtain the configuration information from this 
equipment immediately.

Drawer Settings

1) Paper Size

Select the paper size set in each drawer.

2) Paper Type

Select the paper type set in each drawer.

3) [Restore Defaults]

Restores the configuration of this equipment displayed in the [Configuration] tab menu to the original 
factory defaults.

SNMP Settings

1) SNMP V1/V2

Community Name — If a community name other than “private” (default) is set for the SNMP community 
name for your TOSHIBA MFP, enter its community name.

1 2

3

1

2
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 To find your TOSHIBA MFP under the SNMP V1/V2 environment, the community names set for the 
target TOSHIBA MFP must be specified correctly. For help, consult your administrator.
 To change the community name, the administrator privilege is necessary. You must log in with the 

“Administrator” privilege and open the printer driver properties.
 Up to 31 characters including the following symbols can be entered for the Community Name.

! " # $ % & ' ( ) * + , - / : ; < = > ? @ [ \ ] ^ _ ` { | } ~

2) [Restore Defaults]

Click this button when you want to reset all the settings back to the defaults.
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Printing With Best Functions for Your Needs

In this section, procedures are given to print various types of print jobs, using the layout and finishing options. 
Read this section before starting printing and select the procedure best suited for your needs.
 P.105 “Layout and finishing options in [Basic] tab menu”
 P.106 “Layout and finishing options in [Finishing] tab menu”
 P.110 “Finishing options in [Effect] tab menu”

 Layout and finishing options in [Basic] tab menu

Using the printer driver, you can set various layout options to suit your preferences. In this section various 
printing functions enabled with the [Basic] tab menu are explained.
 P.105 “Fitting images within paper size”

 Fitting images within paper size

Automatically enlarges or reduces an image to fit into a specified paper size, or manually set the scale to 
enlarge or reduce it.

Printing enlarged or reduced image to fit the specified paper size

1 Display the [Basic] tab menu.

2 Select the document size on the [Original Paper Size] box. Then select the paper size 

that you want to print at the [Print Paper Size] box.

The document image is automatically enlarged or reduced depending on the original paper size and 
print paper size.

3 Set any other print options and click [OK].

4 Click [OK] or [Print] to send the print job.

Printing an enlarged or reduced image by specifying the scale manually

1 Display the [Basic] tab menu.

2 Check the [Manual Scale] box. Then enter the scale.

The scale can be set from 25% to 400% in units of 1%.

3 Set any other print options and click [OK].

4 Click [OK] or [Print] to send the print job.
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 Layout and finishing options in [Finishing] tab menu

Using the printer driver, you can set various layout options to suit your preferences. In this section various 
printing functions enabled with the [Finishing] tab menu are explained.
 P.106 “Sort printing”
 P.107 “Printing on both sides of a paper”
 P.108 “Making a booklet”
 P.109 “Printing several pages on one sheet”

 Sort printing

Selects how multiple copies of a document to be output, such as separately for each copy and grouping each 
page.

Sorting printed documents according to the copies

1 Display the [Basic] tab menu.

2  Enter the number of copies to be printed at the [Number of Copies] box.

3 Display the [Finishing] tab menu.

4 Select [Sort Copies] icon at [Copy Handling].

5 Set any other print options and click [OK].

6 Click [OK] or [Print] to send the print job.

Sorting printed documents according to the pages

For example, assume that you have a three-page job (A, B, C) and you want three copies of each page in this 
order (AAA, BBB, CCC).

1 Display the [Basic] tab menu.

2 Enter the number of copies to be printed at the [Number of Copies] box.

3 Display the [Finishing] tab menu.

4 Select [Group Copies] icon at [Copy Handling].

5 Set any other print options and click [OK].

6 Click [OK] or [Print] to send the print job.
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Sorting printed documents horizontally and vertically for each copy

 Rotated Sort Copies can be enabled only when printing on A4, B5, Letter, or 16K.
 To make Rotated Sort Copies, sheets to be used must be placed both horizontally and vertically 

(example: A4 and A4-R).

1 Display the [Basic] tab menu.

2 Enter the number of copies to be printed at the [Number of Copies] box.

3 Display the [Finishing] tab menu.

4 Select [Rotated Sort] icon at [Copy Handling].

5 Set any other print options you require and click [OK].

6 Click [OK] or [Print] to send the print job.

The printed documents are alternately sorted horizontally and vertically for each copy.

 Printing on both sides of a paper

You can print on both sides of the paper.

1 Open the [Basic] tab to select the following settings.

 Any paper size other than envelopes from the [Print Paper Size] list. You cannot use envelopes.
 [Plain] from the [Paper Type] list. You cannot use other paper sizes.

2 Open the [Finishing] tab, select the [2-Sided Printing] check box, and select the binding 

position icon.

Long Edge — Select this to print on both sides of the paper with a margin on the long edge.
Short Edge — Select this to print on both sides of the paper with a margin on the short edge.
Booklet — Select this to print a properly paginated booklet or magazine-style publication.

You can also set booklet printing at the [2-Sided Printing] option by selecting the [Booklet] icon. For 
instructions on how to perform booklet printing, see the following section.
 P.108 “Making a booklet”

3 Set any other print options you require and click [OK].

4 Click [OK] or [Print] to start the print job.

The print job is printed on both sides of paper in the specified direction.
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Making a booklet

You can create a document in a book- or magazine-style publication by selecting the Booklet option.

Creating a booklet

1 Display the [Finishing] tab menu.

2 Select the [2-Sided Printing] check box and select the [Booklet] icon.

3 Click [Details].

The [Booklet Details] dialog box appears.

4 Select the booklet size at the [Output Document Layout] box.

A5 on A4 — Select this to print an A5 size booklet. Every 2 pages are printed on A4 paper to fit on half 
a sheet (A5).
A4 on A3 — Select this to print an A4 size booklet. Every 2 pages are printed on A3 paper to fit on half 
a sheet (A4).
B5 on B4 — Select this to print a B5 size booklet. Every 2 pages are printed on B4 paper to fit on half a 
sheet (B5).
B6 on B5 — Select this to print a B6 size booklet. Every 2 pages are printed on B5 paper to fit on half a 
sheet (B6).
1/2 Folio on Folio — Select this to print a 1/2 Folio size booklet. Every 2 pages are printed on Folio 
paper to fit on half a sheet.
A6 on A5 — Select this to print an A6 size booklet. Every 2 pages are printed on A5 paper to fit on half 
a sheet (A6).
Letter-Half on Letter — Select this to print a 1/2 Letter size booklet. Every 2 pages are printed on 
Letter paper to fit on half a sheet.
LT on LD — Select this to print a Letter size booklet. Every 2 pages are printed on Ledger paper to fit 
on half a sheet (Letter).
1/2 LG on LG — Select this to print a 1/2 Legal size booklet. Every 2 pages are printed on Legal paper 
to fit on half a sheet.
1/2 Statement on Statement — Select this to print a 1/2 Statement size booklet. Every 2 pages are 
printed on Statement paper to fit on half a sheet.
1/2 Comp on Comp — Select this to print a 1/2 Computer size booklet. Every 2 pages are printed on 
Computer paper to fit on half a sheet.
1/2 13LG on 13LG — Select this to print a 1/2 13 inch LG size booklet. Every 2 pages are printed on 13 
inch LG paper to fit on half a sheet.
1/2 8.5SQ on 8.5SQ — Select this to print a 1/2 8.5 inch SQ size booklet. Every 2 pages are printed on 
8.5 inch SQ paper to fit on half a sheet.
32K on 16K — Select this to print a 32K size booklet. Every 2 pages are printed on 16K paper to fit on 
half a sheet.
16K on 8K — Select this to print a 16K size booklet. Every 2 pages are printed on 8K paper to fit on half 
a sheet.
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5 If you want to add a margin space between facing pages, enter a width in the [Center] 

box, and if you want to add a margin on the outside edge, enter a width in the [Outer] 

box.

 You can change the unit of the margin at the [Units].
 The center margin can be set from 0.00 mm to 12.70 mm in units of 0.10 mm when the unit is mm, 

and from 0.00 inch to 0.50 inches in units of 0.01 inch when the unit is inches.
The printed images will be reduced according to the margin setting.
 The outer margin can be set from 0.00 mm to 25.40 mm in units of 0.10 mm when the unit is mm, 

and from 0.00 inch to 1.00 inches in units of 0.01 inch when the unit is inches.
The printed images will be reduced according to the margin setting.

6 Click [OK] to close the [Booklet Details] dialog box.

7 Set any other print options you require and click [OK].

8 Click [OK] or [Print] to send the print job.

The print job is printed as a booklet.

 Printing several pages on one sheet

Prints several pages of a document on one sheet of paper (N-up feature). This feature is very useful for 
browsing a large number of pages for appearance or page order.
For example, to check the navigation path of a number of web pages or review the narrative of a slide 
presentation, using N-up is not only convenient but conserves paper as well.

Printing multiple pages per sheet

1 Display the [Finishing] tab menu.

2 Select how many pages you want to print on a single sheet at the [Number of pages per 

Sheet] box.

2 pages — Prints images from 2 pages arranged on one sheet.
4 pages — Prints images from 4 pages arranged on one sheet.
6 pages — Prints images from 6 pages arranged on one sheet.
8 pages — Prints images from 8 pages arranged on one sheet.
9 pages — Prints images from 9 pages arranged on one sheet.

16 pages — Prints images from 16 pages arranged on one sheet.

3 Select how the pages are arranged on one sheet in the [Direction of Print] option.

Left to Right — Arranges pages horizontally from the left and printed top to bottom on one sheet.
Right to Left — Arranges pages horizontally from the right and printed top to bottom on one sheet.
Left to Right by column — Arranges pages vertically from the top and printed left to right on one 
sheet.
Right to Left by column — Arranges pages vertically from the top and printed right to left on one 
sheet.

Items that can be selected in [Direction of print] may vary depending on the number of pages 
selected at the [Number of pages per Sheet] box.

4 If you want to draw a line around each page, select the [Draw Borders Around Pages] 

check box.
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5 Set any other print options and click [OK].

6 Click [OK] or [Print] to send the print job.

 Finishing options in [Effect] tab menu

Using the printer driver, you can set various layout options to suit your preferences. In this section various 
printing functions enabled with the [Effect] tab menu are explained.
 P.110 “Printing with watermarks”

 Printing with watermarks

Watermarks overprint your document with useful information, such as [TOP SECRET], [CONFIDENTIAL], 
[DRAFT], [ORIGINAL], or [COPY]. You can choose from several predefined watermarks or you can create 
and save your own custom watermarks.
Watermarks are text only. 

Printing a watermark

1 Display the [Effect] tab menu.

2 Select the watermark to be printed at the [Watermark] box.

You can create a new watermark if there is none you want to apply on the box.
 P.111 “Creating or editing a watermark”

3 If you want to print the watermark on only the first page, select the [Print on First Page 

Only] check box.

4 Set any other print options and click [OK].

5 Click [OK] or [Print] to send the print job.
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Creating or editing a watermark

1 Click [Add] to create a new watermark, or select one that you want to edit and click 

[Edit] to edit a watermark.

The [Watermark] dialog box appears.

2 Enter the watermark text in the [Caption] box.

You can enter up to 63 characters for the [Caption] box. However, if too many characters are entered, 
the watermark may not be printed correctly.

3 Select a font for the watermark at the [Font Name] box.

4 Select a font style for the watermark at the [Style] box.

5 Enter the font size in the [Font Size] box.

You can enter any integer between 6 and 300pt in units of 1pt.

6 To rotate the watermark, enter the number of degrees in the [Angle] box.

 You can enter from -90 degrees to 90 degrees in units of 1 degree in the [Angle] box.
 You can also set the angle using the scroll bar.

7 Select how the watermark text is printed from [Solid], [Draw as Outline], and 

[Transparency].

Solid — Prints a solid type of watermark.
Draw as Outline — Prints an outline type of watermark.
Transparency — Prints a transparent watermark. Set the transparent ratio from 0 to 100% in units of 

1%. You can also set the transparent ratio using the scroll bar.

8 Enter the X and Y values or move the scroll bar to adjust the watermark position.

 You can adjust the position horizontally with “X” and vertically with “Y”.
 You can select the unit, [inch] or [mm].
 Click [Center Watermark] to locate the watermark text to the middle horizontally and vertically.

9 Click [OK] to save the watermark settings.
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Deleting a watermark

You can delete the default watermarks. However, they cannot be restored by clicking [Restore Defaults].

1 Select the watermark that you want to delete at the [Watermark] box.

2 Click [Delete].

The [Confirm Delete] dialog box appears.

3 Click [Yes].
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Printing from Application

This section explains printing from Mac OS X 10.6.x to Mac OS X 10.10.x.
 P.114 “Considerations and limitations”
 P.114 “How to print”

 Considerations and limitations

Some print options can be set from both the application and the printer driver, such as collation. If the collation 
is set from the application, documents may not be properly printed. If that happens, use the printer driver to 
set the collation. Depending on the application, some print options such as the orientation need to be set from 
the application. For print options that can be set from both the application and the driver, refer to the manual of 
the application.

 How to print

All printers are managed under [Print & Fax]/[Printers & Scanners] of [System Preferences]. Once a printer is 
added to the printer list, you can select any printer directly from the [Page Setup] dialog box or the [Print] 
dialog box.

In Mac OS X applications, print options are set from both the [Page Setup] dialog box and the [Print] dialog 
box.

 When you create a document, you usually set page attributes such as paper size and orientation from 
within your application, which are linked to the [Page Setup] options.
 Some of the [Print] options vary from application to application.

Printing from Mac OS X application

1 Open a file and select [Page Setup] from the [File] menu of the application.

2 Select a name of your printer from [Format For] and set or make sure of the page 

attributes for the file.

 P.116 “[Page Setup] options”

3 Click [OK] to save the page attributes.

4 Select [Print] from the [File] menu of the application.
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5 Make sure of your printer name at [Printer] and set the options to print the file.

 P.119 “[Print] options”

You can preset the options set in the [Print] dialog box. Select [Save as] from the [Presets] menu 
and save them under a new name. When you use the preset options, select the preset name from 
the [Presets] menu.

6 Click [Print] to print the file.
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Setting up Print Options

When you print a document from Mac OS X, you need to set up page and print options.
 P.116 “[Page Setup] options”
 P.119 “[Print] options”

 [Page Setup] options

When you create a document to print, select [Page Setup] from the [File] menu of your application to open the 
[Page Setup] dialog box and set the page attributes. When necessary, you can define custom page sizes 
other than standard ones.
 P.116 “Page Attributes”
 P.117 “Custom page sizes”

When you create a document, you usually set page attributes such as paper size and orientation from 
within your application, which are linked to the [Page Setup] options.

 Page Attributes

1) Format For

Select a name of your printer to use for printing.

2) Paper Size

Select a paper size to print your document. Available paper sizes are listed below:

3) Orientation

Set the paper direction to print a document.
- Portrait — A document is printed in the portrait direction.
- Landscape (90 degree) — A document is printed in the landscape direction from the left.
- Landscape (270 degree) — A document is printed in the landscape direction from the right. You can 

select this option only in Mac OS X 10.4.x.

 A4 (210 x 297 mm)
 A5 (148 x 210 mm)
 A3 (297 x 420 mm)
 JIS B4 (257 x 364 mm)
 JIS B5 (182 x 257 mm)
 Folio (210 x 330 mm)
 J Post Card (100 x 148 mm)
 US Letter (8 1/2 x 11") 
 US Legal (8 1/2 x 14") 
 Tabloid (11 x 17") 
 Statement (5 1/2 x 8 1/2") 
 Computer (10 1/8 x 14") 
 13"LG (8 1/2 x 13") 

 8.5"SQ (8 1/2 x 8 1/2") 
 16K (195 x 270 mm)
 8K (270 x 390 mm)
 Env-Com10 (4 1/8 x 9 1/2")
 Envelope Monarch (3 7/8 x 7 1/2")
 Envelope DL (110 x 220 mm)
 Envelope Choukei 3 (120 x 235 mm)
 Envelope You4 (105 x 235 mm)
 Envelope C4 (9.02 x 12.76")
 Envelope C5 (6.38 x 9.02")

1
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4) Scale

Change an image size to print on a page. Enter a scale to enlarge or reduce an image. You can set any 
integer from 1% to 999%.

Custom page sizes

You can define custom page sizes other than standard ones.

 When you print on paper longer than standard sizes, print one sheet at a time.
 Paper size cannot be smaller than 100 x 148 mm or larger than 297 x 432 mm.

Creating a custom page size

1 Select [Manage Custom Sizes] from the [Paper Size] menu.

2 Click [+].

A new custom page size name is added to the list.

If you want to create a new custom page size by duplicating an existing custom page size, select a 
custom page size name on the list and click [Duplicate].
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3 Double-click the added custom page size name on the list and rename the custom page 

size.

4 Enter the width and height in the [Paper Size] boxes and select a name of your printer 

from the [Non-Printable Area] menu.

 Use the minimum margin values that are automatically set by selecting the printer name, or you 
can set values larger than the minimum ones for wider margins.
 You can delete the created custom page size by selecting the name and clicking [-].

5 Click [OK].

You can select the saved custom page size from the [Paper Size] menu.
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 [Print] options

When you print a document, select [Print] from the [File] menu of your application. You can set the following 
print options.
 P.119 “Copies & Pages”
 P.120 “Layout”
 P.122 “Paper Handling”
 P.125 “Cover Page”
 P.126 “Printer Features”

 Some of the [Print] options vary from application to application.
 The options and arrangement vary from Mac OS X version to version.

Copies & Pages

In the [Print] dialog box, you must first set basic print options such as the number of copies, the range to print 
pages, sort printing, and two-sided printing.

Mac OS X 10.6.x

Mac OS X 10.8.x or later

1
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1) Copies

Set the number of copies to print a document.

2) Collated

Select this check box to collate pages in order when printing two or more copies: all the pages of one copy 
are printed before the next copy is printed. It is called “sort-printing” (1, 2, 3, ... ; 1, 2, 3, ...).

3) Pages

Set the range of pages to print a document.
- All — Select this option to print all pages.
- From/to — Select this option to print a range of pages. Enter the start and last page numbers.

4) Two-Sided

Select this check box to print on both sides of paper, called “two-sided printing”. When you select this 
check box, [Long-Edge binding] is automatically selected from [Two-Sided] in the [Layout] menu. You can 
select this option only in Mac OS X 10.6.x to Mac OS X 10.10.x.

 Layout

In the [Layout] menu, you can set the print options to print multiple pages per sheet, which is called “N-up 
printing”.

1) Pages per Sheet

Set the number of pages to print on a sheet of paper. Pages are automatically reduced to fit the selected 
paper size.
- 1 — Select this value to print a page on a sheet, which is normal printing.
- 2 — Select this value to print 2 pages arranged on a sheet.
- 4 — Select this value to print 4 pages arranged on a sheet.
- 6 — Select this value to print 6 pages arranged on a sheet.
- 9 — Select this value to print 9 pages arranged on a sheet.
- 16 — Select this value to print 16 pages arranged on a sheet.

2) Layout Direction

Set how pages are arranged on a sheet. You can set this option only for N-up printing.
- Across Left to Right Before Down — Pages are arranged horizontally from left to right and then top to 

bottom on a sheet.
- Across Right to Left Before Down — Pages are arranged horizontally from right to left and then top to 

bottom on a sheet.
- Down Before Across Left to Right — Pages are arranged vertically from top to down and then left to 

right on a sheet.

1
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- Down Before Across Right to Left — Pages are arranged vertically from top to down and then right to 
left on a sheet.

3) Border

Select a type of the border line around each page for N-up printing.
- None — Select this option if no border line is to be drawn.
- Single Hairline — Select this option to draw a single hairline around each page.
- Single Thin Line — Select this option to draw a single thin line around each page.
- Double Hairline — Select this option to draw a double hairline around each page.
- Double Thin Line — Select this option to draw a double thin line around each page.

4) Two-Sided

Turn on or off printing on both sides of paper, which is called “two-sided printing”. You can select the 
binding position for two-sided printing.
- Off — Select this option to print on a single side of paper, which is normal single-sided printing.
- Long-Edge binding — Select this option to turn on two-sided printing for binding along the long edge 

of paper. The print direction on the back side of paper differs depending on the orientation.

- Short-Edge binding — Select this option Select this option to turn on two-sided printing for binding 
along the short edge of paper. The print direction on the back side of paper differs depending on the 
orientation.

5) Reverse page orientation

Select this check box to reverse the page orientation. If you load paper in the opposite direction for any 
reason, you can print pages upside down for correct printing.

6) Flip horizontally

Select this check box to flip pages horizontally for printing.

1

2

Landscape

1

2

Portrait

1 2

Landscape

1
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Portrait
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 Paper Handling

In the [Paper Handling] menu, you can set the options to handle paper such as reversing the order of pages, 
printing odd or even pages, and printing by enlargement/reduction. In addition, the option to collate pages is 
also available in Mac OS X 10.8.x or later

Mac OS X 10.6.x

1) Pages to Print

Select one of the options to print all pages, or only odd or even pages.

2) Page Order

Select the page order for printing. Select [Automatic] or [Normal] to print from the first page to the last one. 
Select [Reverse] to print from the last page to the first one.

3) Destination Paper Size

Print at the original paper size you have set for the document or print by scaling according to the selected 
paper size.
- Scale to fit paper size — Click to clear this check box to print at the original paper size. Select this 

check box so that you can select a paper size from the menu to scale the original paper size to fit the 
selected one for printing. If you do not want to enlarge the size when you select any larger paper size 
than the original one, select the [Scale down only] check box, so that you can print the document at its 
original size.

1
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3
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Mac OS X 10.8.x or later

1) Collate pages

Select this check box to collate pages in order when printing two or more copies: all the pages of one copy 
are printed before the next copy is printed. It is called “sort-printing” (1, 2, 3, ... ; 1, 2, 3, ...).

2) Pages to Print

Select one of the options to print all pages, or only odd or even pages.

3) Page Order

Select the page order for printing. Select [Automatic] or [Normal] to print from the first page to the last one. 
Select [Reverse] to print from the last page to the first one.

4) Destination Paper Size

Print at the original paper size you have set for the document or print by scaling according to the selected 
paper size.
- Scale to fit paper size — Click to clear this check box to print at the original paper size. Select this 

check box so that you can select a paper size from the menu to scale the original paper size to fit the 
selected one for printing. If you do not want to enlarge the size when you select any larger paper size 
than the original one, select the [Scale down only] check box, so that you can print the document at its 
original size.

2

3

4

1



4 PRINT FUNCTIONS (Mac OS X)

124    Setting up Print Options

 Paper Feed

In the Paper Feed menu, you can set the paper source.

1) All pages from

Select this when you want to use the same paper source for all pages. When this is selected, select the 
paper source  to be used at the box.

2) First Page From

Select this when you want to specify different paper sources for the first page and remaining pages. When 
this is selected, specify the paper source to be used for the first page at the box.

3) Remaining From

Select the paper source to be used for remaining pages in the box. This can be selected only when you 
choose the [First Page From] option button.

1
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Cover Page

In the [Cover Page] menu, you can set the options to print a cover page. The cover page includes information 
such as job ID, title, print owner, print source, and billing information.

1) Print Cover Page

Select a position to print a cover page.
- None — Select this option to print the document without a cover page.
- Before document — Select this option to print a cover page before the document.
- After document — Select this to print a cover page after the document.

2) Cover Page Type

Select a title for a cover page.

3) Billing Info

Enter the billing information to have it appear on a cover page.

 The [Billing Info] option is not available, depending on Mac OS X version.
 Due to Mac OS X limitations, the information that you type exceeding the maximum text length in the 

[Billing Info] box does not appear on a cover page.

1
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 Printer Features

In the [Printer Features] menu, you can select the following sets from the [Feature Sets] menu and set the 
options that control the printer features.
 P.126 “General”
 P.127 “Printing Modes”
 P.128 “Printing Modes DC”
 P.129 “Quality”

General

You can set a media source and type, duplex printing, and resolution.

1) Media Type

Select a media type from “Printer's Default”, “Plain Paper”, “Thick”, “Thick 1”, “Thick 2”, “Transparency”, 
“Thin”, or “Envelope”. “Printer's Default” is a default set on the equipment.

1
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Printing Modes

You can set the printing modes for department codes, thin lines, and no blank pages.

1) Department Code

Select [Enable] if the equipment is managed with specific department codes and you need one for printing.

Select [Printing Modes DC] and set the department code that you need for printing.

2) Distinguish Thin Lines

Select [On] to print thin lines clearly.

3) Do not Print Blank Pages

Select [On] to skip blank pages for printing.

2
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Printing Modes DC

You can set a department code to print documents. For the necessary department code, consult your 
administrator.

Select [Printing Modes] and set [Department Code] to print documents with the department code.

1) Department Code(DC) - Digit 1

Select the first digit of your department code from 0 to 9.

2) Department Code(DC) - Digit 2

Select the second digit of your department code from 0 to 9.

3) Department Code(DC) - Digit 3

Select the third digit of your department code from 0 to 9.

4) Department Code(DC) - Digit 4

Select the fourth digit of your department code from 0 to 9.

5) Department Code(DC) - Digit 5

Select the fifth digit of your department code from 0 to 9.

2
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Quality

You can set print quality.

1) Halftone

This sets how halftones are printed.
- Detail — Select this to print halftone in detail.
- Smooth — Select this to print halftone smoothly.

2) Smoothing

Select [On] to print text and graphics smoothly.

3) Toner Save

Select [On] to save toner for printing.

The toner save option might make printed images pale.

2
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Scanning From Application

This equipment supports scanning from TWAIN-compatible applications. TWAIN is the standard that links 
applications and scanners that acquire images. For TWAIN support, see your application’s manual.

You can make use of e-STUDIO Scan Editor bundled with the equipment. It helps you scan and edit 
images. For the details, refer to the following page:
 P.139 “Scanning from e-STUDIO Scan Editor”

Before you start scanning with this equipment, make sure that you have installed the scanner driver. For 
details, refer to the Software Installation Guide.

The default original size depends on the measurement system on Windows: A4 for Metric or LT for the 
North America. You can change the default only before the first execution after installation. For the 
measurement system, see the Windows Help.

 P.132 “How to scan”

 How to scan

Follow the steps below to scan the original. The following describes a general scanning operation that is 
common to TWAIN-compatible applications.

1 Place the original(s).

 P.39 “Placing originals on the original glass”
 P.40 “Placing originals on the Reversing Automatic Document Feeder”

2 Run your TWAIN-compatible application and execute the image acquisition command.

You can usually execute the scan or image acquisition command on the [File] menu to select this 
equipment. The location of the command and the method to select the scanner vary depending on the 
application. See your application’s manual.

3 Set the scan settings.

 You can make various options to scan the original image.
 P.134 “Scan options”
 You can also make the scan settings using the Easy Set feature.
 P.137 “Using the Easy Set feature”
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4 Click [Pre-Scan] to preview the original.

If you are not satisfied with the preview image, change the scan settings and preview the image again.

5 Click [Scan] to scan the original.

While scanning, you can stop scanning by clicking [CANCEL].

When the authentication screen appears, enter the department code that is required to log in to this 
equipment. For details, ask your administrator.

6 Save the scanned image in your application.

The saving command varies depending on the application. You usually execute the Save or Save as 
command on the File menu. If necessary, modify the scanned image, using the various graphic 
commands in your application.
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Setting up Scan Options

You can make various options to affect the scanning status. You can save different sets of options in files and 
recall one of them for frequent use.
 P.134 “Scan options”
 P.136 “Scanning from the equipment on the network”
 P.137 “Scanning from the equipment connected by USB cable”
 P.137 “Using the Easy Set feature”

 Scan options

The basic and advanced dialogs are available for the scan operation.
 P.134 “Basic scan dialog”
 P.135 “Advanced scan dialog”

Basic scan dialog

When you execute the image acquisition command, the following basic scan dialog appears.

1) Easy Set

The scan options can be saved.
 P.137 “Using the Easy Set feature”

2)

Clears the preview image.

3) Preview screen

The pre-scanned image appears. The dotted boundary shows the scanning area or the original size. The 
image information appears under the preview screen.

4)

Opens the IO Type dialog to set the destination.
 P.136 “Scanning from the equipment on the network”
 P.137 “Scanning from the equipment connected by USB cable”

When you scan images using a TWAIN-compatible application, the Network-connected equipment 
takes a longer scan time than the USB-connected one, depending on the original and resolution.

1
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5)

Shows the version information of the scanner driver.

6)

Shows the Help information about this scanner driver.

7) [Close]

Quits the scanning operation.

8) [Pre-Scan]

Pre-scans the original.

9) [Scan]

Scans the original. 

10)Measurement unit

Select [Inch], [mm], or [Pixel] to change the measurement unit.

11)

Opens the advanced scan dialog.
 P.135 “Advanced scan dialog”

Advanced scan dialog

You can click the triangle that faces right on the right-hand side of the basic scan dialog box to make scanning 
settings. The default settings are underlined.

1) Resolution

Sets the horizontal and vertical resolution as dots per inch: 150 x 150 dpi, 200 x 200 dpi, 300 x 300 dpi, 
400 x 400 dpi, or 600 x 600 dpi.

2) Original Mode

Sets the original mode to fit the original image such as text only or the mixture of text and photos: Text, 
Text/Photo, Gray, or Color.

3) Original Size

Sets the original document size or the scanning area.
Select the original size from the pull-down list.
The displayed items differ depending on the installed options and destinations.

1
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 When [600 x 600 dpi] is selected in [Resolution] and [Color] is selected in [Original Mode], only [A5-
R] or [ST-R] can be selected.
 When [400 x 400 dpi] is selected in [Resolution] and [Color] is selected in [Original Mode], paper 

size larger than [A4] or [LT] cannot be selected.

4) ADF/Platen

Selects the equipment on which the originals are placed: Platen Scan, ADF Scan, or Duplex Scan.
The displayed items differ depending on the installed options and destinations.

5) Rotation

Rotates the imaged clockwise by 90 degrees, counterclockwise by 90 degrees, or by 180 degrees. This 
option takes effect on the image to scan but not on the preview image: OFF, Right 90, Left 90, or 180.

6)

Closes the advanced scan dialog and return to the basic scan dialog.
 P.134 “Basic scan dialog”

7) [Enhanced Settings] tab

-  Exposure/Contrast

Adjusts the exposure and contrast of the image using the scroll bar or editing the field: -100 (lighter) to 
100% (darker).
[Contrast] is only available when [Gray] or [Color] is selected in [Original Mode].

-  Sharp

Adjusts the sharpness of the image using the scroll bar or editing the field: -2 (softer) to 3% (sharper).
[Sharp] is only available when [Gray] or [Color] is selected in [Original Mode].

-  RGB Adjustment

Adjusts the RGB values of the image using the scroll bar or editing the field: -100 to 100%.
[RGB Adjustment] is only available when [Color] is selected in [Original Mode].

-  Saturation

Adjusts the saturation of the image using the scroll bar or editing the field: -100 to 100%.
[Saturation] is only available when [Color] is selected in [Original Mode].

8) Default

Resets all the settings back to the defaults.

 Scanning from the equipment on the network

1 Click  on the basic scan dialog box.

2 When the [IO Type] dialog box appears, select [IPv4] or [IPv6].
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3 Click [Search], and then confirm the displayed IP address and device name.

If you set the IP address manually, input the address in the text box.

4 Click [OK].

 Scanning from the equipment connected by USB cable

1 Click  on the basic scan dialog box.

2 When the [IO Type] dialog box appears, select [USB].

3 Click [OK].

 Using the Easy Set feature

When you have made scan settings, you can save them as an Easy Set file. This allows you to load a specific 
batch of settings without changing the scan settings each time.
 P.137 “Saving the Easy Set file”
 P.138 “Using the Easy Set file”

 Saving the Easy Set file

You can save multiple Easy Set files.

1 Open the advanced scan dialog from within your application.

 P.132 “How to scan”

2 Set the scan options as you like.

 P.134 “Scan options”

3 Click  next to the Easy Set menu.

4 Enter a file name, select a folder where you save the file, and then click [Save].
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Using the Easy Set file

1 Select the pre-defined Easy Set file, or click  next to the Easy Set menu to select your 

Easy Set file.

 The following two pre-defined files are available.

 When the Open dialog box appears, select the folder, select the target Easy Set file, and then click 
[Open].

2 Click [Pre-Scan].

Deleting the Easy Set files

You can delete the Easy Set files in the same way as for normal files. Locate the folder where you have saved 
the Easy Set file, right-click the file, and then click [Delete] from the menu. Click [Yes] to delete the file. When 
you are working in the preview window, click the folder icon next to the Easy Set menu so that you can delete 
the file in the same way. After deleting the file, click [CANCEL] to close the dialog box.

Pre-defined File Resolution Original Mode Other Scan Options

Picture 150 x 150 dpi Text/Photo Default settings

Text 600 x 600 dpi Text
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Scanning from e-STUDIO Scan Editor

e-STUDIO Scan Editor is an application to scan images with the equipment and edit them in Windows. From 
this application, you can use the scanner driver to scan images. When you have followed the standard steps 
to install the software such as a printer driver for the equipment, you also have installed this application. The 
following describes the functions of e-STUDIO Scan Editor.
For details about a scanning procedure, refer to the following page.
 P.132 “How to scan”

 Features of e-STUDIO Scan Editor

e-STUDIO Scan Editor has the following features:
 Scan an image and save it in a PDF, TIFF, or JPEG format.
 Scan two or more images and save them in a PDF or TIFF format.
 Insert images in a file window, which are saved in a JPEG, BMP, TIFF, PNG, or PDF format.
 Arrange the images in a file window.
 Edit images simply within the application or open another application to edit them.
 Open the e-mail application that is available as standard in Windows and attach an image file to an e-mail.

 Application window

You can start e-STUDIO Scan Editor from the [Start] menu of Windows. The following application window 
opens and a file window shows thumbnails or scanned images. You can also insert image files from a folder 
using a drag-and-drop operation. Select commands from the menu bar or click the icon on the tool bar to use 
this application.
 P.140 “Menu bar”
 P.142 “Tool bar”
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Menu bar

The following menus are available on the menu bar located at the top of the application window. You can 
select commands from them.
 P.140 “[File] menu”
 P.141 “[Edit] menu”
 P.141 “[Insert] menu”
 P.141 “[View] menu”
 P.141 “[Tools] menu”
 P.141 “[Window] menu”
 P.142 “[Help] menu”

[File] menu

You can select commands to handle files.
 New

Opens a new file window.
 Open

Opens files saved with this application or files saved in a JPEG, BMP, TIFF, PNG, or PDF format.
 Close

Closes the selected file window.
 Save

Saves a file. When you save a file first, you can name the file and save it in any folder. You can save a 
single image in a PDF, TIFF, or JPEG format and two or more images in a PDF or TIFF format.
 Save As

Saves the selected file in another name. You can save a single image in a PDF, TIFF, or JPEG format and 
two or more images in a PDF or TIFF format.
 Send

Opens the e-mail application that is available as standard in Windows and attaches the selected file to an 
e-mail. You can select a format (TIFF or PDF) of the attached file on [Send] of the [Preferences] dialog box.
 P.148 “Send”
 Print

Prints images in the selected file window.
 Select Scanner

Selects the scanner (TWAIN source/driver) of the equipment. When a dialog box opens, you can select a 
TWAIN source in the list.

 The correct TWAIN source has been selected at the installation. In most cases, you do not need to 
select the scanner again.
 If one or more TWAIN sources have been installed, be sure to select the correct TWAIN source for 

the equipment.
 You can set preference for the TWAIN source on [Scanner] of the [Preferences] dialog box.
 P.147 “Scanner”

 Acquire

Opens the scanner driver to scan images. The scanned images are shown as thumbnails in a file window.
 P.134 “Setting up Scan Options”
 Exit

Quits this application.
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[Edit] menu

You can select common commands to handle images.
 Undo

Undoes the last deleting operation.
 Cut

Cuts the selected image.
 Copy

Copy the selected image.
 Paste

Pastes the cut or copied image at any position.
 Delete Pages

Deletes the selected image.
 Select All

Selects all images in a file window.

[Insert] menu

You can select commands to insert images in a file window.
 Insert

Insert images after the selected image or the last one, which are saved in a JPEG, BMP, TIFF, PNG, or 
PDF format.
 Scanned Image

Scans images and inserts them after the selected image or the last one. You can scan images from the 
scanner driver.
 P.134 “Setting up Scan Options”

[View] menu

You can select commands to show or hide the tool bar and status bar.
 Tool Bar

Shows or hides the tool bar at the top of the application window. You can turn on or off the tool bar by 
clicking the command to attach or remove a check mark.
 P.142 “Tool bar”
 Status Bar

Shows or hides the status bar at the bottom of the application window. You can turn on or off the tool bar by 
clicking the command to attach or remove a check mark.

[Tools] menu

You can select commands to open the dialog box where you can arrange images in a file window or you can 
set the preferences for this application.
 Arrange Pages

Opens the [Arrange Pages] dialog box to arrange the images in a file window.
 P.145 “Arranging the images”
 Preferences

Opens the [Preferences] dialog box to set the preferences for this application.
 P.146 “Setting the preferences”

[Window] menu

You can arrange the file windows in the application window.
 Cascade

Arranges the file windows by cascading them.
 Vertical

Arranges the file windows vertically.
 Horizontal

Arranges the file windows horizontally.
 Close All

Closes all file windows.
 Arrange Icons

Minimizes and arranges the icons of file windows.



5 SCAN FUNCTIONS

142    Scanning from e-STUDIO Scan Editor

[Help] menu

You can select the commands show the help or information window of this application.
 Contents

Opens the help window of this application.
 About

Open the information window of this application.

 Tool bar

The following tool icons are available on the tool bar located under the menu bar at the top of the application 
window.

You can show or hide the tool bar with [Too Bar] on the [View] menu.
 P.141 “[View] menu”

1) Acquire

Scans images. When you click this icon, the application starts scanning immediately or opens the scanner 
driver. You can set the action on [Scanner] of the [Preferences] dialog box.
 P.134 “Setting up Scan Options”
 P.147 “Scanner”

2) New

Opens a new file window.

3) Open

Opens files saved with this application or files saved in a JPEG, BMP, TIFF, PNG, or PDF format.

4) Save

Saves a file. When you save a file first, you can name the file and save it in any folder. You can save a 
single image in a PDF, TIFF, or JPEG format and two or more images in a PDF or TIFF format.

5) Print

Prints images in the selected file window. When you click this icon, the application starts printing 
immediately or opens the print dialog box. You can set the action on [Printing] of the [Preferences] dialog 
box.
 P.146 “Printing”

6) Send

Attaches the selected file to an e-mail. You can select a format (TIFF or PDF) of the attached file on [Send] 
of the [Preferences] dialog box.
 P.148 “Send”

7) Preferences

Opens the [Preferences] dialog box to set the preferences for this application.
 P.146 “Setting the preferences”

1 2 3 4 5 6 7 8
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8) Arrange Pages

Opens the [Arrange Pages] dialog box to arrange the images in a file window.
 P.145 “Arranging the images”

 File window for the scanned images

A scanned image appears as a thumbnail in a file window. When two or more images are scanned, all of them 
appear in a single file window. You can select a thumbnail and select commands from the shortcut menu, edit 
images, and arrange them in the file window.
 P.143 “Shortcut menu”
 P.144 “Editing an image”
 P.145 “Arranging the images”

 Shortcut menu

When you right-click a thumbnail, the shortcut menu appears so that you can select the following commands 
from the menu.
 Cut, Copy, Paste, Delete

Cuts, copies, and pastes an image. When you right-click a thumbnail and select [Cut] or [Copy] from the 
menu, you can cut or copy the selected image, then you can select [Paste] to paste it at any position. 
When you right-click a thumbnail and select [Delete] from the menu, you can delete the selected image.
 Insert File

Opens a dialog box so that you can select an image file to insert it in the current file window. You can insert 
images saved in a JPEG, BMP, TIFF, PNG, or PDF format.

 You can move image files to insert them into a file window using a drag-and-drop operation.
 You can insert an image also by selecting [Insert] from the [Insert] menu on the menu bar.

 Insert Scanned Image

Scans images and insert them in the current file window. When you select [Insert Scanned Image], the 
application starts scanning immediately or opens the scanner driver. You can set the action on [Scanner] of 
the [Preferences] dialog box.
 P.134 “Setting up Scan Options”
 P.147 “Scanner”

You can scan and insert images also by selecting [Scanned Image] from the [Insert] menu on the menu 
bar.
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 Editing an image

When you double-click a thumbnail, an edit window opens. You can edit the image using the following icons at 
the bottom of the edit window. Click the [Previous Page] icon, the [Next Page] icon, or the Close button to 
save the edited image.

1) Previous Page

Shows the previous image in a file window.

2) Next Page

Shows the next image in a file window.

3) Rotate 90 degrees Clockwise

Rotates an image by 90 degrees clockwise.

4) Rotate 90 degrees Anti-Clockwise

Rotate an image 90 degrees anticlockwise

5) Tilt / Skew

Tilts a skewed image. You can select the action to confirm the operation or to execute it without 
confirmation on [Editor Options] of the [Preferences] dialog box.
 P.149 “Editor Options”

6) Flip

Flips an image upside down.

7) Mirror

Inverts an image horizontally.

1 2 3 4 5 6 7 8 9 10 11 12 13
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8) Zoom In

Zooms in on an image.

9) Zoom Out

Zooms out from an image.

10) Fit to Width

Fits an image to the width of the window.

11) Best Fit

Fits an image within the window.

12) Edit Page

Opens an image in another application to edit it. You can select the application on [Editor Options] of the 
[Preferences] dialog box.
 P.149 “Editor Options”

By default, you can open images in “Paint” that is a standard application of Windows.

13) Delete Page

Deletes the current image.

Arranging the images

You can arrange images in two ways:
 Move a thumbnail to any position in a file window using a drag-and-drop operation.
 Select a file window and select [Arrange Pages] from the [Tools] menu. The [Arrange Pages] dialog box 

appears so that you can arrange images as follows:
- Select an image and click [Move Up] to move it the previous position.
- Select an image and click [Move Down] to move it to the next position.
- Select an image and click [Delete] to delete it.
- Click [Reset] to cancel the operation you have done in this dialog box.
- Click [OK] to complete the above operation and close this dialog box.
- Click [Cancel] to cancel the above operation and close this dialog box.
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 Setting the preferences

You can set the preferences to use the basic functions of e-STUDIO Scan Editor. Select [Preferences] from 
the [Tools] menu or click the [Preferences] icon on the too bar to open the [Preferences] dialog box. Click the 
icons at the top of the dialog box to set the following functions.
 P.146 “Printing”
 P.147 “Scanner”
 P.148 “Send”
 P.149 “Editor Options”

 Printing

You can set the following print functions on [Printing].

 Oversized Pages

Selects one of the following options to print pages that are too big for the paper.
- Ignore margins and then scale if necessary

Ignores margins around an image and scale it to fit the paper if necessary.
- Clip

Clips an image to print on the paper.
- Reduce to fit

Reduces an image to print on the paper.
 Show dialog when "Print" Tool Bar Button is used.

Sets the action to be done when you click the [Print] icon on the tool bar. Select the check box to open the 
print dialog box. Click to clear the check box to start printing immediately without opening the print dialog 
box.
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 Scanner

You can set the following scan functions on [Scanner].

 Current Scanner

Shows the current scanner (TWAIN source/driver). When you click [Select], the dialog box opens so that 
you can select any one source from the list.

 The correct TWAIN source has been selected at the installation. In most cases, you do not need to 
select the scanner again.
 If one or more TWAIN sources have been installed, be sure to select the correct TWAIN source for 

the equipment.
 You can select a TWAIN source also by selecting [Select Scanner] from the [File] menu.

 Show dialog when "Scan" Tool Bar Button is used.

Sets the action to be done when you click the [Acquire] icon on the tool bar or when you select [Insert 
Scanned Image] from the shortcut (or context) menu. Select the check box to open the scanner driver. 
Click to clear the check box to start scanning immediately without opening the scanner driver.
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 Send

You can set the following e-mail functions on [Send].

 System used to send image files

Shows an e-mail application. When you select [Send] from the [File] menu or click the [Send] icon on the 
tool bar, you can attach a file to an e-mail and send it with the selected application.

The name of an e-mail application that has been set as a default program in Windows appears.

 Attachment Format

Selects a TIFF or PDF format of a file that you attach to an e-mail.
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 Editor Options

You can set the following editor functions on [Editor Options].

 Select the program you want to use for editing images.

Shows an application to edit images. When you click [Browse], the dialog box opens so that you can select 
an application that you use to edit images. You can type a path of the application directly in the field. When 
you click the [Edit Page] icon in an edit window, you can open and edit the image within the selected 
application.
 Show confirmation when tilt/skew is done.

Sets the action to be done when you click the [Tilt/Skew] icon in an edit window. Select the check box to 
show a confirmation message before tilting or skewing an image. Click to clear the check box to tilt or skew 
it immediately without confirmation.
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Scan to E-Mail

Scan to E-mail allows you to send your scans to specified e-mail addresses. The scanned image is converted 
to a PDF, TIFF, or JPEG file and sent as an e-mail attachment.

 Procedure for Scan to E-Mail

1 Place the original(s).

 For placing the originals, see the pages below.
 P.39 “Copying originals”
 A4, A3, A5-R, B5, B5-R, B4, A4-R and FOLIO (LT, LD, LT-R, LG, ST-R and COMP) sized 

originals can be scanned.

2 Press [SCAN].

3 Press  or  to select “E-MAIL”, and then press .

4 Press  or  to select “ADDRESS”, and then press .

Scan to E-mail

Internet
Send E-mail to the Internet

via SMTP server

SMTP server

SELECT SCAN TYPE

E-MAIL

FILE

USB

E-MAIL

(ADDRESS)

DocYYMMDD

PDF
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5 Press  or  to select “TO (ADDRESS)” or “CC (ADDRESS)”, and then press .

6 Select from the Address Book or enter the address directly.

 P.164 “Specifying E-mail Addresses”
 P.167 “Character entry”

7 Press  to return to the E-MAIL screen.

8 Press  or  to select the item, press , and then make the scan settings as required.

The settings available for Scan to E-Mail are as follows:

To make further settings, see the following.
 P.159 “Scan Settings”

9 Press [START].

Menu Functions Settings Description

FILE 

NAME(MAX128)

- An initial file name can be 
changed.
 P.167 “Character entry”

FILE FORMAT PDF MULTI Stores your scan as a PDF file.
Select [MULTI] for saving several 
pages as a single file.
Select [SINGLE] for saving 
several pages as a separated 
single file for each page.

SINGLE

TIFF MULTI Stores your scan as a TIFF file.
Select [MULTI] for saving several 
pages as a single file.
Select [SINGLE] for saving 
several pages as a separated 
single file for each page.

SINGLE

JPEG Stores your scan as a JPEG file.
This setting is not available when 
“BLACK” is selected in the 
“COLOR MODE” function.

MESSAGE SIZE NONE, 64, 128, 256, 512, 1024, 2048 Scans the data at the selected 
file size and sends them 
separately.

E-MAIL ADDRESS

TO(ADDRESS)

CC(ADDRESS)

E-MAIL

(ADDRESS)

DocYYMMDD

PDF
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10 If there are more originals, place the next ones.

 When you place originals on the Reversing Automatic Document Feeder (RADF), select “SCAN 

NEXT” using  or  and press [OK].

 When you place an original on the original glass, select “SCAN NEXT PAGE” using  or  and 
press [OK]. 

Repeat step 10 until all the originals have finished being scanned.

11 If there are no more originals, select “FINISHED” using  or . The originals are stored 

by pressing the [OK].

RADF Original Glass

CONTINUE SCAN

SCAN NEXT

FINISHED

NEXT ORIGINAL?

SCAN NEXT PAGE

FINISHED
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Scan to File

Scan to File allows you to store scans as PDF, TIFF or JPEG files in a network folder. From these folders, you 
can copy the saved data and use it on your computer.
If you choose to store your scans in the network folder, the type of operating system, such as Windows or 
Macintosh, does not matter; you can save the data in any network folder accessible by FTP or SMB.

 Procedure for Scan to File

 The network administrator has to make settings for storing the scanned data to the client computers. 
For details, refer to the TopAccess Guide.
 We recommend that you back up the data stored in the shared folder.
 Delete documents stored in the shared folder when they are no longer needed.

1 Place the original(s).

 For placing the originals, see the pages below.
 P.39 “Copying originals”
 A4, A3, A5-R, B5, B5-R, B4, A4-R and FOLIO (LT, LD, LT-R, LG, ST-R and COMP) sized 

originals can be scanned.

2 Press [SCAN].

3 Press  or  to select “FILE”, and then press .

Scan to File

Copying files from the

network folder

Client

computer
Network FolderNetwork Folder

SELECT SCAN TYPE

E-MAIL

FILE

USB
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4 Press  or  to select “REMOTE1” or “REMOTE2”, and then press .

5 Press  or  to select the item, press , and then make the scan settings as required.

The settings available for Scan to FILE are as follows:

To make further settings, see the following.
 P.159 “Scan Settings”

6 Press [START].

Menu Functions Settings Description

FILE 

NAME(MAX128)

- An initial file name can be 
changed.
 P.167 “Character entry”

FILE FORMAT PDF MULTI Stores your scan as a PDF file.
Select [MULTI] for saving several 
pages as a single file.
Select [SINGLE] for saving 
several pages as a separated 
single file for each page.

SINGLE

TIFF MULTI Stores your scan as a TIFF file.
Select [MULTI] for saving several 
pages as a single file.
Select [SINGLE] for saving 
several pages as a separated 
single file for each page.

SINGLE

JPEG Stores your scan as a JPEG file.
This setting is not available when 
“BLACK” is selected in the 
“COLOR MODE” function.

FILE

REMOTE1

REMOTE2

DocYYMMDD

FILE

REMOTE1

REMOTE2

DocYYMMDD
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7 If there are more originals, place the next ones.

 When you place originals on the Reversing Automatic Document Feeder (RADF), select “SCAN 

NEXT” using  or  and press [OK].

 When you place an original on the original glass, select “SCAN NEXT PAGE” using  or  and 
press [OK]. 

Repeat step 7 until all the originals have finished being scanned.

8 If there are no more originals, select “FINISHED” using  or . The originals are stored 

by pressing the [OK].

RADF Original Glass

CONTINUE SCAN

SCAN NEXT

FINISHED

NEXT ORIGINAL?

SCAN NEXT PAGE

FINISHED
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Scan to USB Memory

Scan to USB allows you to save scanned images as PDF, TIFF, or JPEG files in a USB storage device.

 Procedure for Scan to USB Memory

USB storage devices must meet requirements below. However, some USB storage devices may not be 
used with this equipment even though the requirements below are met.
- FAT16 or FAT32 format
- Single-partition (USB storage devices with multiple partitions are not supported.)

1 Place the original(s).

 For placing the originals, see the pages below.
 P.39 “Copying originals”
 A4, A3, A5-R, B5, B5-R, B4, A4-R and FOLIO (LT, LD, LT-R, LG, ST-R and COMP) sized 

originals can be scanned.

2 Press [SCAN].

Scan to USB

USB MediaUSB Media
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3 To store scans in a USB storage device, connect the device to the equipment and wait a 

few seconds.

4 Press  or  to select “USB”, and then press [OK].

5 Press , and then make the scan settings as required.

The settings available for Scan to USB Memory are as follows:

To make further settings, see the following.
 P.159 “Scan Settings”

Menu Functions Settings Description

FILE 

NAME(MAX128)

- An initial file name can be 
changed.
 P.167 “Character entry”

FILE FORMAT PDF MULTI Stores your scan as a PDF file.
Select [MULTI] for saving several 
pages as a single file.
Select [SINGLE] for saving 
several pages as a separated 
single file for each page.

SINGLE

TIFF MULTI Stores your scan as a TIFF file.
Select [MULTI] for saving several 
pages as a single file.
Select [SINGLE] for saving 
several pages as a separated 
single file for each page.

SINGLE

JPEG Stores your scan as a JPEG file.
This setting is not available when 
“BLACK” is selected in the 
“COLOR MODE” function.

SELECT SCAN TYPE

USB

BLACK

300dpi

USB

DocYYMMDD

PDF
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6 Press [START].

When you store scans in a USB storage device, never attempt to remove the device from the 
equipment until data transmission is completed. Removing the USB storage device during data 
transmission may corrupt the device.

7 If there are more originals, place the next ones.

 When you place originals on the Reversing Automatic Document Feeder (RADF), select “SCAN 

NEXT” using  or  and press [OK].

 When you place an original on the original glass, select “SCAN NEXT PAGE” using  or  and 
press [OK]. 

Repeat step 7 until all the originals have finished being scanned.

8 If there are no more originals, select “FINISHED” using  or . The originals are stored 

by pressing the [OK].

RADF Original Glass

CONTINUE SCAN

SCAN NEXT

FINISHED

NEXT ORIGINAL?

SCAN NEXT PAGE

FINISHED
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Scan Settings

You can make the scan settings on the scan functions menu.

Press [CANCEL] to exit from the setting without making any changes. You can also exit by pressing  if it 
is active.

 Selecting the color mode

You can select the color mode best suited to your scan job.

1 Press [SCAN].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK].

 Selecting the resolution

You can select the resolution.

*1 When the “FULL COLOR” mode has been selected, you can select “600 dpi” only for the original of A5-R or ST-R size.

*2 When the “FULL COLOR” mode has been selected, you cannot select the original size larger than A4 or LT.

1 Press [SCAN].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK].

Menu Functions Settings Description

COLOR MODE BLACK Images in black and white.

GRAY SCALE Images containing both text and photos. The photo 
quality is enhanced.

FULL COLOR Color images.

SELECT SCAN TYPE

FILE

USB

BLACK

Menu Functions Settings

RESOLUTION 600dpi*1

400dpi*2

300dpi

200dpi

150dpi

SELECT SCAN TYPE

USB

BLACK

300dpi



5 SCAN FUNCTIONS

160    Scan Settings

 Scanning the 2-sided originals

With the single/2-sided scan setting, you can choose whether to scan your originals on both sides.

To scan 2-sided originals automatically, the Reversing Automatic Document Feeder is required.

1 Press [SCAN].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK].

 Selecting the original size

You can specify the original size.

1 Press [SCAN].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK].

Menu Functions Settings Description

SINGLE/2-SIDED 

SCAN

SINGLE Scans only the front of the originals.

DUPLEX Scans both sides of the originals.

SELECT SCAN TYPE

BLACK

300dpi

SINGLE

Menu Functions Settings Description

ORIGINAL SIZE AUTO SIZES Detects the size of your originals.

A3, A4, A4-R, A5-R, B4, B5, 
B5-R, FOLIO, 8K, 16K, 
16KR, LD, LG, LT, LT-R, 
COMP, 13"LG, ST-R, 8.5"SQ

Sets the size of your originals.

SELECT SCAN TYPE

300dpi

SINGLE

AUTO SIZES
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 Scanning different sizes in one go

When different sizes of originals are mixed and placed on the Reversing Automatic Document Feeder, some 
combinations of sizes can be scanned in one go. The combination of A3 and A4, B4 and B5, or A4-R and 
FOLIO is available.

1 Press [SCAN].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK].

 Selecting the original mode

You can select the original mode for the image quality best suited to your originals.

1 Press [SCAN].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK].

Menu Functions Settings

MIX-ORIGINAL OFF

ON

SELECT SCAN TYPE

SINGLE

AUTO SIZES

MIX-ORIGINAL:OFF

Menu Functions Settings Description

ORIGINAL MODE TEXT/PHOTO Text and photographs mixed.

TEXT Scans in the appropriate image quality for the 
original(s) with text, fine illustration and watermark.

PHOTO Photographs only.

SELECT SCAN TYPE

AUTO SIZES

MIX-ORIGINAL:OFF

TEXT/PHOTO
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 Selecting the orientation

You can change the orientation of your scans. Select the desired rotation pattern.

1 Press [SCAN].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK].

 Selecting the compression ratio

You can select the compression ratio for the scanned image data. In general, the higher the compression 
ratio, the lower the image quality.

This function is not available when “BLACK” is selected in the “COLOR MODE” function.

1 Press [SCAN].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK].

Menu Functions Settings Description

ROTATION Scans originals without a change in orientation.

Rotates your scans 90 degrees to the right.

SELECT SCAN TYPE

MIX-ORIGINAL:OFF

TEXT/PHOTO

Menu Functions Settings Description

COMPRESS LOW Applies a low compression ratio and enhances the 
image quality.

MID Compresses the data with a moderate compression 
ratio and obtains an average image quality.

HIGH For a high compression ratio. Suitable when you 
want to minimize the data size rather than enhance 
the image quality.

SELECT SCAN TYPE

TEXT/PHOTO

COMPRESS:LOW
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 Removing blank pages

If your original contains blank pages, you can remove them from the scan result.

This function is available only when “BLACK” is selected in the “COLOR MODE” function.

1 Press [SCAN].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK].

 Adjusting the exposure

You can adjust the density to make scans lighter or darker in nine levels from -4 to +4. The auto density 
setting can represent the scan image in the middle density status.

 This function is not available when “GRAY SCALE” is selected in the “COLOR MODE” function.
 “AUTO” is available only when “BLACK” is selected in the “COLOR MODE” function and “TEXT” or 

“TEXT/PHOTO” is selected in the “ORIGINAL MODE” function.

1 Press [SCAN].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item.

4 Adjust the density as follows.

For “AUTO”:

Press [OK].
For manual:

1) Press  or  to increase or decrease the density level.
2) Press [OK].

Menu Functions Settings

OMIT BLANK 

PAGE

OFF

ON

SELECT SCAN TYPE

OMIT BLANK:OFF

COMPRESS:LOW

Menu Functions Settings Description

EXPOSURE AUTO Adjusts the density automatically.

Manual Adjusts the density manually.

SELECT SCAN TYPE

AUTO EXPOSURE

OMIT BLANK:OFF

COMPRESS:LOW
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 Continuing the scanning

When you scan with the Reversing Automatic Document Feeder (RADF), you can select whether you 
continue scanning the next originals after the last loaded original is scanned.

1 Press [SCAN].

2 Press  or  to select the item displayed on the LCD screen, and then press .

3 Press  or  to select the setting item, and then press [OK].

 Specifying E-mail Addresses

To specify e-mail addresses for the Scan to E-mail function, you have the following options:

Up to 220 addresses can be specified.

 P.164 “Entering an e-mail Addresses”
 P.165 “Selecting from the address book”
 P.165 “Searching the address book with single numbers”
 P.166 “Searching the address book with group numbers”
 P.166 “Viewing/Deleting specified e-mail addresses”

Entering an e-mail Addresses

1 Press  or  to select “INPUT ADDRESS”, and then press .

2 Enter an e-mail address using the digital keys.

 P.167 “Character entry”

3 Press [OK].

 You can enter up to 220 addresses in total for “TO (ADDRESS)” and “CC (ADDRESS)”.
 If you want to view or delete the specified e-mail addresses, see the following page.
 P.166 “Viewing/Deleting specified e-mail addresses”

Menu Functions Settings

CONTINUE SCAN OFF

ON

SELECT SCAN TYPE

CONTINUE SCAN:ON 

AUTO EXPOSURE

OMIT BLANK:OFF

TO(ADDRESS)

REVIEW LIST

INPUT ADDRESS

SEARCH

TO:ADDRESS

abC@example.com

  :Aa
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Selecting from the address book

1 Press  or  to select “SEARCH”, and then press .

2 Using  or , select letters tab that you want to display. Using  or , select the desired 

contact, and then press [OK].

3 Press [OK].

 You can enter up to 220 addresses in total for “TO (ADDRESS)” and “CC (ADDRESS)”.
 If you want to view or delete the specified e-mail addresses, see the following page.
 P.166 “Viewing/Deleting specified e-mail addresses”

Searching the address book with single numbers

1 Press  or  to select “SINGLE NUMBER”, and then press .

2 Using the digital keys, enter the single number for the desired contact.

3 Press [OK].

 You can enter up to 220 addresses in total for “TO (ADDRESS)” and “CC (ADDRESS)”.
 If you want to view or delete the specified e-mail addresses, see the following page.
 P.166 “Viewing/Deleting specified e-mail addresses”

TO(ADDRESS)

REVIEW LIST

INPUT ADDRESS

SEARCH

001test1

002test2

abc

ALL A-Z 0-9 ABC

TO(ADDRESS)

INPUT ADDRESS

SEARCH

SINGLE NUMBER

TO:ADDRESS

SINGLE(001-200)

  120
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Searching the address book with group numbers

1 Press  or  to select “GROUP NUMBER”, and then press .

2 Using the digital keys, enter the group number for the desired contact.

3 Press [OK].

 You can enter up to 220 addresses in total for “TO (ADDRESS)” and “CC (ADDRESS)”.
 If you want to view or delete the specified e-mail addresses, see the following page.
 P.166 “Viewing/Deleting specified e-mail addresses”

Viewing/Deleting specified e-mail addresses

You can view the specified e-mail addresses, contacts, and groups, and delete them from the list.

1 On the “E-MAIL ADDRESS” menu, select “TO” or “CC” using  or , and then press .

If you select “CC”, select “REVIEW LIST” using  or , and then press [OK].

Currently selected e-mail addresses, contacts, and groups are listed on the screen.
To delete an e-mail address, contact, and/or group from the list, go to step 2.

2 Select a listing you want to delete, and then press [CLEAR/STOP].

3 “DELETE DESTINATION?” message appears, select “YES” using  or , and then 

press [OK].

TO(ADDRESS)

SEARCH

SINGLE NUMBER

GROUP NUMBER

TO:ADDRESS

GROUP DIAL(01-20)

  12

E-MAIL ADDRESS

TO abc@example.com

CC MULTI DEST.
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 Character entry

The character entry screen is for entering characters when you are setting and entering items.
You can enter the following:
Alphabet characters, numbers and symbols.

Enter the characters using the digital keys and , , , or , after switching the type of the character with the 
[✱] digital key.

 Switching the input mode

The type of the character is displayed in the first line of the message display panel. Set the type of character 
to enter by pressing the [✱] digital key.
The input mode switches as follows each time the [✱] key is pressed.

Alphabet characters <--> Numbers

 Entering characters

Example: To enter “Chicago”

1 Press [✱] to set the alphabet input mode.

2 Press [2] a few times to enter “C”.

3 Press  to move the cursor to the right.

If you want to enter the character assigned to another digital key, you can enter it without moving the 

cursor to the right or pressing .

4 Similarly, you can enter the following characters using the digital keys.

5 After you have entered the last character, Press [OK].

FILE NAME(MAX128)

_

  :Aa

FILE NAME(MAX128)

C

  :Aa

FILE NAME(MAX128)

C_

  :Aa

FILE NAME(MAX128)

Chicago

  :Aa
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Relationship between the digital keys and the input character

The character entered by each digital key differs depending on the input mode. The assignment of characters 
in the character input mode is as follows.

Characters entered in the character input mode

You can enter the characters displayed on the upper side of the digital keys.

 Scan speed

The scan speed depends on the selected color mode and resolution settings.
The approximate scan speed (for printing A4/LT) under each condition is listed in the table below.

*1 Available only A4/LT or smaller size

*2 Available only A5-R/ST-R

The color mode and resolution settings can be changed on the scan setting screen. For details, see the 
following sections:
 P.159 “Selecting the color mode”
 P.159 “Selecting the resolution”

Digital 

key
Number of times the key is pressed ()

1 . @ 1

2 A B C 2 a b c

3 D E F 3 d e f

4 G H I 4 g h i

5 J K L 5 j k l

6 M N O 6 m n o

7 P Q R S 7 p q r s

8 T U V 8 t u v

9 W X Y Z 9 w x y z

0 0

# <space> - +

Color Mode Resolution Scan Speed

Black 150 dpi

25 pages/minute

200 dpi

300 dpi

400 dpi

600 dpi

Full Color 150 dpi

25 pages/minute200 dpi

300 dpi

400 dpi 6 pages/minute*1

600 dpi 6 pages/minute*2
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Once you have set the several functions and settings, you can register up to three of them as “templates” and 
recall one of them for frequent use.

 Registering the templates

1 Make settings for the functions to register as a template.

2 Press [TEMPLATE].

3 Press  or  to select “REGISTRATION”, and then press .

4 Press  or  to select a template, and then press [OK].

 You can register three templates for scanning.
 The settings are overwritten if you select an existing template.
 Update the recipients of the template if you have updated the address book.
 You can also register and edit templates with TopAccess. For details, refer to the TopAccess Guide.

You can specify the following items in scan templates.

Basic setting

*1 When the “FULL COLOR” mode has been selected, you cannot select the original size larger than A4 or LT.

*2 When the “FULL COLOR” mode has been selected, you can select “600 dpi” only for the original of A5-R or ST-R size.

*3 This item is available only when the Reversing Automatic Document Feeder (RADF) is installed.

No. Item Name Settings

1 Scan to (Agent) E-MAIL, FILE, USB

2 Color Mode BLACK, GRAY SCALE, FULL COLOR

3 Resolution 150dpi, 200dpi, 300dpi, 400dpi*1, 600dpi*2

4 Single/2-Sided Scan SINGLE, DUPLEX

5 Original Size AUTO SIZES, A3, A4, A4-R, A5-R, B4, B5, B5-R, FOLIO, 8K, 
16K, 16KR, LD, LG, LT, LT-R, COMP, 13"LG, ST-R, 8.5"SQ

6 Mixed Original Size OFF, ON

7 Rotation , 

8 Compress LOW, MID, HIGH

9 Omit Blank Page OFF, ON

10 Exposure AUTO, MANUAL(±4)

11 Continue Scan*3 OFF, ON

TEMPLATE

RECALL

REGISTRATION
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Scan to E-mail

Scan to File

Scan to USB

* Specify from the control panel by modifying the value that has been set with the administrator privilege or the default value.

 Recalling a template

1 Press [TEMPLATE].

2 Press  or  to select “RECALL”, and then press .

3 Press  or  to select a template, and then press [OK].

No. Item Name Settings

1 Destination TO, CC

2 File Format PDF(SINGLE), PDF(MULTI), TIFF(SINGLE), TIFF(MULTI), 
JPEG

3 File Name The default value or the file name entered from the control 
panel.

4 Message size NONE, 64, 128, 256, 512, 1024, 2048

5 Subject*

6 From Address* Specify with the administrator privilege or enter from the control 
panel.

7 From Name* Specify with the administrator privilege or enter from the control 
panel.

8 Body* Specify with the administrator privilege or enter from the control 
panel.

No. Item Name Settings

1 Destination REMOTE1, REMOTE2

2 File Format PDF(SINGLE), PDF(MULTI), TIFF(SINGLE), TIFF(MULTI), 
JPEG

3 File Name The default value or the file name entered from the control 
panel.

No. Item Name Settings

1 File Format PDF(SINGLE), PDF(MULTI), TIFF(SINGLE), TIFF(MULTI), 
JPEG

2 File Name The default value or the file name entered from the control 
panel.

TEMPLATE

RECALL

REGISTRATION
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See the following page for information on using the copy menu.
 P.37 “COPY FUNCTIONS”

 Copy menu items

When you press  or  on the main screen (Copy), you enter the copy menu which allows you to use copy 
functions. The table below shows the functions and reference pages available in the copy menu.

Menu Functions Settings Description and Reference Pages

EXPOSURE AUTO, Manual Sets the density level for the copied 
image.
 P.44 “Adjusting the exposure”

ORIGINAL MODE TEXT/PHOTO, TEXT, PHOTO, 
BACKGROUND ERASE

Sets an original mode suitable for the 
image being copied.
 P.45 “Selecting the original mode”

DRAWER Drawer 1 XX to Drawer 4 XX, Bypass XX, 
APS

Sets the paper source.
 P.46 “Selecting the paper”

ZOOM Manual zoom (25 - 100 - 400%), FIXED 
ZOOM, AMS

Sets the zoom ratio for copied images.
 P.48 “Enlarging or reducing the copy 
size”

FINISHING NON SORT, SORT, ROTATE SORT Sets the finishing mode for ejecting 
copies.
 P.53 “Sorting pages”

2IN1/4IN1 OFF, 2IN1, 4IN1 Copies two or four originals onto one 
sheet of paper.
 P.55 “Copying two or four pages on 
each sheet”

ID CARD OFF, ON Sets the ID card function.
 P.57 “Copying both sides of a card on 
a sheet”

EDGE ERASE OFF, ON (4 to 15 mm (0.2 to 0.6")) Sets the edge erase function.
 P.59 “Erasing the shadow on edges”

DUAL PAGE OFF, ON Sets the dual page function.
 P.60 “Copying right and left pages 
separately”

IMAGE SHIFT OFF, LEFT MARGIN, RIGHT MARGIN Sets the image shift function.
 P.61 “Shifting the pages to the right or 
left”

2-SIDED 1 > 1 SIMPLEX, 1 > 
2 DUPLEX, 2 > 2 
DUPLEX, 2 > 1 
SPLIT, 

BOOK, TABLET Sets the 2-sided function.
 P.62 “Copying on one or both sides”

ANNOTATION OFF, PAGE NO., PAGE No.+DATE/TIME Sets the annotation function.
 P.65 “Adding a page number and 
date/time on the copied paper”

OMIT BLANK PAGE OFF, ON Sets the omit blank page function.
 P.65 “Removing blank pages”

MIX-ORIGINAL OFF, ON Sets the mix-original function.
 P.66 “Copying different sizes in one 
go”

IMAGE DIRECTION OFF, ON Sets the image direction function.
 P.67 “Image direction”

CONTINUE SCAN OFF, ON Sets the scan continuation function.
 P.68 “Continuing the scanning for a 
copy”



6 VARIOUS FUNCTIONS

 Scan Menu List    173

Scan Menu List

See the following page for information on using the scan menu.
 P.131 “SCAN FUNCTIONS”

 Scan menu items

When you press  or  on the main screen (Scan), you enter the scan menu which allows you to use basic 
and advanced scan functions. The table below shows the functions and reference pages available in the scan 
menu.

Menu Functions Reference Pages

E-MAIL E-MAIL ADDRESS  P.174 “E-mail functions”

FILE NAME(MAX128)

FILE FORMAT

MESSAGE SIZE

FILE REMOTE1  P.174 “File functions”

REMOTE2

FILE NAME(MAX128)

FILE FORMAT

USB FILE NAME(MAX128)  P.174 “USB functions”

FILE FORMAT

COLOR MODE  P.175 “Basic setting functions”

RESOLUTION

SINGLE/2-SIDED SCAN

ORIGINAL SIZE

MIX-ORIGINAL

ORIGINAL MODE

ROTATION

COMPRESS

OMIT BLANK PAGE

EXPOSURE

CONTINUE SCAN
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 E-mail functions

 File functions

USB functions

Menu Functions Settings Description and Reference Pages

E-MAIL ADDRESS TO (ADDRESS)
CC (ADDRESS)

REVIEW LIST You can select from the Address Book or 
directly enter the address.
 P.150 “Procedure for Scan to E-Mail”
 P.164 “Specifying E-mail Addresses”

INPUT ADDRESS

SEARCH

SINGLE NUMBER

GROUP NUMBER

FILE 
NAME(MAX128)

You can use up to 128 characters. Enter the file name to save.
 P.150 “Procedure for Scan to E-Mail”
 P.167 “Character entry”

FILE FORMAT PDF MULTI Sets the file format to attach the scanned 
data to the E-mail.
 P.150 “Procedure for Scan to E-Mail”

SINGLE

TIFF MULTI

SINGLE

JPEG

MESSAGE SIZE NONE, 64, 128, 256, 512, 1024, 2048 When the scanned data is bigger than the 
selected size, divides the data into the set 
size before sending the E-mail.
 P.150 “Procedure for Scan to E-Mail”

Menu Functions Settings Description and Reference Pages

REMOTE1/2 Displays only. Displays the set destination.
 P.153 “Procedure for Scan to File”

FILE 
NAME(MAX128)

You can use up to 128 characters. Enter the file name to save.
 P.153 “Procedure for Scan to File”
 P.167 “Character entry”

FILE FORMAT PDF MULTI Sets the file format to save.
 P.153 “Procedure for Scan to File”SINGLE

TIFF MULTI

SINGLE

JPEG

Menu Functions Settings Description and Reference Pages

FILE 
NAME(MAX128)

You can use up to 128 characters. Enter the file name to save.
 P.156 “Procedure for Scan to USB 
Memory”
 P.167 “Character entry”

FILE FORMAT PDF MULTI Sets the file format to save.
 P.156 “Procedure for Scan to USB 
Memory”

SINGLE

TIFF MULTI

SINGLE

JPEG
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Basic setting functions

*1 When the “FULL COLOR” mode has been selected, you can select “600 dpi” only for the original of A5-R or ST-R size.

*2 When the “FULL COLOR” mode has been selected, you cannot select the original size larger than A4 or LT.

Menu Functions Settings Description and Reference Pages

COLOR MODE BLACK, GRAY SCALE, FULL COLOR Sets the color mode to scan the data.
 P.159 “Selecting the color mode”

RESOLUTION 600dpi*1, 400dpi*2, 300dpi, 200dpi, 
150dpi

Sets the resolution for the data to scan.
 P.159 “Selecting the resolution”

SINGLE/2-SIDED 
SCAN

SINGLE, DUPLEX Sets the type of originals to scan.
 P.160 “Scanning the 2-sided originals”

ORIGINAL SIZE AUTO SIZES, A3, A4, A4-R, A5-R, B4, 
B5, B5-R, FOLIO, 8K, 16K, 16KR, LD, 
LG, LT, LT-R, COMP, 13"LG, ST-R, 
8.5SQ

Sets the size for the original to scan.
 P.160 “Selecting the original size”

MIX-ORIGINAL OFF, ON Sets the mix-original function.
 P.161 “Scanning different sizes in one 
go”

ORIGINAL MODE TEXT, TEXT/PHOTO, PHOTO Sets the type of the original to scan.
 P.161 “Selecting the original mode”

ROTATION , Rotates the scanned data to save.
 P.162 “Selecting the orientation”

COMPRESS LOW, MID, HIGH Sets the compression ratio for the scanned 
image data.
 P.162 “Selecting the compression ratio”

OMIT BLANK PAGE OFF, ON Sets whether to remove blank pages from 
the scan result.
 P.163 “Removing blank pages”

EXPOSURE AUTO, Manual Sets the density level for the scanned 
image data.
 P.163 “Adjusting the exposure”

CONTINUE SCAN OFF, ON Sets the scan continuation function.
 P.164 “Continuing the scanning”
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You can set various network functions.

For instructions on how to display the NETWORK menu, see the following page:
 P.179 “User Functions Menu List”

 P.176 “Setting the Ethernet speed”
 P.177 “Setting the TCP/IP protocol”
 P.178 “Setting the HTTP network service”

Once the network has been set up, exit from USER FUNCTIONS menu by pressing [CANCEL] or [USER 
FUNCTIONS] button. When “APPLY AND REBOOT?” message appears, select “YES”, and then press 
[OK]. The equipment is automatically rebooted and the network settings are applied.

 Setting the Ethernet speed

You can specify the Ethernet speed.

If the network is not stable, turn the power of the equipment OFF and then back ON.

NETWORK

COMPLETE

ETHERNET

TCP/IP

Item name Description

AUTO
10MBPS HALF DUPLEX
10MBPS FULL DUPLEX
100MBPS HALF DUPLEX
100MBPS FULL DUPLEX

Select the desired combination of communication speed and 
transmission method.

ETHERNET

AUTO

10MBPS HALF DUPLEX

10MBPS FULL DUPLEX
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 Setting the TCP/IP protocol

You can set the TCP/IP protocol that is commonly used in most network systems. When using Web-based 
utilities such as TopAccess or network features of this equipment such as network printing and network 
scanning, you are required to set the TCP/IP protocol.
In the TCP/IP setting operation, you can select the addressing mode, as well as assign the IP address, subnet 
mask and default gateway (when manually assigned).
How the TCP/IP protocol must be set depends on your network environment.

Use the digital keys to enter [IP ADDRESS] or [SUBNET MASK] or [DEFAULT GATEWAY].
For entering characters, see the following page.
 P.167 “Character entry”

Item name Description

ADDRESS MODE  STATIC IP (When connecting to a local area network using static IP addresses)
Select [STATIC IP] and specify an IP address when connecting to a local area 
network where static IP addresses are used. Also set the subnet mask and 
default gateway as required.
 DYNAMIC (When TCP/IP is set by Auto-IP addressing or DHCP server)

Select [DYNAMIC] when you do not know the TCP/IP settings that should be 
assigned to the equipment. If [DYNAMIC] is selected when your network supports 
the DHCP, the IP address, subnet mask, default gateway, primary WINS server 
address, secondary WINS server address, POP3 server address, and SMTP 
server address are acquired from the DHCP server. If the DHCP is not supported, 
an appropriate IP address is assigned to this equipment by the auto-IP 
addressing function. However, the auto-IP addressing may not work properly if a 
router is placed in the network.
 NO AUTO IP (When TCP/IP is set using only the DHCP server)

Select [NO AUTO IP] when the equipment is connected to a local area network 
with a DHCP server and you want to set the TCP/IP not using the auto-IP 
addressing function, but only the DHCP. When [NO AUTO IP] is selected, the IP 
address, subnet mask, default gateway, primary WINS server address, secondary 
WINS server address, POP3 server address, and SMTP server address are 
acquired from the DHCP server, and the IP address assignment by the auto-IP 
addressing function disabled.

IP ADDRESS
SUBNET MASK
DEFAULT 
GATEWAY

Press [IP ADDRESS] and enter the IP address of this equipment using the digital 
keys.
Enter the subnet mask and default gateway as required.

Use  or  to switch the active box.

This item is enabled only when [STATIC IP] is selected for [ADDRESS MODE].

TCP/IP

ADDRESS MODE

IP ADDRESS

SUBNET MASK
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 Setting the HTTP network service

You can enable or disable the HTTP network server service that provides web-based utilities on this 
equipment, such as TopAccess.

Use the digital keys to enter [PRIMARY PORT NUMBER].
For entering characters, see the following page.
 P.167 “Character entry”

Item name Description

HTTP SERVER  ENABLE — Press this button to use the HTTP network server 
service.
 DISABLE — Press this button to disable the HTTP network server 

service.
This option must be enabled for TopAccess.

PRIMARY PORT NUMBER Press this button to enter the primary port number to be used for 
receiving HTTP access from other clients. Normally use the default port 
number “80”.

HTTP

HTTP SERVER

PRIMARY PORT NUMBER
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Before you start operating the “USER FUNCTIONS” menu, learn the general procedure below.

 Press [CANCEL] to exit from the setting without making any changes. You can also exit with the  
button if it is active.
 Press [CLEAR/STOP] to delete a character. Keep pressing [CLEAR/STOP] for a second to clear all 

characters.

1 Press [USER FUNCTIONS].

2 Press  or  to scroll the menu, and then press  to enter the function menu.

 P.180 “User functions menu items”

3 Press  or  to scroll the menu, and then press  to select the function.

4 Press  or  to scroll the menu, and then press  to select the settings for each 

function.

5 Press , , , or  to select a setting, and then press [OK].

 Continues to the next step if the selected setting has more options or values.
 Exits from the menu if the selected setting has no more options or values. At this point, the operation 

is complete.

6 Make option settings with , , , or , or enter characters using the digital keys, and 

then press [OK].

 Repeat this step if the selected setting has more options or values.
 Exits from the menu if the selected setting has no more options or values. At this point, the operation 

is complete.

The options or values vary depending on the function.
 P.182 “GENERAL”
 P.186 “COPY”
 P.187 “SCAN”
 P.188 “USB PRINT”
 P.188 “LIST”
 P.189 “WIRELESS SETTING”
 P.190 “ADDRESS BOOK”
 P.190 “DRAWER”
 P.191 “INFORMATION”

USER FUNCTIONS

GENERAL

COPY

SCAN
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 User functions menu items

When you press [USER FUNCTIONS] on the main screen (Copy), you enter the “USER FUNCTIONS” menu 
which enables you to change each setting and execute the device functions.
The table below shows the functions and reference pages available in the “USER FUNCTIONS” menu.

Menu Functions Reference Pages

GENERAL CHANGE LANGUAGE  P.182 “GENERAL”

CLOCK DATE/TIME

DATE FORMAT

WALKUP SCREEN

TIMERS AUTO POWER SAVE

SLEEP MODE

AUTO CLEAR

WEEKLY TIMER

DEPARTMENT CODE 

POP UP DRAWER SET

PAPER JAM RECOVERY

LCD CONTRAST

USB WAKEUP

NETWORK COMPLETE

NIC STATUS

ETHERNET

TCP/IP

HTTP

SERVICE NOTIFY*1 E-MAIL SETTINGS

CUSTOMER INFO.

SUPPLY NOTICE DESTINATION SETUP

AUTO DETECT

OTHER INFORMATION

COPY EXPOSURE  P.186 “COPY”

EXPOSURE LEVEL AUTO LEVEL

MANUAL LEVEL

ORIGINAL MODE

MAXIMUM COPIES

SORT MODE PRIORITY

AUTO 2-SIDED MODE

2IN1/4IN1 ORIGINAL SIZE

ORIG. ORIENTATION

PAGE LAYOUT

BACKGROUND

SHARPNESS

OMIT BLANK PAGE

CONTINUE SCAN
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*1 This item is not displayed depending on the destinations.

*2 This item is displayed when the PostScript kit has been installed.

SCAN COLOR MODE  P.187 “SCAN”

COMPRESS

2-SIDED SCAN

ROTATION

BLACK SETTING RESOLUTION

ORIGINAL MODE

EXPOSURE

GRAY SETTING RESOLUTION

FULL COLOR SETTING RESOLUTION

ORIGINAL MODE

OMIT BLANK PAGE

CONTINUE SCAN

FAX TERMINAL ID For details of the fax 
settings, see the Fax 

Guide.
INITIAL SETUP

RX PRINT

USB PRINT PAPER SIZE A3, A4, B4, B5, A5-R, 
FOLIO, LD, LG, LT, COMP, 
13"LG, ST-R, 8.5SQ

 P.188 “USB PRINT”

2-SIDED SINGLE, DUPLEX

REPORT SETTING AUTO JOURNAL For details of the fax 
settings, see the Fax 

Guide.
MEMORY TX

MULTI TX

LIST ADDRESS BOOK  P.188 “LIST”

FUNCTION

COUNTER

DEPARTMENT

PCL FONT

PS FONT*2

WIRELESS 
SETTING

-  P.189 “WIRELESS 
SETTING”

ADDRESS BOOK E-MAIL SINGLE NUMBER  P.190 “ADDRESS 
BOOK”GROUP NUMBER

PHONE BOOK SPEED DIAL

GROUP DIAL

ONE TOUCH

DRAWER DRAWER 1  P.190 “DRAWER”

DRAWER 2

DRAWER 3

DRAWER 4

INFORMATION COUNTER TOTAL COUNTER  P.191 “INFORMATION”

TONER REMAIN

SERIAL NUMBER

Menu Functions Reference Pages
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GENERAL

Menu Functions Settings Description

CHANGE LANGUAGE S-CHINESE (SIMPLIFIED 
CHINESE), T-CHINESE 
(TRADITIONAL CHINESE), 
JAPANESE, ENGLISH, 
FRENCH, ITALIAN, 
GERMAN, POLISH, 
RUSSIAN, SPANISH, 
SWEDISH, NORWEGIAN, 
FINNISH, DANISH, DUTCH, 
PORTUGUESE, CZECH, 
HUNGARIAN, ROMANIAN, 
SLOVAKIAN, LITHUANIAN, 
IRISH, SLOVENIAN, 
BULGARIAN, LATVIAN, 
SERBIAN, TURKISH

Sets the default language. The 
default language and the 
appearance order vary 
depending on the region.

CLOCK DATE/TIME YYYY/MM/DD HH:MM
Year:2012 - 2037
Month:01 - 12
Day:01 - 28, 29, 30, 31
Hour:00 - 23
Minute:00 - 59

Sets the date and time.

DATE FORMAT MM/DD/YY
DD/MM/YY
YY/MM/DD

Sets the data format.

WALKUP SCREEN COPY, SCAN, FAX Sets the start screen.

TIMERS AUTO POWER SAVE 1, 3, 4, 5, 7, 10, 15, 20, 30, 45, 
60

Sets the period of time (in 
minutes) that this equipment 
should wait before low power 
mode is activated.

SLEEP MODE 1, 3, 5, 10, 15, 20, 25, 30, 40, 
50, 60

Sets the period of time (in 
minutes) that this equipment 
should wait before sleep mode 
is activated.

AUTO CLEAR 15, 30, 45, 60, 75, 90, 105, 
120, 135, 150

Sets the time (in seconds) to 
clear the previous settings and 
return to the main screen.

WEEKLY TIMER OFF, ON (SUNDAY, 
MONDAY, TUESDAY, 
WEDNESDAY, THURSDAY, 
FRIDAY, SATURDAY)

Sets the time to enter energy 
saving mode and the time to 
exit the energy saving mode for 
each day from Sunday to 
Saturday.
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DEPART
MENT 
CODE

YES MASTER 
CODE/ 
DEPARTMEN
T CODE

NUMBER (01 to 99) Sets the department number in 
the range from "2" to "99". ("01" 
is already registered as the 
master code (administrator's 
code).)

NAME (max 20 characters) Enter the department name.
 P.167 “Character entry”

CODE (5 digits) Sets the 5-digit number for 
master code or department 
code. Entered numbers are 
displayed as asterisks (*). 
Existing codes cannot be 
entered. 

Do not forget this 5-digit 
number for master code 
because it is required for 
setting or deleting each 
department code.

NO - Department code is not set.

POP UP DRAWER SET ENABLE, DISABLE Sets whether to display a pop-
up message on the LCD screen 
in the following cases.
 When the size of paper 

loaded in the drawer differs 
from setting.
 When a paper misfeed 

occurs.

PAPER JAM RECOVERY ENABLE, DISABLE

LCD CONTRAST -3 (Light) to +3 (Dark) Sets the brightness of LCD 
panel.

USB WAKEUP OFF, ON Sets whether the equipment 
wakes up from the sleep mode 
by detecting the USB cable or 
USB device.

Menu Functions Settings Description
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NETWOR
K

COMPLETE - Completes the network 
settings.

NIC STATUS - Displays the current network 
communication status.

ETHERNET AUTO, 10MBPS HALF 
DUPLEX, 10MBPS FULL 
DUPLEX, 100MBPS HALF 
DUPLEX, 100MBPS FULL 
DUPLEX

Select the desired combination 
of communication speed and 
transmission method.

TCP/IP ADDRESS 
MODE

STATIC IP, DYNAMIC, NO 
AUTO IP

Sets a method for specifying an 
IP address.

IP ADDRESS 000. 000. 000. 000 - 
255.255.255.255

Sets the IP address of this 
equipment.

SUBNET 
MASK

000. 000. 000. 000 - 
255.255.255.255

Sets the subnet mask of this 
equipment.

DEFAULT 
GATEWAY

000. 000. 000. 000 - 
255.255.255.255

Sets the default gateway of this 
equipment.

HTTP HTTP 
SERVER

ENABLE, DISABLE Sets whether to use the HTTP 
network server service.

PRIMARY 
PORT 
NUMBER

1 - 65535 Sets the primary port number to 
be used for receiving HTTP 
access from other clients. 
Normally use the default port 
number “80”.

SERVICE 

NOTIFY*1

E-MAIL 
SETTINGS

SEND NOW YES, NO Sets the e-mail settings for 
service notification.E-MAIL 

ADDRESS1
-

E-MAIL 
ADDRESS2

-

E-MAIL 
ADDRESS3

-

CUSTOMER 
INFO.

CUSTOMER 
NAME

- Sets the customer information 
for service notification.

CUSTOMER 
TEL NO.

-

CUSTOMER 
E-MAIL

-

Menu Functions Settings Description
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*1 This item is not displayed depending on the destinations.

SUPPLY 

NOTICE*1

DESTINATI
ON SETUP

FAX 
NUMBER

- Sets the contact information for 
ordering supplies.

E-MAIL -

AUTO DETECT OFF, ON Sets whether to detect 
information automatically.

OTHER 
INFORMATI
ON

CUSTOMER 
NUMBER

- Sets other various contact 
information.

CONTACT 
NAME

-

CONTACT 
TEL 
NUMBER

-

SHIP TO 
NAME

-

SHIP TO 
ADDRESS

-

Menu Functions Settings Description
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COPY

Menu Functions Settings Description

EXPOSURE AUTO, Manual Sets the default setting for the 
density. You can change the 
exposure from lighter to darker in 
nine steps from -4 to +4.

EXPOSURE 
LEVEL

AUTO LEVEL -2 to +2 Sets the center value for 
adjusting the density with 
EXPOSURE.

MANUAL LEVEL -2 to +2 Sets the center value for 
adjusting the density with 
EXPOSURE.

ORIGINAL MODE TEXT/PHOTO, TEXT, 
PHOTO, BACKGROUND 
ERASE

Sets the default setting for the 
original mode.

MAXIMUM COPIES 9, 99, 999 Sets the maximum number of 
copies to be allowed.

SORT MODE PRIORITY NON SORT, SORT, ROTATE 
SORT

Sets the default sort mode for 
copy jobs.

AUTO 2-SIDED MODE OFF, 1 > 2 DUPLEX, 2 > 2 
DUPLEX, USER

Sets the default auto 2-sided 
mode for copy jobs.

2IN1/4IN1 ORIGINAL SIZE A3, A4, A5, B4, B5, FOLIO, 
8K, 16K, LD, LG, LT, COMP, 
13"LG, ST, 8.5SQ

Sets the default setting for the 
original size when using the 
“2IN1/4IN1” function.

ORIG. ORIENTATION Portrait, Landscape Sets the default setting for the 
original orientation when using 
the “2IN1/4IN1” function.

PAGE LAYOUT 2IN1: Sets the order of the pages when 
using the “2IN1/4IN1” function.

4IN1: 

BACKGROUND -4 to +4 Adjusts the density of the 
original’s background. It avoids 
the back side of a 2-sided 
original becoming visible on its 
front side. You can change the 
background from lighter to darker 
in nine steps from -4 to +4.

SHARPNESS -4 to +4 Emphasizes or blurs the outline 
of the image. You can change the 
sharpness from softer to sharper 
in nine steps from -4 to +4.

OMIT BLANK PAGE -3 to +3 Sets the sensitivity level to detect 
blank pages. The higher the level 
is, the more likely the equipment 
can detect blank pages. You can 
specify the sensitivity level in the 
range from -3 to +3.

CONTINUE SCAN OFF, ON Sets whether to continue 
scanning when the scanning of 
all the originals set on the RADF 
is finished.
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 SCAN

Menu Functions Settings Description

COLOR MODE BLACK, GRAY SCALE, FULL 
COLOR

Sets the default setting for the 
color mode.

COMPRESS LOW, MID, HIGH Sets the default setting for the 
compression ratio.

2-SIDED SCAN SINGLE, DUPLEX Sets the default setting for the 2-
sided scan mode.

ROTATION
 

Sets the default setting for the 
orientation.

BLACK 
SETTING

RESOLUTION 600dpi, 400dpi, 300dpi, 
200dpi, 150dpi

Sets the default setting for the 
resolution when [BLACK] is 
selected for the color mode 
setting.

ORIGINAL MODE TEXT/PHOTO, TEXT, 
PHOTO

Sets the default setting for the 
original mode when [BLACK] is 
selected for the color mode 
setting.

EXPOSURE AUTO, Manual Sets the default setting for the 
density when [BLACK] is 
selected for the color mode 
setting.

GRAY 
SETTING

RESOLUTION 600dpi, 400dpi, 300dpi, 
200dpi, 150dpi

Sets the default setting for the 
resolution when [GRAY SCALE] 
is selected for the color mode 
setting.

FULL COLOR 
SETTING

RESOLUTION 300dpi, 200dpi, 150dpi Sets the default setting for the 
resolution when [FULL COLOR] 
is selected for the color mode 
setting.

ORIGINAL MODE TEXT/PHOTO, TEXT, 
PHOTO

Sets the default setting for the 
original mode when [FULL 
COLOR] is selected for the color 
mode setting.

OMIT BLANK PAGE -3 to +3 Sets the sensitivity level to detect 
blank pages. The higher the level 
is, the more likely the equipment 
can detect blank pages. You can 
specify the sensitivity level in the 
range from -3 to +3.

CONTINUE SCAN OFF, ON Sets whether to continue 
scanning when the scanning of 
all the originals set on the RADF 
is finished.
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USB PRINT

The following functions and settings are available on the “USB PRINT” menu.

 LIST

* This item is displayed when the PostScript kit has been installed.

Menu Functions Settings Description

PAPER SIZE A3, A4, B4, B5, A5-R, FOLIO, 
LD, LG, LT, COMP, 13"LG, ST-
R, 8.5SQ

Sets the paper size to print files 
from a USB storage device.

2-SIDED SINGLE Prints on a single side of paper.

DUPLEX Prints on both sides of paper.

Menu Functions Settings Description

ADDRESS BOOK SPEED DIAL, GROUP DIAL, 
ONE TOUCH

Prints the E-mail address list.
For details of the fax settings, 
see the Fax Guide.

FUNCTION - Prints the user function list.

COUNTER - Prints the total counter list.

DEPARTMENT - Prints the department code and 
the counter value.
The printed counter value is for 
the department you specified in 
the department code entry 
screen.
Enter the master code in the 
department code entry screen if 
you want to print counter values 
of all the registered departments.

PCL FONT - Prints the list of PCL fonts.

PS FONT* - Prints the list of PS fonts.
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WIRELESS SETTING

You can configure the Wireless LAN Module if it is installed.
Select Infrastructure Mode or Ad Hoc Mode to specify the security mode.

 If you do not set no security, anyone knows how the SSID can connect to the wireless network. 
Therefore, it is recommended to set the security if it is possible.
 Once the WIRELESS SETTING has been set up, exit from USER FUNCTIONS menu by pressing 

[CANCEL] or [USER FUNCTIONS] button. When “APPLY AND REBOOT?” message appears, select 
“YES”, and then press [OK]. The equipment is automatically rebooted and the WIRELESS SETTING is 
applied.

 WPS
WPS is a standard to allow easy wireless LAN configurations. This equipment supports Push Button 
Configuration and PIN methods.
The Push Button Configuration method completes the configuration by transmitting the ESSID and 
encryption key to the wireless LAN device as you press the button on the Access Point.
Whereas the PIN method completes the configuration by transmitting the ESSID and encryption key to the 
wireless LAN device as you register the PIN generated by the wireless LAN device to the Access Point.
 WPA2-PSK, WPA2/WPA-PSK

WPA2 and WPA2/WPA-PSK are authentication methods using the PSK (Pre-Shared Key) between the 
Access Point and other wireless devices.
To access the wireless network using the WPA2-PSK or WPA2/WPA-PSK authentication, the same PSK 
passphrase must be assigned in both the Access Point and other wireless devices. If the PSKs are same 
between the Access Point and other wireless devices, the Access Point allows them to access the wireless 
network through the Access Point.
 WEP

WEP is a data encryption method using the WEP key between the Access Point and other wireless 
devices.
WEP is less secure compared with WPA2 and WPA2/WPA-PSK. If the wireless network is configured in 
the Infrastructure Mode and the Access Point supports WPA2-PSK or WPA2/WPA-PSK, it is 
recommended to use WPA2-PSK or WPA2/WPA-PSK rather than WEP.
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The following functions are available on the “WIRELESS SETTING” menu.

ADDRESS BOOK

DRAWER

Menu Functions Settings Description

ON INFRASTRU
CTURE

WPS - Selects the connection method 
from [PBC] or [PIN]. Press the 
WPS button on the Access Point 
within 2 minutes of selecting the 
PBC method. Register the PIN 
generated by this equipment to 
the Access Point within 2 
minutes of selecting the PIN 
method.

SSID/SECURITY - WPA2-PSK, WPA2/WPA-PSK:
Specify the passphrase after 
selecting AES if you are using 
WPA2-PSK, or after selecting 
TKIP+AES if you are using 
WPA2/WPA-PSK.
WEP:
Selects the WEP encryption and 
key entry method, and then enter 
the WEP key.
NONE: 
Sets no security for wireless 
access.

AD HOC AUTO - At first, select the channel setting 
method. Next, selects the WEP 
encryption and key entry method, 
and then enter the WEP key.

MANUAL -

OFF - Disables the wireless network.

Menu Functions Settings Description

E-MAIL SINGLE NUMBER - Edits the address book for "Scan 
to E-Mail" function.GROUP NUMBER -

PHONE BOOK SPEED DIAL - For details of the fax settings, see 
the Fax Guide.GROUP DIAL

ONE TOUCH

Menu Functions Settings Description

DRAWER 1 A3, A4, A4-R, A5-R, 8K, 16K, 
16K-R, B4, B5, B5-R, FOLIO, 
LD, LG, LT, 
LT-R, ST-R, COMP, 13" LG, 
8.5SQ

Sets the paper size for the 
drawer.DRAWER 2

DRAWER 3

DRAWER 4
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 INFORMATION

Menu Functions Settings Description

COUNTER TOTAL COUNTER - Displays the total counter.

TONER REMAIN - Displays the toner remaining 
information.

SERIAL NUMBER - Displays the serial number.
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Department Management

You can identify the number of output pages by copying, transmitting and receiving faxes, printing, and 
scanning by user groups (departments) using the department management function.
When the department management function is enabled the department code entry screen is displayed before 
using this equipment. This can also prevent improper use of this equipment.
 P.18 “Preparation 1 - Turning Power ON”

You can register the department name and code from the [USER FUNCTIONS] menu.

1 Press [USER FUNCTIONS].

2 Press  or  to select [GENERAL] and then press .

3 Press  or  to select [DEPARTMENT CODE] and then press .

4 Press  or  to select [YES] and then press .

USER FUNCTIONS

GENERAL

COPY

SCAN

GENERAL

WALKUP SCREEN

TIMERS

DEPARTMENT CODE

DEPARTMENT CODE

YES

NO
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5 Specify the department number, name, and code.

 P.179 “User Functions Menu List”

You need to set the master code (department number: 01) before entering the department code.
The master code registration screen is displayed if you have not set the master code.

DEPARTMENT CODE

(NUMBER)

(NAME)

(CODE)

MASTER CODE       01

(NAME)

(CODE)

ADD DEPARTMENT
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Job Status

You can confirm the status of jobs, delete jobs, and print files stored in a USB storage device.

1 Press the [JOB STATUS] button.

2 Press  or  to scroll the menu and then press  to enter the function menu.

 P.194 “JOB STATUS menu items”

3 Press  or  to select the function menu and then start the operation.

 JOB STATUS menu items

When you press the [JOB STATUS] button on the main screen, the JOB STATUS menu appears. On this 
menu, you can confirm the status of each job, delete jobs, print files from a USB storage device, and print 
various lists.
The table below shows the functions available on the JOB STATUS menu and the reference pages.

*1 These menu items are available only for the equipment with the fax unit installed as an option.

 4JOBS

JOB STATUS

SECURE RX

RESERVATION LIST

Menu Functions Settings

JOBS PRINT CONFIRM Confirms the job status or deletes jobs.
 P.195 “Confirming the job status and deleting 
jobs”

DELETE

SCAN CONFIRM

DELETE

FAX*1 CONFIRM

DELETE

USB PRINT Prints files saved in a USB storage device.
 P.196 “Printing from a USB storage device”

SECURE RX*1 Prints SECURE RECEIVE fax jobs.
For details, see the Fax Guide.

RESERVATION LIST*1 Prints a list of jobs that are reserved to be sent.
For details, see the Fax Guide.

JOURNAL*1 Prints a history of fax transmissions and receptions.
For details, see the Fax Guide.
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Confirming the job status and deleting jobs

You can confirm the statuses of print, scan, and fax jobs and delete jobs.

Confirming the job status

1 Press  or  to select [JOBS] and then press .

2 Press  or  to select [PRINT], [SCAN] or [FAX] and then press .

3 Press  or  to select [CONFIRM] and then press .

Jobs in progress or those on the waiting list appear.

4 Press  or  to select the job whose status you want to confirm and then press .

The status of the selected job appears.

5 After you have confirmed the status, press , [CANCEL] or [OK].

The menu returns to the previous one.

Deleting unnecessary jobs

1 Press  or  to select [JOBS] and then press .

2 Press  or  to select [PRINT], [SCAN] or [FAX] and then press .

3 Press  or  to select [DELETE] and then press .

Jobs in progress or those on the waiting list appear.

4 Press  or  to select the job you want to delete and then press .

A message asking you to confirm the deletion appears.

5 If you want to continue to delete the job, press  and select [YES]. Then press [OK].

The job is deleted.

ARE YOU SURE?

YES

NO
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 Printing from a USB storage device

You can print PDF, JPEG or TIFF files saved in a USB storage device connected to this equipment.

 USB storage devices must meet the requirements below. However, some USB storage devices may 
not be used with this equipment even though the requirements below are met.
- FAT16 or FAT32 format
- Single-partition (USB storage devices with multiple partitions are not supported.)

 Only files saved in the root folder of a USB storage device can be printed.
 Up to 99 files can be displayed in alphabetical order.
 Up to 20 characters of the file name can be displayed. The 21st and the subsequent characters are 

displayed in dots.
 A JPEG file with a resolution is higher than 600 dpi cannot be printed.
 The compression format of TIFF files is compatible with JPEG/MH/MR/MMR.
 If photo images in a TIFF file have been printed in a grainy fashion, try carrying out the printing from a 

client computer, and thus this phenomenon may be improved.
 Only PDF files that have been scanned with the same equipment in the BLACK mode can be printed.
 The encrypted PDF files cannot be printed.
 A paper size cannot be set for PDF files. They are printed in the size in which they are scanned.
 TIFF and JPEG files cannot be printed as being scaled according to the paper.

1 Connect a USB storage device to the slot of this equipment.

2 Select the paper size and set the duplex printing mode in [USB PRINT] of the USER 

FUNCTIONS menu.

 P.188 “USB PRINT”

The paper size setting is disabled for PDF files as they are printed in the size in which they are 
scanned.

3 Press the [JOB STATUS] button.

4 Press  or  to select [JOBS] and then press .
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5 Press  or  to select [USB PRINT] and then press .

6 Press  or  to select the file you want to print and then press [OK].

Printing starts.

Do not remove the USB storage device until printing finishes.
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When This Message Appears

A message appears when a problem occurs on the equipment. Find the message on the list below and follow 
the instructions in the Countermeasure.

Message Meaning Countermeasure

MISFEED xxxx An error code “xxxx” and a 
message for solving the 
problem are displayed.

Remove any misfed paper.
 P.202 “Paper Misfeed”

CHECK:PAPER SIZE The incorrect paper size has 
been set for paper loaded on 
the bypass tray.

Remove paper from the bypass tray and load it 
again so that the display shows “BYPASS PAPER 
SIZE”. Set the correct paper size. When you load 
paper the size other than the standard ones, 
select “CUSTOM” for the paper size.

CLOSE *** Any cover of the equipment 
indicated by “***” is not 
securely closed.

Close the cover securely.

DRAWER * EMPTY The paper in a drawer 
indicated by “*” has run out.

Load paper in the drawer.
 P.24 “Loading paper in the drawer/Paper Feed 
Unit”

COUNT OVER The number of pages 
scanned has exceeded the 
maximum value.

Select “PRINT” on the LCD screen to copy the 
data scanned so far. Select “CANCEL JOB” to 
delete all the data scanned so far.

CALL FOR SERVICE 
xxxx

The repair or adjustment by 
your service technician is 
needed.

Contact your service representative.
Give the service technician the error code 
(consisting of letters and numbers) that appears 
in the upper right area of the LCD screen.

Never attempt to repair, disassemble or 

modify the equipment by yourself.

This could cause an electric shock, a fire or 
serious injury. Contact your service 
representative when the equipment is in an 
abnormal condition or any malfunction is found.

MAINTENANCE The maintenance by your 
service technician is needed.

Contact your service representative.

BYPASS EMPTY Paper set on the bypass tray 
has run out.

Load paper on the bypass tray.
 P.30 “Loading paper on the bypass tray”

TONER IS LOW There is only a little toner 
remaining in the toner 
cartridge.

There is still a little toner remaining in the toner 
cartridge. Do not replace the toner cartridge until 
“TONER EMPTY” appears on the LCD screen.

 The message may not appear because the 
toner remaining in the cartridge does not lie 
evenly.
 When the message appears, it is advisable 

to purchase a new recommended cartridge 
to prepare for its replacement.

ERROR : TONER The toner cartridge is not 
installed correctly.

Install the toner cartridge correctly.

The recommended toner 
cartridge is not being used.

If you are using a toner cartridge other than the 
one we recommend, the equipment may not be 
able to detect whether it is installed or not.
 P.3 “Recommended toner cartridges”

TONER EMPTY The toner in the toner 
cartridge has run out.

Replace the toner cartridge with a new one. 
 P.211 “Replacing Toner Cartridge”

MEMORY IS FULL
PRESS ANY KEY

The built-in memory of the 
equipment has become full.

Press any button on the control panel to delete 
the scanned data.
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CLEAR PAPER 
OUTPUT TRAY
PRESS [START] KEY

Approx. 100 maximum sheets 
of paper have continuously 
exited and the equipment 
stops copying to prevent the 
copied paper from overflowing 
from the tray.

Remove the paper from the receiving tray, and 
then press [START] to resume copying.
Press [CLEAR/STOP] to end the copy. When 
“MEMORY CLEAR?” appears on the LCD 
screen, select “YES”, and then press [START].

SET xxx The paper size setting is 
incorrect.

Make sure the loaded paper size/type and setting 
on the control panel.

PLEASE WAIT 
ADMINISTERED BY 
PC

TopAccess has been closed 
by clicking [X] (Close) on the 
browser window instead of 
[Logout] by a user who logged 
in as an administrator 
(Admin).

Turn the equipment power OFF and back ON, or 
wait until the time set with TopAccess for [Web 
General Setting] – [Session Timer] passes 
(default: 10 minutes).

ERROR:PRINT An error has occurred inside 
the equipment.

Contact your service representative.

TO USB ERROR xxxx Scanned data could not be 
saved in the USB storage 
device.

Scanned data could not be saved in the USB 
storage device. Press any button on the control 
panel to clear the error.

Use a USB storage device that meets the 
following requirements. If you use the USB 
storage device that does not meet the 
requirements, try to use another USB storage 
device that meets them.
- FAT16 or FAT32 format
- Single partition
- Storage space enough to save scanned 

data

Message Meaning Countermeasure
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Paper Misfeed

 Find the position of paper misfeeds

When a paper misfeed occurs in the equipment, the operation stops, the alert lamp blinks on the control 
panel, and a message appears on the LCD screen to indicate the positions where the paper is misfed.

Check the message, remove any misfed paper, and then press [START] to resume copying.
 P.179 “User Functions Menu List”

When a paper misfeed occurs in the equipment, the instruction to remove the misfed paper appears on the 

LCD screen. Press  and  to scroll up and down to read the instruction.

 When paper misfeeds occur frequently

When paper misfeeds occur frequently, they may be due to one of the causes listed below:
 Unacceptable paper is used.
 P.23 “Paper types not acceptable”
 The sizes of paper loaded in the drawer or on the bypass tray are not registered into the equipment 

properly.
 P.35 “Preparation 3 - Registering Paper Size and Type”
 More misfed paper is still remaining after the release of a paper misfeed.
 The side guides are aligned too tight or too loose to the paper.
 The height of the stacked paper is exceeding the indicators in the drawer.

 When removing misfed paper

Observe the following precautions when you remove misfed paper:

Do not tear misfed paper.

Remove misfed paper carefully with both hands. Do not pull the paper forcefully, otherwise the paper could 
tear and cause a misfed paper. Make sure there are no torn pieces of paper left in the equipment.

Do not touch the fuser unit or the metal part around the unit.

When you remove misfed paper within the fuser unit, do not touch the fuser unit or the metal part around the 
unit. If you touch the inside of the equipment, this could cause burns or any injury to your hands.

Do not touch the photoconductive drum.

When you remove the misfed paper within the transfer unit or the fuser unit, be careful not to touch the 
photoconductive drum. This could stain the copy images.
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 Paper misfeeds on the Reversing Automatic Document Feeder (RADF)

1  Open the upper cover.

2  Open the transport guide and remove the original.

3  Open the Reversing Automatic Document Feeder.

4  Turn the dial to remove the misfed original.
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5  Close the Reversing Automatic Document Feeder.

6  Raise the feeder tray.

7  Turn the dial to remove the misfed original.

8  Lower the feeder tray.
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9  Close the upper cover.

 Paper misfeeds on the bypass tray

1 Pull the paper holding lever out, and then pull out the misfed paper on the bypass tray.

2 Check beneath the transport guide inside of the side cover.

Check if any paper is misfed under the transport guide behind the transfer unit.
 P.206 “Paper misfeeds inside of the side cover”

1

2
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 Paper misfeeds inside of the side cover

 Be careful not to catch your fingers between the equipment and the side cover. 
This could injure you.
 Do not touch the fuser unit or the metal part around the unit.

If you touch the inside of the equipment, this could cause burns or any injury to your hands.

1 Open the side cover.

2 Remove the misfed paper behind transfer unit.

Be sure not to touch the photoconductive drum when removing the misfed paper.

If you cannot see the misfed paper, turn the dial (green) of the transfer unit to remove the misfed 
paper.
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3 If you cannot see the misfed paper or it is difficult to remove, open the drawer in which 

you have loaded paper and remove it.

Be sure that the height of the stacked paper does not exceed the line indicated inside of the side 
guides.

4 Close the drawer.

5 Lay down the transfer unit, and then press down the two fuser pressure release levers 

(green) until they come to a stop.

Press down the levers fully until they stop.

6 Raise the transport guide.

2
1
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7 Release the misfed paper within the fuser unit.

Pull the misfed paper up or down as shown below depending on its position.

Be sure not to touch the photoconductive drum when releasing the misfed paper.

8 Return the transport guide and transfer unit to their original positions, and then close 

the side cover.

Pulling it up Pulling it down
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 Paper misfeeds within the Paper Feed Unit

1 Open the side cover and check if any paper is misfed behind the transfer unit.

 P.206 “Paper misfeeds inside of the side cover”

2 Open the paper feed cover of the unit.

3 Release the misfed paper.

4 If it is difficult to find or remove the misfed paper, open the drawer of the Paper Feed 

Unit.

2 1
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5 Check that the guide width is correct, there is no folded/curled paper or overloading, 

and then close the drawer.

 Be sure that the height of the stacked paper does not exceed the line indicated inside of the side 
guides.
 Do not allow any gap between the paper and the end guide in the drawer.

6 Close the paper feed cover of the unit and the side cover.

 Paper misfeeds within the Paper Feed Pedestal

1 Open the paper feed cover of the Paper Feed Pedestal.

2 Release the misfed paper.

3 Close the paper feed cover of the Paper Feed Pedestal.



7 TROUBLESHOOTING

 Replacing Toner Cartridge    211

Replacing Toner Cartridge

 When a message for replacement appears

When the toner cartridge runs out of toner, the message appears on the LCD screen and the alert lamp blinks 
on the control panel.

Never attempt to incinerate toner cartridges.

Dispose of used toner cartridges in accordance with local regulations.

 Before inserting a new toner cartridge, check that the product name is “T-2309”.
 Do not touch the parts on the circuit board mounted on the toner cartridge because they may be 

damaged.

1 Open the front cover.

2 While holding down the green lever, pull out the toner cartridge.

Never attempt to incinerate toner cartridges.

Dispose of used toner cartridges and waste toner boxes in accordance with local regulations.

Do not touch the terminal of the toner cartridge.

This may cause the equipment not to recognize the toner cartridge 
or may damage the terminal.
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3 Shake the new toner cartridge strongly with the label surface down to loosen the toner 

inside.

4 Pull out the seal in the direction of the arrow.

5 Insert the toner cartridge along the rail.

Insert the toner cartridge until you hear a click sound.
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6 Clean the charger.

Hold the cleaning knob of the charger and pull it out toward you carefully until it stops. Then reinsert it in 
its original position carefully. Repeat this procedure two to three times.

Check if the cleaning knob is fully inserted after cleaning.

7 Close the front cover.
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Before Calling Service Technician

When you encounter troubles, find the symptom listed below and follow the instructions in the 
Countermeasure.

 General operation

Phenomenon Usual cause Countermeasure

The equipment does not 
work at all.

The power is not turned 
ON.

Turn ON the power of the equipment.

The power cable is not 
plugged in securely.

Plug in the power cable securely.

The button does not 
respond to my operation.

It has been a short time 
since the power was 
turned ON.

Wait for the completion of warm-up and then try 
again.

The LCD screen is too 
light/dark.

The contrast of the LCD 
screen is not adjusted 
properly.

Adjust the contrast.
 P.179 “User Functions Menu List”

A message is displayed on 
the LCD screen.

The equipment has 
detected an error status.

See the meaning of the message referring to the 
listing below.
 P.200 “When This Message Appears”

“SAVING ENERGY” 
appears on the LCD 
screen.

The equipment is in the 
low power mode.

Press any button on the control panel to cancel 
this mode. Copying is enabled in the low power 
mode.
 P.19 “Saving energy when not in use - Energy 
saving mode -”

The LCD screen is dim. The equipment is in the 
sleep mode.

Press any button on the control panel to cancel 
this mode.
 P.19 “Saving energy when not in use - Energy 
saving mode -”

Copy functions cannot be 
set.

Some copy functions that 
cannot be set 
simultaneously with others 
have been set.

Some copy functions cannot be set together with 
others.
 P.227 “Copying Function Combination Matrix”

The equipment is not 
recognized when it is 
connected to a PC using a 
USB cable.

The cable is not support 
the USB2.0 Hi-Speed. 

Use a USB2.0 Hi-Speed certified cable.

The equipment is 
connected via a USB hub.

Connect the equipment with a PC directly by a 
USB cable.



7.TROUBLESHOOTING

Before Calling Service Technician    215

7 TROUBLESHOOTING

 Toner-related items

 Original/Paper-related items

Phenomenon Usual cause Countermeasure

“TONER IS LOW” appears 
on the LCD screen.

Toner is running out. There is still a little toner remaining in the toner 
cartridge. Do not replace the toner cartridge until 
“TONER EMPTY” appears on the LCD screen.

“TONER EMPTY” appears 
on the LCD screen.

Toner has run out. Replace the toner cartridge with a new one.

“ERROR : TONER” 
appears on the LCD 
screen.

The toner cartridge is not 
installed, or it is installed 
incorrectly.

Install the toner cartridge correctly.

The recommended toner 
cartridge is not being used.

If you are using a toner cartridge other than the 
one we recommend, the equipment may not be 
able to detect whether it is installed or not.
 P.3 “Recommended toner cartridges”

“TONER IS LOW” does not 
appear on the LCD screen, 
although toner is nearly 
empty.

The recommended toner 
cartridge is not being used.

If you are using a toner cartridge other than the 
one we recommend, the equipment may not be 
able to detect whether it is installed or not.
 P.3 “Recommended toner cartridges”

The equipment does not 
become ready after the 
toner cartridge is inserted.

The toner cartridge 
inserted is not usable for 
this equipment.

Check that the product name is “T-2507”.

Phenomenon Usual cause Countermeasure

Paper misfeeds. The paper is unsuited for 
the equipment.

Check if the paper is acceptable.
 P.23 “Paper types not acceptable”

The paper size is not 
registered properly in the 
equipment. 

Register the paper size properly. 
 P.35 “Preparation 3 - Registering Paper Size 
and Type”

Misfed paper is located in 
a place you cannot see 
easily.

See the message on the LCD screen to recheck 
the position where the paper misfeed has 
occurred.
 P.202 “Paper Misfeed”

There is no gap between 
the side guides and paper 
in the drawer, or the gap is 
too wide.

Adjust the gap between the side guides and the 
paper properly.
 P.24 “Loading paper in the drawer/Paper Feed 
Unit”

Multiple feeding occurs. Sheets of paper clinging to 
each other.

Fan the paper well and place it again.
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 Image trouble

Phenomenon Usual cause Countermeasure

The copy image is light. Toner has run out. Replace the toner cartridge if the “TONER 
EMPTY” message appears on the LCD screen.
 P.211 “Replacing Toner Cartridge”

The copy density is set 
lighter.

Make the density darker if you use the manual 
copy density mode.

The copy image is dark. The copy density is set 
darker.

Make the density lighter if you use the manual 
copy density mode.

The copied image is 
stained.

The Platen Cover or the 
Reversing Automatic 
Document Feeder is not 
lowered fully.

Lower it fully to block outside light.

The original glass or platen 
sheet is dirty.

Clean them.
 P.218 “Regular Cleaning”

The copy density is set 
darker.

Make the density lighter if you use the manual 
copy density mode.

Highly transparent 
originals such as overhead 
transparencies or tracing 
paper are used.

Place a blank plain sheet of paper, the same size 
as the original or larger, over the original.

The copy image is fogged. There is a slight gap 
between the original glass 
and the original.

Lower the Platen Cover or the Reversing 
Automatic Document Feeder fully so that the 
original will contact with the original glass.

The paper is damp. Replace with dry paper.

The copy image is partially 
missing.

The size or direction of the 
paper and the original, or 
the reproduction ratio is 
not set properly.

Use paper of the same size as the original or set 
the reproduction ratio suitable to the paper size.

The margin for binding is 
too wide.

Adjust the image shift value again.
 P.61 “Shifting the pages to the right or left”

The copy image has black 
streaks in a horizontal 
direction.

The charger is dirty. Clean the charger.
 P.219 “Cleaning Charger”
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Regular Cleaning

We recommend you to clean the following items weekly, so that the originals can be scanned in unsoiled 
conditions.

 Be careful not to scratch the portions in cleaning.
 When cleaning the surface of the equipment, do not use such organic solvents as thinner or benzine. 

This could warp the shape of the surface or leave it discolored.
 When using a chemical cleaning pad to clean it, follow the instructions.

1. Scanning area (surface of the long rectangular glass) / 2. Original glass

Wipe it with a soft dry cloth. If there are still stains remaining, wipe it clean with a piece of soft cloth which 
has been moistened with water and then squeezed well.
Do not use liquids other than water (such as alcohol, organic solvents or neutral detergent).

3. Guide / 4. Platen sheet

Clean the surface as follows depending on the staining.
 Clean it with a soft cloth.
 Clean it with a soft cloth lightly moistened with water.
 Clean it with a soft cloth lightly moistened with alcohol, and then wipe it with a dry cloth.
 Clean it with a soft cloth lightly moistened with watered-down neutral detergent, and then wipe it with a 

dry cloth.

You need to clean 1 (scanning area) and 3 (guide) only when using Reversing Automatic Document 
Feeder.

42
3

1
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Cleaning Charger

If the inside of the charger is dirty, staining may appear on the copied image. Clean the charger following the 
procedure below.

1 Open the front cover.

2 Clean the charger.

Hold the cleaning knob of the charger and pull it out toward you carefully until it stops. Then reinsert it in 
its original position carefully. Repeat this procedure two to three times.

Check if the cleaning knob is fully inserted after cleaning.

3 Close the front cover.
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e-STUDIO2309A/2809A Specifications

Model name DP-2309A/2809A

Type Desktop type

Original glass Fixed

Printing (copying) system Indirect electrophotographic method

Developing system 2-component magnetic brush developing

Fusing method Two halogen lamp

Photosensor type OPC

Original scanning system Flat surface scanning system
(When the Reversing Automatic Document Feeder is installed: 
Fixed scanning system by feeding the original)

Original scanning sensor Linear CMOS sensor

Scanning light source LED

Resolution Writing 2400 dpi x 600 dpi (Smoothing process)

Scanning 600 dpi x 600 dpi

Acceptable originals Sheets and books

Acceptable original size Original glass: Max. A3 or LD
Reversing Automatic Document Feeder: Max. A3 or LD

Acceptable paper size Drawer A3, A4, A4-R, A5-R, B4, B5, B5-R, FOLIO, LD, LG, LT, LT-R, 
ST-R, COMP, 13"LG, 8.5"SQ, 8K, 16K, 16K-R

Bypass A3, A4, A4-R, A5-R, B4, B5, B5-R, FOLIO, LD, LG, LT, LT-R, 
ST-R, COMP, 13"LG, 8.5"SQ, 8K, 16K, 16K-R, COM10, 
Monarch, DL

Acceptable paper weight Drawer 64 - 80 g/m2 (17 - 20 lb. Bond)

Bypass 64 - 80 g/m2 (17 - 20 lb. Bond) : for continuous feed

52 - 63 g/m2 (14 lb. Bond - 16 lb. Bond), 81 - 216 g/m2 (21 lb. 
Bond - 110 lb. Index/80 lb. Cover) : for single feed

Warm-up time Approx. 18 seconds

First copy time (A4 or LT portrait) A4: Approx. 6.4 seconds
LT: Approx. 6.5 seconds

Continuous copy speed See  P.223 “Continuous copying speed”

Multiple copying Up to 999 copies

Excluded image width Copy Leading edge: 3.0±2.0 mm (0.12"±0.08")
Trailing edge: 2.0±2.0 mm (0.08"±0.08")
Both edges: 2.0±2.0 mm (0.08"±0.08")

Printer Leading edge: 5.0±3.0 mm (0.20"±0.12")
Trailing edge: 5.0±3.0 mm (0.20"±0.12")
Both edges: 5.0±3.0 mm (0.20"±0.12")

Reproduction ratio Actual size 100±0.5% 

Zoom 25 - 400% (in 1% increments)

Storage capacity Max. 150 sheets or until the memory is full (TOSHIBA’s own 
chart)

Paper supply Drawer 250 sheets (80 g/m2, 20 lb. Bond)

Bypass 100 sheets (80 g/m2, 20 lb. Bond)

Loading capacity for the receiving tray Approx. 100 sheets (80 g/m2, 20 lb. Bond)

Toner density adjustment Magnetic auto-toner system

Exposure control Automatic plus manual selection from 9 exposure steps

Memory 512MB

USB interface USB2.0 (Hi-Speed)

Environment (for normal use) Temperature: 10 º - 30 ºC, Humidity: 20 - 85% (No 
condensation)
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 These specifications vary depending on the copying conditions and the environment.
 Specifications and appearance are subject to change without notice in the interest of product 

improvement.

 Continuous copying speed

The values below are measured when originals are set on the original glass, 100% and nonsort multiple 
copies are made.

sheets/min.

*1 ST-R can be loaded only on the bypass tray.

 TOSHIBA-recommended paper is used for the values of the specifications above.
 The bypass copying speed is as listed above when specifying the paper size.
 This specification varies depending on the copying conditions and the environment.

Power requirements and power 
consumption
(including optional equipments)

AC 220 - 240 V±10%, 8 A (50 - 60 Hz): 1.5 kW or less
AC 120 V±10%, 12 A (60 Hz): 1.5 kW or less

Dimensions (equipment only) 575 mm (22.6") (W) x 565 mm (22.2") (D) x 402 mm (15.8") (H)

Weight (including equipment and drum) Approx. 26 kg (57.3 lb.)

Space occupied (equipment only) 943 mm (37.1") (W) x 565 mm (22.2") (D)

Paper size Paper source e-STUDIO2309A e-STUDIO2809A

A4, A5-R, B5, LT, 

ST-R*1

Drawer 23 28

Bypass tray 23 28

A4-R, B5-R, LT-R Drawer 19 19

Bypass tray 19 19

B4, FOLIO, LG, 
COMP, 13"LG

Drawer 16 16

Bypass tray 16 16

A3, LD Drawer 14 14

Bypass tray 14 14
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Specifications of Options

Reversing Automatic Document Feeder

Paper Feed Unit

Paper Feed Pedestal

Drawer Module

Model name MR-3029

Copy sides 1-side, duplex

Number of originals 
(A4)

50 originals (80 g/m2, 20 lb. Bond) or 9.5 mm or less in height (more than 80 g/m2, 20 
lb. Bond)

Feeding speed 37-111 mm/s

Acceptable originals A3, A4, A4-R, A5-R, B4, B5, B5-R, LD, LG, LT, LT-R, ST-R, COMP, 8K, 16K, 16K-
R

Paper weight 50 - 104 g/m2, 13 - 27 lb. Bond

Power source Power supplied from the equipment

Dimensions 560 mm (22.05") (W) x 670 mm (26.38") (D) x 195 mm (7.68") (H)

Weight Approx. 4.5 kg (9.9 lb)

Power consumption 40 W max.

Model name MY-1043

Acceptable paper size A3, A4, A4-R, A5-R, B4, B5, B5-R, FOLIO, LD, LG, LT, LT-R, ST-R, COMP, 13"LG, 
8.5"SQ, 8K, 16K, 16K-R

Paper weight 64 - 80 g/m2, 17 - 20 lb. Bond

Maximum capacity 250 sheets (80 g/m2, 20 lb. Bond)

Dimensions 575 mm (22.64") (W) x 565 mm (22.24") (D) x 117 mm (4.61") (H)

Weight Approx. 5.5 kg (12.1 lb)

Model name KD-1039

Acceptable paper size A3, A4, A4-R, A5-R, B4, B5, B5-R, FOLIO, LD, LG, LT, LT-R, ST-R, COMP, 8K, 
16K, 16K-R

Paper weight 64 - 80 g/m2, 17 - 20 lb. Bond

Maximum capacity 550 sheets (80 g/m2, 20 lb. Bond)

Dimensions 575 mm (22.64") (W) x 575 mm (22.64") (D) x 406 mm (15.98") (H)

Weight Approx. 22 kg (48.5 lb)

Model name MY-1044

Acceptable paper size A3, A4, A4-R, A5-R, B4, B5, B5-R, FOLIO, LD, LG, LT, LT-R, ST-R, COMP, 8K, 
16K, 16K-R

Paper weight 64 - 80 g/m2, 17 - 20 lb. Bond

Maximum capacity 550 sheets (80 g/m2, 20 lb. Bond)

Dimensions 573 mm (22.6") (W) x 557 mm (21.93") (D) x 107 mm (4.21") (H)

Weight Approx. 3.0 kg (6.6 lb)
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Wireless LAN Module 

FAX Unit

For detail specifications, see the following manual.
 Fax Guide

TOSHIBA-recommended paper is used for the values above. Specifications and appearance are subject to 
change without notice in the interest of product improvement.

Model name GN-1080

Transmission Format IEEE 802.11b/g/n standard
Direct Sequence Spread Spectrum (DSSS)
Orthogonal Frequency Division Multiplexing (OFDM)

Data Transmission 
Speed

IEEE 802.11b: 11, 5.5, 2, 1 Mbps
IEEE 802.11g: 54, 48, 36, 24, 18, 12, 9, 6 Mbps
IEEE 802.11n: MSC0-15 (HT20/40)

Access Method CSMA/CA

Wireless Category Low-power data transmission system

Security Static WEP
Key Length: 40 bit, 104 bit

WPA2: PSK(AES(CCMP))
WPA2/WPA mixed: PSK(AES(CCMP)+TKIP)

Operation Mode Infrastructure Mode, Ad Hoc Mode, WPS2.0 PBC or PIN method

Wireless ON/OFF Available

Wired LAN/Wireless 
LAN
Simultaneous 
Operation

Not Available

Model name GD-1360
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Packing List

Packing list Safety Information

Quick Guide

Power cable

DVD
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Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes *1 Yes *1 Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

APS Yes No No Yes No *2 No *2 No *2 Yes Yes Yes Yes Yes Yes Yes Yes Yes No *2 No *2 No *2 No *2 Yes Yes Yes Yes No *2 Yes Yes Yes

Drawer Yes No No Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No *8 Yes

Bypass Yes *10 No No Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes *9 Yes Yes *9 Yes Yes *6 Yes *6 Yes *6 Yes Yes Yes Yes Yes No *8 Yes

Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

AMS Yes No *3 Yes Yes Yes No No Yes Yes Yes Yes Yes Yes Yes Yes Yes No *3 No *3 No *4 No *4 Yes Yes Yes Yes Yes Yes Yes

Manual Yes No *3 Yes Yes Yes No No Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No *3 No *4 No *4 Yes Yes Yes Yes No *7 Yes Yes Yes

Fixed Zoom Yes No *3 Yes Yes Yes No No Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No *3 No *4 No *4 Yes Yes Yes Yes No *7 Yes Yes Yes

Text/Photo Yes Yes Yes Yes Yes Yes Yes Yes No No Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Text Yes Yes Yes Yes Yes Yes Yes Yes No No Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Photo Yes Yes Yes Yes Yes Yes Yes Yes No No Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Auto Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Manual Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

1 > 1 Simplex Yes *11 Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No No No Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

1 > 2 Duplex Yes Yes Yes Yes *9 Yes Yes Yes Yes Yes Yes Yes Yes Yes No No No Yes Yes Yes Yes Yes Yes Yes Yes Yes

2 > 1 Split Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No No No Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

2 > 2 Duplex Yes Yes Yes Yes *9 Yes Yes Yes Yes Yes Yes Yes Yes Yes No No No Yes Yes Yes Yes Yes Yes Yes Yes Yes

Yes *1 Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No No Yes Yes Yes Yes Yes

Yes *1 Yes Yes *6 Yes Yes Yes Yes Yes Yes Yes No No No Yes Yes Yes Yes Yes

2in1 Yes Yes Yes *6 Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No Yes Yes Yes Yes

4in1 Yes Yes Yes *6 Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No Yes Yes Yes Yes

Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Non Sort No *5 Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No No Yes Yes Yes

Sort Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No No Yes Yes Yes

Rotate Sort Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes No No Yes Yes

Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

Notes

Yes: The functions can be combined.

No: Current setting is cancelled, next setting will be selected.

    : Next setting can't be selected.

*1: Can't start job.

*2: Drawer 1 will be selected.

*3: 100% will be selected.

*4: The appropriate zoom ratio will be selected.

*5: Sort will be selected.

*6: When paper type is envelope or paper size is cards, can't start job.

*7: AMS will be selected.

*8: APS will be selected.

*9: When paper type is not plain, next setting can't be selected.

*10: Settings for auto 2-sided mode are ignored if you specify any paper type other than plain paper while User functions menu > COPY > AUTO 2-SIDED MODE is set to "1 > 2 DUPLEX" or "2 > 2 DUPLEX".

*11: Settings for auto 2-sided mode are used when User functions menu > COPY > AUTO 2-SIDED MODE is set to anything other than OFF.
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2-SIDED ................................................172, 181, 188
2-Sided Printing ................................................ 91, 107
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AC-IN terminal ...........................................................11
AD HOC .................................................................190
ADDRESS BOOK ...................................181, 188, 190
[ADDRESS BOOK] button ..........................................15
ADDRESS MODE ....................................................184
ADFPlaten ..............................................................136
Alert lamp .................................................................16
All pages from .........................................................124
AMS (Automatic Magnification Selection) .....................48
Angle ............................................................... 97, 111
ANNOTATION .........................................................172
Application window ..................................................139
APS (Automatic Paper Selection) ................................46
AUTO .....................................................................190
AUTO 2-SIDED MODE .................................... 180, 186
AUTO CLEAR ................................................ 180, 182
AUTO DETECT .............................................. 180, 185
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AUTO POWER SAVE ..................................... 180, 182
Automatic Duplexing Unit ..........................................102
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Bypass tray ........................................................ 12, 20

C
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COMPLETE ................................................... 180, 184
COMPRESS ................................. 173, 175, 181, 187
Configuration of options ..............................................13
Configuration Settings ................................................74
[Configuration] tab ............................................. 88, 102
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CONTACT NAME ....................................................185
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CONTINUE SCAN 172, 173, 175, 180, 181, 186, 187
Continuous copying speed ........................................223
Control panel ...................................................... 10, 14
Copies ....................................................................120
Copies & Pages .......................................................119
COPY ............................................................ 180, 186

[COPY] button .......................................................... 15
Copy Handling ..........................................91, 106, 107
Copy quantity ........................................................... 17
COUNTER .............................................181, 188, 191
Cover Page ............................................................ 125
Cover Page Type .................................................... 125
Custom Page Sizes ................................................. 117
Custom Paper Size ................................................. 100
CUSTOMER E-MAIL ............................................... 184
CUSTOMER INFO. .........................................180, 184
CUSTOMER NAME ................................................ 184
CUSTOMER NUMBER ............................................ 185
CUSTOMER TEL NO. ............................................. 184

D

[DATA] lamp ............................................................. 16
DATE FORMAT .............................................. 180, 182
DATE/TIME ....................................................180, 182
DEFAULT GATEWAY ............................................. 184
Default Menu Setting ................................................. 99
DEPARTMENT ............................................... 181, 188
DEPARTMENT CODE ..................................... 180, 183
Department Code ......................................74, 100, 127
Department Code(DC) - Digit 1 ................................. 128
Department Code(DC) - Digit 2 ................................. 128
Department Code(DC) - Digit 3 ................................. 128
Department Code(DC) - Digit 4 ................................. 128
Department Code(DC) - Digit 5 ................................. 128
Destination Paper Size .................................... 122, 123
DESTINATION SETUP .................................... 180, 185
Digital keys ............................................................... 15
Direction of Print ...............................................92, 109
Distinguish Thin Lines ........................................95, 127
Do not Print Blank Pages ................................... 99, 127
Draw as Outline ................................................ 98, 111
Draw Borders Around Pages .............................. 92, 109
DRAWER ...............................................172, 181, 190
Drawer ............................................................... 10, 20
[DRAWER] button/lamps ............................................ 16
Drawer Module ...................................................11, 20
DRAWER SET ................................................180, 183
Drawer Setting ........................................................ 102
Drawers ................................................................. 102
DUAL PAGE ........................................................... 172

E

Easy Set ................................................................ 137
EDGE ERASE ........................................................ 172
Edit window ............................................................ 144
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E-MAIL ......................................... 173, 181, 185, 190
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E-MAIL ADDRESS1 ................................................ 184
E-MAIL ADDRESS2 ................................................ 184
E-MAIL ADDRESS3 ................................................ 184
E-MAIL SETTINGS .........................................180, 184
Enable SNMP Communication ................................. 103
[ENERGY SAVER] button .......................................... 15
[Enhanced Settings] tab ........................................... 136
Enlarging copy .......................................................... 48
Envelope ............................................................ 20, 32
e-STUDIO Scan Editor ............................................ 139
ETHERNET ....................................................180, 184
EXPOSURE ...42, 172, 173, 175, 180, 181, 186, 187
Exposure ................................................................. 17
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[EXPOSURE] button ..................................................42
EXPOSURE LEVEL ........................................ 180, 186
Exposure/Contrast ...................................................136

F

FAX ........................................................................181
[FAX] button ..............................................................15
FAX NUMBER .........................................................185
FILE .......................................................................173
FILE FORMAT ................................................ 173, 174
FILE NAME .................................................... 173, 174
File window .............................................................143
FINISHING ..............................................................172
[Finishing] tab .............................................88, 91, 106
First page from ........................................................124
Flip horizontally ........................................................121
Font Name ....................................................... 97, 111
Font Size ......................................................... 97, 111
Format For ..............................................................116
Front cover ................................................................10
FULL COLOR SETTING .................................. 181, 187
FUNCTION .................................................... 181, 188
[FUNCTION CLEAR] button ........................................15

G

GENERAL ...................................................... 180, 182
General ..................................................................126
GRAY SETTING ............................................. 181, 187
GROUP DIAL ................................................. 181, 190
GROUP NUMBER ..................................174, 181, 190

H
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How to print ...............................................................80
HTTP ............................................................. 180, 184
HTTP SERVER .......................................................184

I

ID CARD .......................................................... 42, 172
[ID CARD] button .......................................................42
IMAGE DIRECTION .................................................172
[Image Quality] tab .............................................. 88, 95
IMAGE SHIFT .........................................................172
INFORMATION .............................................. 181, 191
INFRASTRUCTURE ................................................190
INITIAL SETUP .......................................................181
Initial values ..............................................................83
INPUT ADDRESS ....................................................174
IP ADDRESS ..........................................................184
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Job Status ...............................................................194
[JOB STATUS] button ................................................15
JPEG ......................................................................174

L

Layout ....................................................................120
Layout Direction .......................................................120
LCD CONTRAST ............................................ 180, 183
LCD screen ...............................................................16
Limitations ........................................................ 80, 114
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LIST .............................................................. 181, 188
Long Edge ................................................................92
Low power mode .......................................................19

M

Main screen (Copy) ................................................... 17
MANUAL ................................................................ 190
Manual ................................................................... 103
MANUAL LEVEL .............................................180, 186
Manual Scale .................................................... 89, 105
Margin

Center .................................................................. 94
Outer .................................................................... 94
Units ..................................................................... 94

MAXIMUM COPIES ........................................ 180, 186
Maximum number of originals ..................................... 38
Media Type ............................................................ 126
MEMORY TX .......................................................... 181
Menu bar ............................................................... 140
Menu Tabs ............................................................... 88
Message .......................................................... 17, 200
MESSAGE SIZE .............................................173, 174
MIX-ORIGINAL .......................................172, 173, 175
Model Selection ...................................................... 102
[MONITOR] button .................................................... 14
MULTI ................................................................... 174
MULTI TX .............................................................. 181
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NETWORK ..................................................... 180, 184
Network interface connector ....................................... 11
NIC STATUS .................................................. 180, 184
Number of Copies ..................................................... 90
Number of pages per Sheet ...............................92, 109
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OFF ....................................................................... 190
[OK] button ............................................................... 15
OMIT BLANK PAGE 172, 173, 175, 180, 181, 186, 187
ON ........................................................................ 190
ONE TOUCH .................................................. 181, 190
One Touch button ..................................................... 15
Option .................................................................... 102
Orientation ....................................................... 90, 116
ORIG. ORIENTATION ..................................... 180, 186
Original glass ............................................................ 10
ORIGINAL MODE 43, 172, 173, 175, 180, 181, 186, 187
Original Mode ......................................................... 135
Original mode ..................................................... 17, 45
[ORIGINAL MODE] button ......................................... 43
Original Paper Size ...........................................89, 105
Original scale ............................................................ 11
ORIGINAL SIZE ............................. 173, 175, 180, 186
Original Size ........................................................... 135
OTHER INFORMATION .................................. 180, 185
[Others] tab ........................................................88, 99
Output Document Layout ................................... 94, 108
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Packing list ............................................................. 226
Page Attributes ....................................................... 116
PAGE LAYOUT .............................................. 180, 186
Page Order ....................................................122, 123
Pages .................................................................... 120
Pages per Sheet ..................................................... 120
Pages to Print ................................................. 122, 123
Paper exit stopper ..................................................... 11
Paper Feed ............................................................ 124
Paper Feed Pedestal ...........................................11, 20
Paper Feed Unit .................................................. 10, 20
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Paper Handling ........................................................122
PAPER JAM RECOVERY ................................ 180, 183
Paper misfeed (bypass tray) ......................................205
Paper misfeed (RADF) .............................................203
Paper misfeed (transfer unit) .....................................206
PAPER SIZE .................................................. 181, 188
Paper Size ..............................................................116
Paper size .......................................................... 17, 20
Paper Source ............................................................90
Paper source .............................................................46
Paper Type ...............................................................90
Paper types not acceptable .........................................23
[PAUSE] button .........................................................14
PCL FONT ..................................................... 181, 188
PDF ........................................................................174
PHONE BOOK ............................................... 181, 190
Plain paper ................................................................20
Platen Cover .............................................................12
Platen sheet ..............................................................10
POP UP ......................................................... 180, 183
Power switch ...................................................... 11, 18
Precautions for Reversing Automatic Document Feeder .38
Preferences .............................................................146
Pre-Scan .................................................................133
Preview window .........................................................88
PRIMARY PORT NUMBER ......................................184
Print Cover Page .....................................................125
Print on First Page Only ..................................... 97, 110
Print Options .............................................................83
Print Paper Size ................................................ 89, 105
Printer Features .......................................................126
Printer Name .............................................................88
Printing ...................................................................146
Printing Modes ........................................................127
Printing Modes DC ...................................................128
Profile ................................................................ 84, 88
PS FONT ....................................................... 181, 188

Q

Quality ....................................................................129

R

Receiving tray ............................................................11
Recommended paper .................................................22
Reducing copy ...........................................................48
Remaining from .......................................................124
REMOTE1 ..............................................................173
REMOTE1/2 ............................................................174
REMOTE2 ..............................................................173
REPORT SETTING ..................................................181
Reproduction ratio ......................................................17
RESOLUTION ............................... 173, 175, 181, 187
Resolution ...............................................................135
[RESOLUTION] button ...............................................15
Restore Defaults .......................................98, 103, 104
Resuming .................................................................41
Reverse page orientation ..........................................121
Reversing Automatic Document Feeder (RADF) ............10
REVIEW LIST ..........................................................174
RGB Adjustment ......................................................136
Rotate 180 Degrees ...................................................97
Rotated Sort ..................................................... 91, 107
ROTATION ................................... 173, 175, 181, 187
Rotation ..................................................................136
RX PRINT ...............................................................181

S

Saturation .............................................................. 136
Scale ..................................................................... 117
Scale to fit paper size ......................................122, 123
SCAN ............................................................ 181, 187
Scan ...................................................................... 133
[SCAN] button .......................................................... 15
Scan options .......................................................... 134
Scan speed ............................................................ 168
Scanner ................................................................. 147
Scanning area .......................................................... 11
Scroll icon ................................................................ 17
SEARCH ................................................................ 174
Send ...................................................................... 148
SEND NOW ........................................................... 184
SERIAL NUMBER ........................................... 181, 191
SERVICE NOTIFY ..........................................180, 184
[SETTINGS] button ................................................... 15
Sharp ..................................................................... 136
SHARPNESS ................................................. 180, 186
SHIP TO ADDRESS ................................................ 185
SHIP TO NAME ...................................................... 185
Short Edge ............................................................... 92
Side cover ................................................................ 12
SINGLE ................................................................. 174
SINGLE NUMBER ..................................174, 181, 190
SINGLE/2-SIDED SCAN .................................. 173, 175
SLEEP MODE ................................................180, 182
Sleep mode .............................................................. 19
Smoothing ........................................................95, 129
SNMP Settings ....................................................... 102
Solid ................................................................ 97, 111
SORT MODE PRIORITY ................................. 180, 186
Specifications ................................................. 222, 224
Specifications of options .......................................... 224
SPEED DIAL .................................................. 181, 190
SSID/SECURITY .................................................... 190
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